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 بسم الله الرحمن الرحيم
 

 

ِِّكَ  َب َِّذيِ خلَقََ" "اقرْأَْ باِسمِْ ر  ال

َِّبِِّ زدِْنيِ علِمْاً"  "وقَلُ ر

 ْ ِيتمُ َِّ قلَيِلاً"  منِْ  "ومَاَ أُوت  العْلِمِْ إِلا

 ْ َئنِ شَكرَتْمُ َِّكمُْ" "ول يدنَ  لأََزِ
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 مقدمة

مجيات والتطبيلأات والأدوات الملاااااااندة للبح  العل ي بالرغم من أن   ي   انتشااااااار الت 
 ساااااااهم بشااااااكل  بت  فى

ي  بشااااااااكل عامالبح   إجراءات  تيلاااااااات   
 أن  ،بشااااااااكل خا للبيانات  وإجراءات التحليل الإحصااااااااائ 

ّ
معظم  إلا

مجيات والتطبيلأات  ها تلك الت   وقلما تتضاااااامن اللغة العمنية  اااااامن جنبيةالأ لغات البيتم تصااااااويعها و  اااااار
ي 
ى فى ى والمهنث   الأ ااااااديمث   ى  العلمااااااء والبااااااح    أار هاااااذا الأمر عل معظم  المعتمااااادة فثهاااااا. وقاااااد  اللغاااااات 

ي ممن لا يتلأنون اللغاااات الأجنبياااة، ون ااااصاااااااااااااااااة   طلاب الااادراساااااااااااااااااات العلياااا، المااااجلاااااااااااااااتت  المجتمع العرئ 
ي تعليمهم الجامعي باللغة العمنية    يتللأونالذين  والد توراه، 

حت  مجالات العلوم الإ لااااااااااااانية أو م تلف  فى
 لطبيعية. االعلوم 

ي  الجهود الفردية    ونالرغم من
ذلت  الت  ح وتبلاي  من أجل ب  مجيات والتطبيلأات الملااندة للبح   شر الت 

المتشااااااااااااااااابهاة المراجع والكتاب التعليمياة  لعادياد من  لبااللغاة العمنياة    اتإصاااااااااااااااادار وماا نتج عنهاا من    العل ي 
 أتلأميبًا 

ّ
أساااااااااااالوب عرل المادة العلمية أو من حي   من حي   ها تبايوت واختلفت فيما بينها، سااااااااااااواء  ن، إلا

مجياات والتطبيلأاات،  ياةالمصاااااااااااااااطلحاات العلمالمفااهيم و طميلأاة تعمياب   ي تلاك الت 
وهو أمر  المتضااااااااااااااامناة فى

ي عرل المادة العلمية و  اختلافيعزى إلى  
وطرق   اتاختلاف اللهجأسااااااااااااااااليب الأفراد والمؤسااااااااااااااالاااااااااااااااات فى
ى رنما بشاااكل أ ت  الغمول و مزيد من التعميب بشاااكل عام. الأمر الذي أدى بالنهاية إلى   التشاااتيت للباح   

ح والتبلي .   من ال ر

ي  هااذا الكتاااب  
نااامج التحلياال الإحصااااااااااااااااائ  ا باااللغااة العمنيااة لت 

ً
ا مبلاااااااااااااااطاا حااً )لغااايااة الإصاااااااااااااااادار   SPSSيلأاادم شر

جماااة ،  ( 28.0.0 . وهو  لاااااااااااااااتناااد إلى الت  مجياااات والتطبيلأاااات الملااااااااااااااااااانااادة للبحااا  العل ي كااا حاااد أهم الت 
ي المت صااااص الصااااادر عن شر ة   نامج التدريت  افية للت 

ي   يالاحت  نامج.    IBMإم  ئ  صاااانعة للت  وعي الم 
وقد ر 

ي 
جمة والتعميب، وذلك من منظور محايد  هذا الكتاب   فى كل من أسلوب عرل المادة العلمية وطميلأة الت 

ات واللغات، متعدد الت صااصااات  ى ت صااصااات علوم وال ت  والميا اايات والإحصاااء  الحاسااوبيجمع ب  
ي مجااالات  من جهااة، و 

ي وتنلأيااب البيااانااات فى
ي مجااال البحاا  العل ي والتحلياال الإحصااااااااااااااااائ 

ة المهنيااة فى ال ت 
ية من جهة اال ة.  ى افية والكتابة باللغة العمنية والإنجلت 

جمة الاحت   متعددة من جهة اانية، ومهارة الت 

وطميلأة    SPSSوتغطي مو اااااااااااااوعات هذا الكتاب الملاااااااااااااائل المتعللأة بالتعرف عل أسااااااااااااااسااااااااااااايات برنامج  
ي كافة مراحل  

ي تلزم للملاااات دم فى
ي إجراء بعج الإجراءات البلاااايطة وإعداداته الم تلفة الت 

اساااات دامه فى
ات الاساااات دام. كما أنه يوفر   ى ح  يفية اساااات دام العديد من المت   تطبيلأيًا عمليَا خطوة ب طوة وي اااار

ً
دليلا

ي برنامج  
اللأابلة للتطبثق اساااااااااااااات دام الأم لة التو اااااااااااااايحية المبلااااااااااااااطة من خلال وذلك    ،SPSSالمتاحة فى

ي الفهم 
ي تلاعد فى

نامج. الصحثح و العملي الفوري والت   المتعمق للت 

ء اليلاااااااااااااات  فلأت  أرجو من الله العزيز اللأدير أن أ ون قد و   ي
ي تحلأثق  ولو بالشاااااااااااااار

، من هذا الكتابالهدف  فى
ح تلأديم  و  ي    لت  مبلاااااااّ شر

مجيات الملااااااااندة للبح  العل ي ال، أحد أهم  SPSSنامج التحليل الإحصاااااااائ   ،ت 
جمة و المع   ي ، لمفاهيم والمصاطلحات الملات دمة فيهالمناساب لتعميب الت 

تحلأثق أقصىا  بما  لااهم فى
ى للعلماء واوتعزيز قدرات ومهارات البح  العل ي  اساااااااااااااااتفادة   ى  وطلاب الدراساااااااااااااااات العليا  لباح    الناطلأ  

ي م تلف المجالات الأ اديمية والمهنية. 
ى فى  بلهجات م تلفة باللغة العمنية والمت صص  

 والله ولىي التوفثق،

 مصطفى فؤاد عبيد 

ى ، غزة  2026، فلسطي 
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 القرّاء المحتملين

 

ي جمثع ال ليات والت صاااااصاااااات  البكالوريوس و طلاب الدراساااااات العليا،   •
الماجلاااااتت  والد توراه، فى

ي 
 العلوم الطبيعية والإ لانية. مجالات فى

ي مرا ز الأبحاث والدراساااات  •
ى وموظفى ى والمهنث   ى الأ اديمث   المت صاااصاااة والاساااتشاااارات  الباح   

ي م تلف المجالات. 
 فى

ي وطلاب   • علوم الحاسااااااوب والميا اااااايات والإحصاااااااء والاقتصاااااااد والت نولوجيا ونظم   كلياتخميج 
 المعلومات. 

كاااات   • ي ال ااااااااااااااار
ي دوائر الت طي  والبحوث والتطوير والتحليااال والإحصاااااااااااااااااااء والمعلوماااات فى

موظفى
 .والمؤسلات ال اصة والح ومية

ي  •
ى فى ى المت صاااااصااااا   ية ومرا ز التدريب والمدرن   ي دوائر التنمية الب ااااار

التدريب عل مدراء وموظفى
ي للبيانات. مهارات 

 البح  العل ي والتحليل الإحصائ 

ي للبيااناات بااسااااااااااااااات ادام برناامج   •
ي التحليال الإحصااااااااااااااااائ 

ى بتطوير قادراتهم ومهااراتهم فى كاافاة المهتم  
SPSS. 
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 قائمة المحتويات

 

 الصفحة الموضوع

  الإهداء

 5 الملأدمة

ى   7 اللأرّاء المحتمل  

 8 قائمة المحتويات

ي 
 SPSS 9الفصل الأول: مدخل إلى برنامج التحليل الإحصائ 

ي 
: قراءة البيانات فى ي

 SPSS 17الفصل ال ائى

 31 الفصل ال ال : است دام محرر البيانات

ات الفرديةالفصل الرابع  45 : إحصائيات المتغت 

ان المزدوج  55 الفصل ال امس: جداول الاقت 

 67 الفصل اللادس: إ شاء وتحمير الأشكال البيانية

 77 الفصل اللابع: التعامل مع الم رجات

مجية  123 الفصل ال امن:  تابة الأوامر الت 

 131 الفصل التاسع: تعديل قيم البيانات

: طرق توفت  الوقت والجهد  147 الفصل العاشر

: ت صيص برنامج   SPSS 155الفصل الحادي ع ر

ي التلويق( 
: دراسة حالة تطبيلأية )است دام النماذج التوبؤية فى ي ع ر

 169 الفصل ال ائى

ي الكتاب1الملحق  
 183 : ملفات الأم لة الملت دمة فى

ي برنامج 2الملحق  
 SPSS 199: نظام النوافذ فى
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 الفصل الأول

 SPSSمدخل إلى برنامج التحليل الإحصائي 

 

 SPSSفتح ملف بيانات 

ي 
ي برنامج التحليل الإحصاااااائ 

والتبديل إلى عرل    ،SPSS خطوات فتح ملف لعرل قيم البيانات الفعلية فى
 . التلميات الوصفية لأحد البيانات أو ل ل قيم البيانات

 عرض البيانات

 م: اخت  من اللأوائ .1

 ...  بياناتح < فت<   ملف

File > Open > Data... 

 . يتم عرل ممنااع حوار لفتح الملفات

، يتم عرل ملفات بيانات ي
اضى  (. sav. بامتداد )  SPSS بشكل افت 

ي هاذا   SPSS  إذا  نات تمياد فتح ملف بيااناات.  demo.sav   لااااااااااااااات ادم هاذا الم اال الملف
الملااااااااااااااات ادم فى

 . لمزيد من المعلومات حول مواقع ملفات البياناتة ملفات الأم لة الملت دمملحق الم ال، فراجع 

 
ي  demo.sav ملف بيانات

ي محرر البيانات فى
 SPSS فى

ي طميلأااة عرل البيااانااات، إذا و اااااااااااااااعاات مؤشر    SPSS  يتم فتح وعرل ملف بيااانااات
ي محرر البيااانااات. فى

فى
ي تصاااااف المتغت  

الماوس عل اسااااام متغت  )عناوين الأعمدة(، فلااااايتم عرل تلااااامية المتغت  الوصااااافية الت 
ي الشاااكل أعلاه يتم عرل تلااامية متغت  الحالة 

(. فى ا )إذا تم تحديد تلااامية لهذا المتغت 
ً
بشاااكل أ تح تحديد

 .Marital عندما يؤشر الماوس فوق عنوان العمود  Marital Status الاجتماعية
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، يتم عرل قيم البيانات الفعلية ي
اضى  . بشكل افت 

 اخت  من اللأوائم:  .2

 تلميات اللأيمة<  عرل

View > Value Labels 

 من ذلك، يم نك است دام زر "تلميات اللأيم
ً
ي  الأدوات Value Labelsة" أو بدلا  . عل شر

 
 زر تلميات اللأيمة

ي ي
ي الشكل التالىي SPSS تم الآن عرل التلميات الوصفية ل ل اللأيم لتلهيل تفلت  البيانات فى

 : ، كما فى

 
ي محرر البيانات

 طميلأة عرل تلميات اللأيمة ل ل البيانات فى

ي 
ى
 SPSSخطوات إجراء تحليل سري    ع ف

سااوف تحتوي    Analyze، فإن قائمة التحليل Add-On Optionsإذا كان لديك أي خيارات للإ ااافات  
ي المتوفرة. سااااوبدأ ب طوات إجراء تحليل شيااااع وهو إ شاااااء 

عل قائمة بفئات التلأارير والتحليل الإحصااااائ 
ي 
 Statistics. يتطلب هذا الم ال خيار الإحصاااااااائيات أو SPSSجدول ت راري بلاااااااي  )جدول الت رار( فى

Base option. 

 :اخت  من اللأوائم .1

 تحليل < إحصائيات وصفية < التكرارات ... 

Analyze > Descriptive Statistics > Frequencies... 
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 : يتم عرل ممنااع حوار الت رارات

 
ي  -ممنااع حوار الت رارات 

 SPSS إجراء تحليل شيااااع فى

ي تظهر بجوار كل متغت  توفر معلومات حول نوع البيانات وملتوى اللأياس لذلك المتغت  
 . الأيلأونة الت 

ي  الشكل التالىي يو ح تلأليمات
 :SPSSأنواع البيانات فى

 وقت  تاري    خ  نص  عدد  

ي   القياس النسب 
 )بيانات متصلة(

 

n/a 

  

ي   القياس الرتب 
 )بيانات رتبية( 

    

القياس الاسمي  
 )بيانات اسمية( 

    

 ملاحظات

ي اللأائمة، فلاايتم عرل التلاامية أ الاساام بال امل  •
إذا ظهرت تلاامية المتغت  وأ أو اساامه مبتورًا فى

 . عند و ع المؤشر فوقه

ي ممنااع الحوار يظهر ا •
ى أقواس ممنعة بعد التلااااااااااامية الوصااااااااااافية للمتغت    inccat م المتغت  سااااااااااافى ب  

،    Income Category in Thousands""فئاااة الااادخااال باااالآلاف إذا لم ي ن هنااااس تلااااااااااااااامياااة متغت 
ي ممنااع اللأائمة

 . فليظهر اسم المتغت  فلأ  فى

ا م اال النوافااذ، بااالنلأر فوق الحاادود ال ااارجيااة أو الزوايااا  • يم نااك تغثت  حجم ممنعااات الحوار تمااامااً
ا أوسع

ً
ات أيض  . وسحبها. عل سبيل الم ال، إذا قمت بتوسثع ممنااع الحوار، فلت ون قوائم المتغت 
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ي تميد تحليلها من قائمة المصاااااااااااادر عل اليلاااااااااااار واساااااااااااحبها  •
ات الت  ي ممنااع الحوار، ت تار المتغت 

فى
. يتم تعطياااال الزر "موافق" أو  ى ات الموجودة عل اليم   ي قااااائمااااة المتغت 

، الااااذي يلأوم  OK  وأفلتهااااا فى
ات ي قائمة المتغت 

 . بتشغيل التحليل، حت  يتم و ع متغت  واحد عل الأقل فى

ي العادياد من ممنعاات الحوار، يم ناك الحصاااااااااااااااول عل معلوماات إ ااااااااااااااااافياة عن طميق النلأر بزر  •
فى

ي اللأائمة وتحديد معلومات المتغت  من اللأائمة المنب لأة
 . الماوس الأيمن فوق أي اسم متغت  فى

ي قائمة متغت  المصادر واساحب المتغت  إلى قائمة   Gender [gender]  انلأر فوق الجوس ]الجوس[. 2
فى

ات الملتهدفة  . المتغت 

ي قائمة المصادر واسحبه إلى قائمة الهدف [inccat]انلأر فوق فئة الدخل بالآلاف . 3
 . فى

 
ي 
ات الم تارة لإجراء تحليل فى  SPSS المتغت 

 . لتشغيل الإجراء  OKنلأر فوق "موافق" أو ا .4

ي نافذة العارل 
 :Viewerيتم عرل النتائج فى

 
ي العارل  – جدول ت رارات الجوس وفئات الدخل

 Viewerفى
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ي 
ى
ي ف

 SPSSإنشاء مخطط بيانى

ا اسااات دام  
ً
عل الرغم من أن بعج الإجراءات الإحصاااائية يم ن أن توشااار  م ططات، إلا أنه يم نك أيضااا

ي  Graphsقائمة الرسوم البيانية 
ي شيااااع فى

 .SPSS من أجل إ شاء م ط  بيائى

 خدمة الهاتف اللاساااااااااال ي  
ى ي يو ااااااااااح العلاقة ب  

عل ساااااااااابيل الم ال، يم نك إ شاااااااااااء م ط  أو رساااااااااام بيائى
 .(PDA) وملكية الملاعد الرق ي الش صىي 

ي 
ى
ي ف

 SPSS خطوات إنشاء مخطط بيانى

 : اخت  من اللأوائم. 1

ئ المخطط <  الرسوم البيانية  ...  منش 

Graphs > Chart Builder... 

 
ي 
 مع مناطق الإسلأاط الم تملة  SPSS ممنااع حوار إ شاء الم ططات البيانية فى

 (. إذا لم ت ن محددة)  Gallery" المعرل"انلأر فوق علامة التبويب . 2

"  انلأر فوق عمود . 3 يطي
ا)  Bar"شر

ً
 (. إذا لم ي ن محدد

ة الموجودة أعل المعرل Clustered Bar اسحب رمز . 4  . إلى اللوحة، وهي الملاحة الكبت 

ات، وانلأر بزر الماوس الأيمن فوق ال دمة اللاسااالكية. 5 ،  [wireless]  قم بالتممير لأسااافل قائمة المتغت 
 . كملتوى قياس لها   Nominal" الاسمي "ام اخت  نوع 

 .Xإلى المحور س  [wireless]" ال دمة اللاسلكية"اسحب متغت  . 6

 . كملتوى قياس له  Nominalواخت   [ownpda] انلأر بزر الماوس الأيمن عل المتغت  . 7
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متى العليااا من  Owns PDA [ownpda]  اساااااااااااااااحااب متغت  .  8 ي الزاويااة الي 
إلى منطلأااة إسااااااااااااااالأاااط الكتلااة فى

 . اللوحة

 . لإ شاء الم ط  OKانلأر فوق "موافق" . 9

ي نافذة العارل كما يلي : النتيجة
يطي فى

 : يتم عرل الم ط  ال ر

 
ي 
ي نافذة العارل فى

ي بالأعمدة فى
 SPSS إ شاء م ط  أو رسم بيائى

ي أن الأشااااا ا  الذين لديهم خدمة هاتف لاسااااال ي هم أ تح عر اااااة لاسااااات دام أجهزة  
ظهر الرسااااام البيائى ي 

 . الملاعد الرق ي الش صىي أ تح من الأش ا  الذين ليس لديهم خدمة لاسلكية

ناااااافاااااذة   ي 
ي جزء المحتوياااااات فى

يم ناااااك تحمير الم ططاااااات والجاااااداول عن طميق النلأر المزدوج علثهاااااا فى
ي 
ي تطبيلأات أخرى. ساااايتم تغطية هذه الموا ااااثع بالتفصاااايل فى

العارل، ويم نك  لاااان النتائج ولصاااالأها فى
 . المو وعات اللاحلأة
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 الفصل الثاني

 قراءة البيانات

 

  SPSS هيكلية ملفات بيانات

ي 
ة فى ادها من عدد من المصااااااااااااااادر الم تلفة، عمليات  SPSS يم ن إدخال البيانات مباشر ، أو يم ن اسااااااااااااااتت 

ي بويااااة أو هيكاااال ملفااااات بيااااانااااات
 ؛ تطبيلأااااات جااااداول البيااااانااااات، م اااالSPSS  قراءة البيااااانااااات الم زنااااة فى

Microsoft Excel؛ تطبيلأاات قواعاد البيااناات، م ال  Microsoft Accessكلهاا    ،؛ والملفاات النصاااااااااااااااياة
تيب التالىي 

ي هذا اللألم ونالت 
 : سيتم مناقشتها فى

 
ً
 SPSS : عرل بوية ملفات بياناتأولا

ي برنامج
 SPSS اانيًا: استعرال طميلأة قراءة ملفات البيانات فى

ا: عرل طرق قراءة بيانات ملفات
ً
 Excel اال 

 رابعًا: استعرال طرق قراءة البيانات من قاعدة البيانات

 قراءة البيانات من ملف نصىي  :خاملًا

 SPSS الأساسي لملفات بياناتالهيكل 

ات أو )الأعمادة(   SPSS  يتم تنظيم ملفاات بيااناات ي ملف    . حلااااااااااااااااب الحاالات أو )الصااااااااااااااافوف(، والمتغت 
فى

ى للاساااااااااااااااتطلاع أو الاساااااااااااااااتبياان. وتم ال  ى الفردي   ، تم ال الحاالات الملاااااااااااااااتجثب   ي الشاااااااااااااااكال التاالىي
البيااناات فى

ي الاستطلاع
ات الردود عل كل سؤال تم طرحه فى  . المتغت 
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 SPSS قراءة ملفات بيانات

ي لها امتداد ملف SPSS تحتوي ملفات بيانات برنامج
 . عل البيانات المحفوظة sav. الت 

 : محفوظ SPSS لفتح أو قراءة ملف بيانات

 : اخت  من اللأوائم

 ...  يانات< ب فتح<   ملف

File > Open > Data... 

 . لمزيد من المعلومات "ملفات الأم لة" راجع مو وع .demo.sav تصفح وافتح ملف

ي محرر البيانات 
 .Data Editorيتم عرل البيانات الآن فى

 
 SPSS ملفات بيانات

ي   Excelقراءة ملفات 
ى
 SPSS ف

ي محرر البيااااناااات  
ة فى  من  تااااباااة جمثع بياااانااااتاااك مبااااشر

ً
ي  بااادلا

، أي Excel  ، يم ناااك قراءة ملفااااتSPSSفى
اد وقراءة ملفات البيانات من تطبيلأات ا قراءة عناوين الأعمدة  .  Microsoft Excel  اسااااااااااتت 

ً
يم نك أيضاااااااااا

ات وتغثت  بعج الإعدادات.   ك سماء متغت 

اد وقراءة ملف بيانات ي  Excel فيما يلي خطوات استت 
 :SPSS فى

اد البيانات<  ملف : اخت  من اللأوائم .1  < إكسل استي 

File > Import Data > Excel 

 .demo.xlsxوحدد الملف  Samples \ Englishانتلأل إلى المجلد  .2

ي   Excel  يعرل ممنااع الحوار قراءة ملف
معاااااينااااة لملف البيااااانااااات. يتم عرل محتويااااات الورقااااة الأولى فى

 . الملف. إذا كان الملف يحتوي عل أوراق متعددة، فيم نك تحديد الورقة من اللأائمة
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اد قراءة ملفات ي  Excel ممنااع الحوار استت 

 SPSS  يعرل معاينة لملف البيانات فى

ي الشاكل أعلاه، يم نك أن ترى أن بعج قيم متغت  الجوس 
لها ملاافات بادئة. كما يتم عرل   Genderفى

 . ( 1 نلأاط ).( وليس )صفر أو   MaritalStatusبعج قيم الحالة الاجتماعية 

ات من الصف الأول  قراءة أسماء المتغي 

ات من الصاااااااااااااااف الأول من البيانات"ت  د من تحديد خيار . 3  Read variable "قراءة أساااااااااااااااماء المتغت 
names from the first row of data  . ، إذا كانت عناوين الأعمدة لا تتوافق مع قواعد اسام المتغت 

ات صاااااااااااااااالحة. يتم حف  عناوين الأعمدة الأصااااااااااااااالية   ات  متغت    تلااااااااااااااامياتيتم تحويلها إلى أساااااااااااااااماء متغت 
variable labels. 

 Remove leading spaces from stringحدد إزالة الملااااااااااااااافات البادئة من قيم اللااااااااااااااللاااااااااااااالة  . 4
values. 

ي تحادد نوع البيااناات  لاااااااااااااااقم باللغااء تحادياد الو. 5
 Percentage of values thatباة المئوياة لللأيم الت 

determine data type. 

ي كاااناات مفلأودة من النظااام للمتغت    No Answer"  يتم الآن عرل اللأيم "لا توجااد إجااابااة
ي ال لايااا الت 

فى
إذا لم ي ن هناااس معلمااة الولااااااااااااااابااة المئويااة لللأيم وكااان العمود  .  MaritalStatus"  "الحااالااة الاجتماااعيااة

 .Stringيحتوي عل مزيااااج من أنواع البيانات، فليتم قراءة المتغت   نوع بيانات سلللة 

 .String يتم الاحتفاظ بكل اللأيم، ولكن يتم التعامل مع اللأيم الرقمية  لأيم سلللة



 

ي 
ح برنامج التحليل الإحصائ   مصطفى فؤاد عبيد د. م.                        خطوة خطوة                                       - SPSSشر

 

16 

 

 
اد    ت ابعد تغثت  ال يارات والإعداد Excel قراءة ملف  -ممنااع الحوار استت 

ي تحاااادد نوع البيااااانااااات  .  6
( الولااااااااااااااابااااة المئويااااة لللأيم الت   Percentage of values thatحاااادد )اخت 

determine data type للتعامل مع MaritalStatus   كمتغت  رق ي . 

 .Excel للأراءة ملف OKانلأر فوق "موافق" . 7

ات. نظرًا لأن أساااااااماء   ي محرر البيانات، مع اسااااااات دام عناوين الأعمدة ك ساااااااماء متغت 
تظهر البيانات الآن فى

ات لا يم ن أن تحتوي عل ملااااااااااااافات، يتم إزالة الملااااااااااااافات من عناوين الأعمدة الأصاااااااااااالية. عل  المتغت 
يتم الاحتفاظ  .  MaritalStatusإلى المتغت     Marital Status سبيل الم ال، يتم تحويل عنوان العمود 
 .variable label بعنوان العمود الأصلي  تلمية متغت  

 
ي 
 Excel ت قراءة ملفاتا عدادإ الملتوردة بعد تنفيذ خيارات و  Excel يعرل بيانات  SPSS محرر البيانات فى
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اد وقراءة البيانات من مصادر قاعدة البيانات  استي 

ي 
اد وقراءة البيانات من مصااااااااااادر قاعدة البيانات بلااااااااااهولة باساااااااااات دام معالج قاعدة البيانات فى  يتم اسااااااااااتت 

SPSS  .يم ن قراءة أي قاعدة بيانات تلااااات دم برامج تشاااااغيل ODBC    )اتصاااااال قاعدة البيانات المفتوح(
ة بعد تثبيت برامج التشغيل. يتم توفت  برامج تشغيل للعديد من توليلأات قواعد البيانات   ODBC  مباشر

. تمت   ى ى ال ارجث   عل قر  التثبيت المضاغوط. يم ن الحصاول عل برامج تشاغيل إ اافية من البائع  
اد منااااقشااااااااااااااااااة   ا وهي قااااعااادة بيااااناااات أ لاااااااااااااااس    اتت 

وقراءة أحاااد تطبيلأاااات قواعاااد البيااااناااات الأ تح شاااااااااااااااثوعاااً
Microsoft Access، ي هذا الم ال
 . فى

.  Access لااااااااااااااODBC  ويتطلب برنامج تشغيل  Microsoft Windows : هذا الم ال خا  بااااااااااااااملاحظة

.  SPSS  باات من برنااامج  32  فلأ  مع الإصااااااااااااااااادار   Microsoft Access ODBC  يعماال برنااامج تشاااااااااااااااغياال

ي الأنظمة الأسااااااااااااااساااااااااااااية الأخرى ولكنها قد تتطلب برنامج تشاااااااااااااغيل
لجهة   ODBC ال طوات متشاااااااااااااابهة فى
 . خارجية للوصول

اد وقراءة البيانات   باستخدام معالج قاعدة البياناتاستي 

ي 
 :SPSS خطوات قراءة البيانات من مصادر قاعدة البيانات باست دام معالج قاعدة البيانات فى

 : اخت  من اللأوائم. 1

اد البيانات<   ملف  استعلام جديد<  قاعدة البيانات<  استي 

File > Import Data > Database > New Query... 

ي معالج قاعدة البيانات. تم تحديد 
حيب فى من قائمة مصاااااااااادر   MS Access Database  تظهر لوحة الت 
 . البيانات المتاحة

 
 من قائمة مصادر البيانات المتاحة   MS Access Database ممنااع الحوار "ترحيب معالج قاعدة البيانات" مع تحديد 
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من قاائماة مصااااااااااااااااادر البيااناات ام انلأر فوق    MS Access Databaseحادد قااعادة بيااناات أ لاااااااااااااااس  .  2
 .Next "التالىي "

ا قاائماة بمصااااااااااااااااادر بيااناات ملاحظ ة
ً

عل الجااناب   OLEDB: بنااءً عل التثبيات ال اا  باك، قاد ترى أيضاااااااااااااااا
فلأ (، ولكن هذا الم ال  لاات دم قائمة مصااادر بيانات    Windowsالأ  اا من المعالج )أنظمة تشااغيل 

ODBC  .المعرو ة عل الجانب الأيمن 

 . الذي تميد فتحه Access للانتلأال إلى ملف قاعدة بيانات Browse" انلأر فوق "استعرال. 3

 . لمزيد من المعلومات" ملفات الأم لة" راجع مو وع. demo.mdbافتح ملف الم ال . 4

ي ممنااع حوار تلجيل الدخول OK انلأر فوق "موافق". 5
 . فى

ادها ات المطلوب استي   تحديد الجداول والمتغي 

ي الشكل التالىي 
ادها، كما يظهر فى ي تميد استت 

ات الت  ي ال طوة التالية، يم نك تحديد الجداول والمتغت 
 : فى

 
اد من قاعدة البيانات   ممنااع الحوار "تحديد البيانات" مع تحديد كافة الحلأول للاستت 

،  Available Tablesة"  ب  مله من عمود "الجداول المتاح  Demoاسحب جدول الم ال التو يجي  .  6
تيب" أو  داد الحلأول بهذا الت   .Retrieve Fields In This Orderإلى عمود: "است 

اد مجموعاة فرعياة من الحاالات )عل سااااااااااااااابيال  اد جمثع الحاالات، يم ناك اساااااااااااااااتت  إذا  نات لا تمياد اساااااااااااااااتت 
اد عثنة عشااااوائية من الحالات من مصاااادر البيانات.    30الم ال، الذ ور الأ ت  من   عامًا(، أو يم نك اسااااتت 

ة، ي قلاااااا عدد الحالات عل عثنة صاااااغت 
ة، قد ترغب فى أو عثنة تم ل كل   بالولااااابة لمصاااااادر البيانات الكبت 

 .البيانات، لتلأليل وقت المعالجة

 . للمتابعة Next" التالىي "انلأر فوق زر . 7
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ات  استخدام أسماء الحقول لإنشاء أسماء المتغي 

ات   ي جدول قاعدة البيانات لإ شااااااااااااء أساااااااااااماء متغت 
لااااااااااات دم أساااااااااااماء الحلأول فى

 
ي   Variable Namesت

 فى
SPSS  .  ات صاااااااااااالحة، ويتم الاحتفاظ إذا لزم الأمر، يتم تحويل الأساااااااااااماء عت  الصاااااااااااالحة إلى أساااااااااااماء متغت 

ات  ا تغثت   .  Variable Labelsب سااااماء الحلأول الأصاااالية )غت  الصااااالحة(  تلااااميات للمتغت 
ً
يم نك أيضاااا

اد قاعدة البيانات ات قبل استت   . أسماء المتغت 

 . للمتابعة Next "التالىي "انلأر فوق زر . 8

 
ات  ى إلى خلية رقمية لمتغت  الجوس   -خطوة تعميف المتغت  مت 

ادها. تم تحديد إعادة الت  ات المحددة لثتم استت   شد كل المتغت 

ى إلى عددي. ا9 مت 
ي حلأل الجوس  Recode to Numeric"  نلأر فوق "إعادة الت 

يحول هذا .  Gender فى
ويحتف  باللأيمة الأصااااااالية   Integerإلى متغت  عددي صاااااااحثح    Stringال يار نوع المتغت  من ساااااااللااااااالة  
 .Value Label تلمية قيمة للمتغت  الجديد 

 . للمتابعة Next "التالىي "انلأر فوق زر . 10

ي خطوة النتائج.  SQLتظهر عبارة الاساااتعلام  
ي معالج قاعدة البيانات فى

ي تم إ شاااا ها من التحديدات فى
الت 

ا 
ً
ي ملف لاست دامها لاحلأ

 . يم ن تنفيذ هذه العبارة الآن أو حفظها فى

اد البيانات Finishانلأر فوق "إنهاء" . 11  .لاستت 

ي قاااااعاااادة بيااااانااااات
ي محرر   Access  جمثع البيااااانااااات الموجودة فى

اد متاااااحااااة الآن فى ي حااااددتهااااا للاساااااااااااااااتت 
الت 

 . البيانات
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ي  
ى
 SPSSقراءة البيانات من ملف نصي ف

ي برنامج  
، ويم ن للعديد من برامج جداول SPSSتم ل الملفات النصاااااااااية مصااااااااادرًا شاااااااااائعًا  خر للبيانات فى

شااااااااااااات  الملفات 
 
البيانات وقواعد البيانات حف  محتوياتها ب حد تولااااااااااااايلأات الملفات النصاااااااااااااية العديدة. ت

ي تلااات دم الفواصااال أو علامات الجدولة 
المحددة بفواصااال أو بعلامات جدولة إلى صااافوف البيانات الت 

ي هذا الم ال، سااااااااااوف يتم قرا 
. فى ي للإشااااااااااارة إلى كل متغت 

بحي  ت ون   SPSSءة البيانات من ملف نصىااااااااااي فى
 .tab-delimitedالبيانات محددة بعلامات جدولة 

ي 
ح خطوات قراءة بيانات الملفات النصية فى  .SPSS فيما يلي سوف يتم شر

ي 
ى
 SPSS خطوات قراءة البيانات من ملف نصي ف

اد البيانات<  ملف : اخت  من اللأوائم. 1  بيانات نصية<  استي 

File > Import Data > Text Data 

 .demo.txtوحدد الملف  Samples \ Englishانتلأل إلى المجلد . 2

اد النص  بلرشاااادس خلال عملية تحديد  يفية تفلااات  الملف    Text Import Wizardيلأوم معالج اساااتت 
ي الشكل التالىي 

 : النصىي المحدد. والذي يظهر كما فى

 
اد النص: ال طوة   ي  - 6من  1معالج استت 

 SPSS قراءة البيانات من ملف نصىي فى

ي ال طوة . 3
ا  1فى

ً
أو إ شاااااء تولااااثق جديد    Predefined Format، يم نك اختيار تولااااثق محدد ملاااابلأ

ي المعالج. حدد 
 . ، لإ شاء تولق جديد No "لا"فى

 . للمتابعة Next" التالىي "انلأر فوق زر . 4

ات  تحديد أسماء المتغي 

ا بعلامات جدولة 
ً
ا محدد

ً
ا،  لاااااااات دم هذا الملف تولاااااااايلأ

ً
ا، يتم  .  tab-delimitedكما ذ رنا سااااااااابلأ

ً
أيضاااااااا

ات  ي اللطر العلوي من هذا الملف Variable Namesتحديد أسماء المتغت 
 . فى

ي ال طوة  .  5
للإشارة إلى أن الملف يحتوي عل بوية تولثق   Delimited  "محدد"من المعالج، اخت     2فى

 . محددة
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ي أعل الملف. 6
ات فى  . حدد نعم للإشارة إلى أن الملف يتضمن أسماء المتغت 

 . للمتابعة Next "التالىي "انلأر فوق زر . 7

ي ال طوة  .  8
ات   2، أدخال 3فى لرقم اللاااااااااااااااطر الاذي تبادأ فياه الحاالاة الأولى للبيااناات )لأن أسااااااااااااااامااء المتغت 

ي اللطر الأول( 
 . موجودة فى

ي هذه ال طوة، وانلأر فوق  . 9
ا ية بدون تغثت  للبلأية فى

 . للمتابعة  Next "التالىي زر "احتف  باللأيم الافت 

ي ال طوة 
 . طميلأة شيعة للت  د من قراءة الملف بشكل صحثح 4توفر لك معاينة البيانات فى

يتم تحادياد  .  Delimitersوقم باللغااء التحادياد لل ياارات الأخرى للمحاددات  Tab "التبوياب"حادد  .  10
عد الملااااافات جزءًا   Spaceالملااااافة 

 
ا اااايًا لأن الملف يحتوي عل ملااااافات. بالولاااابة لهذا الملف، ت افت 

للأراءة    Spaceتحتااج إلى إلغااء تحادياد الملااااااااااااااااافاة  .  Delimitersمن قيم البيااناات وليلاااااااااااااااات محاددات 
 . الملف بشكل صحثح

 Remove leading spaces for string لللأيم من نوع اللاااااللااااالةحدد إزالة الملاااااافات البادئة . 11
values .ات ي التعبت 

ي بداية قيم اللاللالة عل  يفية تلأثيم قيم اللاللالة فى
. تؤار الملاافات الموجودة فى

ي هذا الملف، تحتوي بعج قيم الجوس عل ملااااااافات بادئة ليلاااااات جزءًا من اللأيمة. إذا لم تلأم بلزالة 
فى

بدون  " f"  ع ملااااااااااااااافة بادئة  لأيمة م تلفة عن" مf ة "يتم التعامل مع قيموف  لاااااااااااااافهذه الملااااااااااااااافات، 
 . ملافة بادئة

 
اد النص: ال طوة    تحديد المحددات وإزالة الملافات البادئة  -  6من   4معالج استت 

 . للمتابعة Next "التالىي "انلأر فوق زر . 12

ي 
ات لتتوافق مع قواعد التلاامية فى الفرصااة لتحمير   5، تمنحك ال طوة SPSS نظرًا لتعديل أسااماء المتغت 

 . أي أسماء غت  مرغوب فثها 
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 تعريف أنواع البيانات

ا. عل ساااااااابيل الم ال، يم نك تغثت  نوع متغت  الدخل 
ً
إلى   Incomeيم ن تعميف أنواع البيانات هنا أيضاااااااا

 .Dollarعملة الدولار 

 :لتغثت  نوع البيانات

ي معاينة البيانات . 13
 .Income" الدخل"، حدد Data previewفى

 .Data format "تولثق البيانات"من اللأائمة المولدلة  Dollarحدد الدولار . 14

 
اد النص مع تحديد متغت  الدخل وتحديد الدولار لتولثق بيانات المتغت    5ال طوة   -تغثت  نوع البيانات   من معالج استت 

ة وقيم رقميااString ة  عل قيم من نوع اللاااااااااااااااللااااااااااااااالاا MaritalStatus  يحتوي متغت  الحااالااة الاجتماااعيااة
Numeric  . أقل من خملاااااااااااااة بالمائة من اللأيم عبارة عن قيم من نوع اللاااااااااااااللااااااااااااالة. باسااااااااااااات دام الإعداد
ي 
اضى ي  95الافت 

ي تحدد تولاااااااثق البيانات التللأائ 
 Percentage of values٪ للولااااااابة المئوية لللأيم الت 

that determine the Automatic data format  يتم التعاااماال مع المتغت  عل أنااه رق ي ويتم ،
ى قيم الللللة عل أنها بيانات مفلأودة من النظام.   تعث  

إذا لم يتوافق تولااااثق البيانات مع قيمة الولاااابة المئوية، فلاااايتم التعامل مع المتغت  كمتغت  سااااللاااالة. إذا  
يتم الاحتفااااااظ بكااااال اللأيم، ولكن يتم التعاااااامااااال مع كااااال اللأيم الرقمياااااة 100قمااااات بتغثت  الإعاااااداد إلى    ،

 . امل معها كالحروف ولا يتم إجراء العمليات الحلابية علثها( عيت يارها سلاسل )أتبباع

 . للمتابعة Next" التالىي "زر انلأر فوق . 15

ة، وانلأر فوق زر "إنهاا .  16 ي ال طوة الأخت 
ا اااااااااااااااياة كماا هي فى

اد   Finishء"  اترس التحاديادات الافت  لاساااااااااااااااتت 
 . البيانات

ي 
اد وقراءة البيانات من ملف نصىي فى  .SPSS بهذا توتهي خطوات استت 
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 الفصل الثالث

 محرر البيانات

 

 استخدام محرر البيانات

ي 
وهي طميلأة عرل البيانات وطميلأة    SPSSيم ن اساااات دام محرر البيانات مع طرق العرل الم تلفة فى

ات، حي  يعرل محرر البيانات  محتويات ملف البيانات الوشاااااااااا . تت ون    Data Editorعرل المتغت 
ات )أعمدة( وحالات )صفوف(.  ي محرر البيانات من متغت 

 المعلومات الموجودة فى

البيااااااااناااااااات   ي طميلأاااااااة عرل 
الحاااااااالات Data Viewفى الصااااااااااااااافوف  وتم ااااااال  ات،  المتغت  الأعمااااااادة  تم ااااااال   ،

 )الاستجابات أو الملاحظات(. 

ات  ي طميلأة عرل المتغت 
ا، وكل عمود  Variable Viewأما فى ً ي محرر البيانات، ي ون كل صااااااااااااف متغت 

فى
 . عبارة عن سمة مرتبطة بهذا المتغت  

ي جمعتها. التشابيه الشاائع هو الاساتطلاع أو 
ات لتم يل الأنواع الم تلفة من البيانات الت  لات دم المتغت 

 
ت

ات عل شاااااكل  ي المتغت 
ا. ت ئ  ً ي تعادل متغت 

ي الملاااااح الإحصاااااائ 
. الإجابة عل كل ساااااؤال فى ي

الملاااااح الإحصاااااائ 
ات العدية والل ي ذلك أنواع المتغت 

 . لاسل النصية والعملة والتارياااانالعديد من الأنواع الم تلفة، بما فى

ح بعج أسااليب اسات دام محرر البيانات  ، ساوف يتم شر إ اافة البيانات   وطرق  Data Editorفيما يلي
ي 
ي المحرر فى

ي المو وعات التاليةSPSS فى
 : ، وذلك كما فى

ي  •
ى
 SPSS إضافة البيانات الرقمية ف

ي  •
ى
 SPSS إضافة بيانات السلاسل ف

ات وإ افة التلميات لها  ها من المو وعات ال اصة بتعميف البيانات والمتغت   . وغت 

ي 
ى
 SPSSإضافة البيانات الرقمية ف

ة أو لإجراء   ا لملفاااات البيااااناااات الصاااااااااااااااغت 
ً
ي محرر البيااااناااات، مماااا قاااد ي ون مفياااد

يم ن إدخاااال البيااااناااات فى
ح طميلأاة إ ااااااااااااااااافاة  ي الم اال التاالىي ساااااااااااااااوف يتم شر

ا. فى تعاديلات طفيفاة عل ملفاات البيااناات الأ ت  حجماً
ي 
 .SPSSالبيانات الرقمية فى

 خطوات إضافة البيانات الرقمية

". انلأر فوق علامة التبويب "1 ي أسفل نافذة محرر البيانات.  Variable View عرض المتغي 
 فى

ات  ي هذا الم ال، هناس حاجة إلى الاث    Variablesتحتاج إلى تحديد المتغت 
ي ساااااااايتم اساااااااات دامها. فى

الت 
ات فلأ : العمر والحالة الاجتماعية والدخل.   متغت 
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ي طميلأة عرل المتغت  

ات فى ي   -أسماء المتغت 
 SPSSإ افة البيانات الرقمية فى

ي الصف الأول من العمود الأول، ا تب العم2
 .(age)ر . فى

ي ا تب الحالة الاجتماعي. 3
ي الصف ال ائى

 .(marital)ة فى

ي الصف ال ال ، ا تب الدخ. 4
 .(income)ل فى

ات الجديدة نوع بيانات رق ي تللأائيًا   . يتم إعطاء المتغت 

ات، فلاااااااوف يلأو  بل شااااااااء أساااااااماء فميدة تللأائيًا. ومع ذلك، فإن  SPSSم  إذا لم تلأم بلدخال أساااااااماء المتغت 
ة  . هذه الأسماء ليلت وصفية ولا يوض بها لملفات البيانات الكبت 

 . لمتابعة إدخال البيانات Data Viewانلأر فوق علامة التبويب طميلأة عرل البيانات . 5

ي طميلأااة عرل  
ي طميلأااة عرل المتغت  هي الآن عناااوين الأعماادة ال لااااة الأولى فى

ي أدخلتهااا فى
الأساااااااااااااااماااء الت 
 . البيانات

ي الشكل التالىي 
ي الصف الأول، بدءًا من العمود الأول. كما فى

 : ابدأ بلدخال البيانات فى
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ي محرر البيانات

ي طميلأة عرل البيانات كما تظهر فى
ي تم إدخالها فى

 اللأيم الت 

ي 6
 . 55، ا تب Age عمود العمر . فى

ي 7
 . 1، ا تب Marital عمود الحالة الاجتماعية . فى

ي عمود الدخل . 8
 . 72000، ا تب Incomeفى

ي من العمود الأول لإ افة بيانات الحالة التالية. 9
 . حرس المؤشر إلى الصف ال ائى

ي عمود العمر . 10
 . 53، ا تب Ageفى

ي عمود الحالة الاجتماعية . 11
 .0، ا تب Maritalفى

ي عمود الدخل أو . 12
 . 153000، ا تب Incomeفى

ياا ، تعرل أعماادة العمر والحااالااة الاجتماااعيااة علامااات ع ااااااااااااااار ي الوقاات الحااالىي
عل   Decimal Pointsة  فى

ات ي هذه المتغت 
ية فى ا صحيحة. لإخفاء العلامات الع ر

ً
 : الرغم من أن قيمها تهدف إلى أن ت ون أعداد

ي أسفل نافذة محرر البيانات  Variable Viewانلأر فوق علامة التبويب عرل المتغت  أو. 13
 . فى

ية . 14 ي عمود العلامات الع ر
ية 0، ا تب Ageر" للصف "العم Decimalsفى  . لإخفاء العلامة الع ر

ية . 15 ي عمود العلامات الع ااااااااااار
لإخفاء    0ا تب    ،Maritalة"  للصاااااااااااف "الحالة الاجتماعي  Decimalsفى

ية  . العلامة الع ر
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ي 
ى
 SPSS إضافة بيانات السلاسل ف

ي 
ي محرر البياناSPSS يم ن إدخال البيانات غت  الرقمية فى

ت ، م ل إ اااااااافة بيانات اللااااااالاسااااااال النصاااااااية، فى
Data Editor  ي

ي برنامج التحليل الإحصائ 
 .SPSS فى

ي برنااام
حياا  توجااد العااديااد من أنواع البيااانااات م اال البيااانااات   SPSSج  وت تلف أنواع البيااانااات المعرفااة فى

ي برنام
ي يتم التعامل معها بشكل م تلف فى

 .SPSSج الرقمية والبيانات النصية، والت 

ي 
ى
 :SPSS خطوات إدخال بيانات السلاسل ف

ي أسفل نافذة محرر البيانات Variable View انلأر فوق علامة التبويب عرل المتغت  . 1
 . فى

ي ال لية الأولى من أول صف فارغ، ا تب الجوس. 2
 . لاسم المتغت   Sexأو  فى

 . بجوار الإدخال ال ا  بك Type أو  "النوع"انلأر فوق خلية . 3

 لفتح ممنااع الحوار نوع المتغت    Type"  النوع"انلأر فوق الزر الموجود عل الجااااناااب الأيمن من خلياااة  .  4
Variable Type. 

 ل. لتحديد نوع المتغت  إلى نوع بيانات الللاس String" سلللة"حدد . 5

 . لحف  اختيارس والعودة إلى محرر البيانات OKق" انلأر فوق زر "مواف. 6

 
  نوع المتغت   String ممنااع حوار نوع المتغت  مع تحديد سلللة

ي برنام
ى
 SPSSج تعريف البيانات ف

ي برناام
،  Data Typesباالإ ااااااااااااااااافاة إلى تحادياد أنواع البيااناات   ،SPSSج  ااااااااااااااامن عملياة تعميف البيااناات فى

ات  ا تحديد التلاااااااااااااميات الوصااااااااااااافية للمتغت 
ً

و ذلك تلاااااااااااااميات اللأيم  ،  Variable Labelsيم نك أيضااااااااااااا
Value Label  ات وقيم البيانات. تلات دم هذه التلاميات الوصافي ي التلأارير   Labelsة  لأساماء المتغت 

فى
 . والم ططات الإحصائية



 

ي 
ح برنامج التحليل الإحصائ   مصطفى فؤاد عبيد د. م.                        خطوة خطوة                                       - SPSSشر

 

27 

 

ي برنام
ح أو عرل تعميف البيانات فى ي الأقلااام التالية سااوف يتم شر

وذلك باساات دام طرق كل .  SPSSج  فى
 : من

ات أو  .1  Variable Labelsإ افة تلميات للمتغت 

 Variable Type and Formatتغثت  نوع المتغت  وتوليلأه أو  .2

ات أو  .3  Value Labelsإ افة تلميات للأيم المتغت 

 Missing Dataمعالجة البيانات المفلأودة أو  .4

 Numeric Variableقيم مفلأودة لمتغت  رق ي  .5

 String Variableقيم مفلأودة لمتغت  سلللة أو  .6

ي هذا ة:  ملاحظ
يم ن مراجعة مو ااااااااااوع ملفات الأم لة لمزيد من المعلومات عن الأم لة الملاااااااااات دمة فى

 هذا الكتاب. و المو وعات الأخرى  من لألم أال

ات   إضافة تسميات للمتغي 

ات أو  ي   Variable Labelsتهدف إ ااااافة تلااااميات للمتغت 
ات. غالبًا   SPSSفى إلى تلأديم أوصاااااف للمتغت 

ات. يم ن أن يصااااااال حجم التلاااااااميات إلى  ا أطول من أساااااااماء المتغت 
ً
 255ما ت ون هذه الأوصااااااااف  لااااااا 

ات الم تلفة وجعلها تبدو أ تح  ى المتغت  ي الإخراج ال ا  بك لتمثت 
بايت. يتم اسات دام هذه التلاميات فى

ي قد ت ون م تلا 
ات الت  ي قواعد برنامج و وحًا من أسماء المتغت   تلت 

 .SPSSة حت 

ات  :خطوات إضافة تسميات للمتغي 

ي أسااااااااااااااافال ناافاذة محرر البيااناات    Variable View. انلأر فوق علاماة التبوياب عرل المتغت   1
 Dataفى

Editor. 

ي عمود التلاااااااااامية 2
 Respondent'sب"  ، ا تب "عمر الملااااااااااتجيAgeلصااااااااااف "العمر"   Label. ام فى

Age. 

ي عمود التلااااااااااااااامياا.  3
ي صاااااااااااااااف الحااالااة الاجتماااعيااة    Labelة  وفى

ة"  ، ا تااب "الحااالااة الاجتماااعيااMaritalفى
Marital Status. 

ي عمود التلاااااااااااااااميااااا.  4
 Householdة"  ، ا تاااااب "دخااااال الأش Incomeلصاااااااااااااااف الااااادخااااال    Labelة  ام فى

Income. 

ي عمود التلمي. 5
ي صف الجوس  Labelة ام فى

 .Genderس" ، ا تب "الجوSexفى
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ي 
ي طميلأة عرل متغت  فى

ات فى  SPSS إ افة تلميات للمتغت 

ي هذا :  ةملاحظ
يم ن مراجعة مو ااااااااااوع ملفات الأم لة لمزيد من المعلومات عن الأم لة الملاااااااااات دمة فى

ي 
 .SPSS المو وع أو المو وعات الأخرى  من دورة تدريب برنامج التحليل الإحصائ 

ي 
ى
 SPSS  تغيي  نوع المتغي  وتنسيقه ف

ي   Typeع يعرل عمود النو 
. كما يوفر إمكانية تغثت  نوع المتغت  وتولاااايلأه فى  نوع البيانات الحالىي ل ل متغت 

SPSS  . أنواع البيانات شااااااااااثوعًا هي البيانات الرقمية واللاااااااااالاساااااااااال، ولكن يتم دعم العديد من الأنواع 
أ تح

، يتم تعميف الدخ ي ملف بيانات الم ال الحالىي
 .Numeric  نوع رق ي   Incomeل الأخرى. فى

، ام انلأر فوق الزر الموجود عل الجااانااب الأيمن من Incomeل  انلأر فوق خليااة النوع لصاااااااااااااااف الاادخاا.  1
 .Variable Type ال لية لفتح ممنااع الحوار نوع المتغت  

 .Dollarر الدولاعملة حدد . 2

ي الشكل التالىي 
 : يتم عرل خيارات التولثق لنوع البيانات المحدد حاليًا، كما فى
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 مع تحديد الدولار  نوع  Variable Type ممنااع الحوار 

ي 
 . المرغوب به لهذا النوع Formatق ، يتم تحديد التولثSPSS بعد تحديد نوع المتغت  فى

ي هذا الم ال، حدد التولاثق التالىي . 3
 $ ###: بالولابة إلى نوع العملة أو الدولار، توجد عدة تولايلأات. فى

###  ،### ،###. 

ات ال اصة بك OKق" انلأر فوق زر "مواف. 4  . لحف  التغثت 

ي هذا :  ملاحظة
يم ن مراجعة مو اااااااااااوع ملفات الأم لة لمزيد من المعلومات عن الأم لة الملااااااااااات دمة فى

ي 
 .SPSS المو وع أو المو وعات الأخرى  من دورة تدريب برنامج التحليل الإحصائ 

ي 
ى
 SPSSإضافة تسميات القيمة ف

ي   Value Labelsة توفر إ اااااافة تلاااااميات اللأيم
ا  SPSS فى ال اصاااااة   Valuesت طميلأة لمن  قيم المتغت 

ي هذا الم ال، هناس قيمتان ملأبولتان لمتغت  "الحالة .  Stringة  من النوع ساااااااااللااااااااال  Labelة  بك بتلااااااااامي
فى

ي اللأيمااااة ) .  Maritalة"  الاجتماااااعياااا
ي اللأيمااااة )صااااااااااااااافر( أن الحااااالااااة "أعزب"، وتعتى

وج".  1تعتى ى أنااااه "مت   )
 . والمطلوب رن  هذه اللأيم بتلك التلميات

 خطوات إضافة تسميات القيمة

، ام انلأر فوق الزر الموجود Maritalة" للصاااااااااااااااف "الحاالاة الاجتمااعيا  Valuesم  انلأر فوق خلياة اللأي.  1
 .Value Labelsة" "تلميات اللأيمر عل الجانب الأيمن من ال لية لفتح ممنااع الحوا

 : لاحظ أن

ي إجراءات وحلاااااااااااابات   Valueو اللأيمة أ
ي يتم اسااااااااااات دامها فى

. وهي الت  هي اللأيمة الرقمية الفعلية للمتغت 
ي 
 . التحليل الإحصائ 

ي يتم تطبيلأها عل اللأيمة   Value Labelو تلااااااااامية اللأيمة أ
هي مجرد تلااااااااامية من النوع ساااااااااللااااااااالة، والت 

ي كالم ططات البيانية والجداول 
ي م رجات التحليل الإحصااااااااااااائ 

لاااااااااااات دم فى
 
ي ت
الرقمية المحددة. وهي الت 

ها   . وغت 
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ي حلأل اللأيم 0 ا تب )صفر( . 2
 .Valueة فى

ي حلأل تلمي Singleب" ا تب "أعز . 3
 .Labelة فى

 . لإ افة هذه التلمية إلى اللأائمة Addة" ام انلأر فوق زر "إ اف. 4

 
ي  -ممنااع الحوار "تلميات اللأيمة"  

 SPSS إ افة تلميات اللأيمة لمتغت  فى

ي حلأل اللأيم1ا تب ) . 5
و Valueة ( فى ى ي حلأل التلمي Marriedج" ، وا تب "مت 

 .Labelة فى

ات والعودة إلى محرر   OKق"  مواف"، ام انلأر فوق  Add  "الإ اااااااااااااااااافااة"ام انلأر فوق زر  .  6 لحف  التغثت 
 .Data Editor البيانات

ي طميلأة عرل البيانات  
ا عرل هذه التلميات فى

ً
، مما يجعل بياناتك أ تح قابلية  Data Viewيم ن أيض
 . لللأراءة

ي أسااااااااااااااافاال نااافااذة محرر البيااانااا  Data View  ام انلأر فوق علامااة التبويااب عرل البيااانااات.  7
 Dataت  فى

Editor. 

 م: ام اخت  من اللأوائ. 8

 تسميات القيمة<  عرض

View > Value Labels 

ي محرر البيااانااات. يفيااد هااذا 
ي قااائمااة مولاااااااااااااااادلااة عناادمااا تلأوم باالدخااال قيم فى

يتم الآن عرل التلاااااااااااااااميااات فى
 
ً
وج( بدل ى اح إدخالات صحيحة وتلأديم إجابة وصفية أ تح للبيانات )أعزب، مت  ي اقت 

 من )صفر، الإعداد فى
1 ) . 

ي  اااااااااب  عمليات الإدخال والتحلأق من صاااااااااحة إدخال البيانات )تمنع ملحوظة
: تلااااااااااهم هذه العملية فى

ي للبيانات(. 
 إدخال قيم غت  الصفر والواحد والذي يؤار عل نتائج التحليل الإحصائ 

ا بالفعل )مع وجود علامة اختيار بجواره(،   Value Labelsة"  قائمة "تلميات اللأيم  إذا كان عنلا 
ً
 شط

 . فلثؤدي اختيار "تلميات اللأيمة" مرة أخرى إلى إيلأاف تشغيل عرل تلميات اللأيمة
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ي 
ى
  SPSSمعالجة البيانات المفقودة ف

ا بحي  لا يم ن تجاهلها. قد يرفج    Missing Valuesالبيانات المفلأودة  
ً
أو غت  الصااااااالحة شااااااائعة جد

المجثبون عل الاسااااااااتبيان أو الاسااااااااتطلاع الإجابة عل أساااااااائلة معثنة. وقد لا يعرفون الإجابة علثها، أو قد 
يجثبون بصاايغة غت  متوقعة وغت  محددة  اامن خيارات الاسااتبيان. إذا لم تلأم بتصاافية هذه البيانات أو 

وري معااالجااة البيااانااات   تحاادياادهااا، فلأااد  ي نتااائج دقيلأااة. لااذا، فااإنااه من اللااااااااااااااااى
لا يوفر تحليلااك الإحصاااااااااااااااااائ 

ي 
ي برنامج التحليل الإحصائ 

ي للبيانات فى
 .SPSSالمفلأودة قبل إجراء التحليل الإحصائ 

ي 
ى
 SPSSمعالجة البيانات المفقودة تلقائيًا ف

ي تحتوي عل Numericباالولاااااااااااااااباة للبيااناات الرقمياة 
، يتم تحويال حلأول البيااناات الفاارغاة أو الحلأول الت 

ي يم ن تعميفهاا بنلأطاة  System-Missingإدخاالات غت  صااااااااااااااااالحاة إلى بيااناات مفلأودة من النظاام  
، والت 

 واحدة ).(. 

ى  ى ب   ا لتحليلاك. عل سااااااااااااااابيال الم اال، قاد تجاد أناه من المفياد التمثت  قاد ي ون ساااااااااااااااباب فلأادان اللأيماة مهماً
ى الذين لم يجثبوا عل  ى الملاتجثب   ي الاساتبيان ون  

ى الذين رفضاوا الإجابة عل ساؤال فى هؤلاء الملاتجثب  
 للتطبثق. 

ً
 سؤال لأنه لم ي ن قابلا

 معالجة القيم المفقودة للبيانات الرقمية

تاحة لتحديدها وتلمثتها   : فيما يلي خطوات معالجة اللأيم المفلأودة للبيانات الرقمية والطرق الم 

ي أسااااااااااااااافاال نااافااذة محرر البيااانااات   Variable View  انلأر فوق علامااة التبويااب طميلأااة عرل المتغت  .  1
فى

Data Editor. 

ي صااااااااااااااف العم. 2
، ام انلأر فوق الزر الموجود عل الجانب الأيمن من Ageر  انلأر فوق ال لية المفلأودة فى

 .Missing Valuesة" ال لية لفتح ممنااع الحوار "اللأيم المفلأود

ي ممنااع الحوار هذا، يم نك تحديد ما يصااااااااااااااال إلى الاث قيم مفلأودة م تلفة  . 3
 Discrete missingفى

valuesق ، أو تحديد نطاRange من اللأيم بالإ افة إلى قيمة مفلأودة واحدة م تلفة عن النطاق . 

 
 Missing Valuesة"  ممنااع حوار "اللأيم المفلأود

 .Discrete missing valuesة حدد اللأيم المفلأودة الم تلف. 4
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ى   999ا تب . 5 ي ممنااع النص الأول واترس ممنعي النص الآخمين فارغ  
 . فى

ات والعودة إلى محرر البيانا OKق" انلأر فوق زر "مواف. 6  .Data Editorت لحف  التغثت 

 تطبيق تسمية على القيم المفقودة

 . عل تلك اللأيمة Labelة الآن وقد تمت إ افة قيمة البيانات المفلأودة، يم ن تطبثق تلمي

ي صااااااااااااف العمر    Valuesم  انلأر فوق خلية اللأي. 7
، ام انلأر فوق الزر الموجود عل الجانب الأيمن Ageفى

 .Value Labelsة" من ال لية لفتح ممنااع الحوار "تلميات اللأيم

ي حلأل اللأيم  999ا تب . 8
 .Valueة فى

ي حلأل التلمية No Responseة ا تب لا توجد استجاب. 9
 .Label فى

 . لإ افة هذه التلمية إلى ملف البيانات ال ا  بك Add" إ افةزر "انلأر فوق . 10

ات والعودة إلى محرر البيانا OKق" انلأر فوق زر "مواف. 11  .Data Editorت لحف  التغثت 

ات السلسلة  معالجة القيم المفقودة لمتغي 

ات اللاااااااااللااااااااالة  ي   Stringيتم التعامل مع اللأيم المفلأودة لمتغت 
بشاااااااااكل مشاااااااااابه لللأيم المفلأودة    SPSSفى

ات الرقميااة   ى الحلأول الفااارغاة  Numericللمتغت  ات الرقميااة، لا يتم تعث   . ومع ذلااك، عل ع س المتغت 

ات اللاااااااااااااااللااااااااااااااالااة عل أنهااا بيااانااات مفلأودة من النظااام   ي متغت 
 من ذلااك، يتم  System-Missingفى

ً
. باادلا

ها عل أنها سلللة فارغة   .Empty Stringتفلت 

ات السلسلة وتسميتها   : خطوات تحديد القيم المفقودة لمتغي 

ي أسفل نافذة محرر البيانات. ا1
 . نلأر فوق علامة التبويب عرل المتغت  فى

ي صاااااااف الجوس. 2
، ام انلأر فوق الزر الموجود عل الجانب الأيمن من sex انلأر فوق ال لية المفلأودة فى

 .Missing Valuesة" ال لية لفتح ممنااع الحوار "اللأيم المفلأود

ي 3
 .Discrete missing valuesة  ممنااع الحوار هذا، حدد خيار اللأيم المفلأودة المنفصل. فى

ي ممنااع النص الأول NR ا تب. 4
 . فى

ي 
ات اللاااااللااااالة فى ة  حلااااااساااااة لحالة الأحرف. لذلك، لن يتم التعامل مع قيم   SPSS اللأيم المفلأودة لمتغت 

nr  لأيمة مفلأودة  . 

ات والعودة إلى محرر البيانا OKق" انلأر فوق "مواف. 5  .Data Editorت لحف  التغثت 

 : الآن يمكنك إضافة تسمية للقيمة المفقودة

ي صاااااف الجوس    Valuesم  نلأر فوق خلية اللأي. ا6
، ام انلأر فوق الزر الموجود عل الجانب الأيمن sexفى

 .Value Labelsة" من ال لية لفتح ممنااع الحوار "تلميات اللأيم

ي حلأل اللأيم NRب ا ت. 7
 .Valueة فى

ي حلأل التلمي No Responseة" لا توجد استجاب"ا تب . 8
 .Labelة فى

وعك Addة" "إ افزر انلأر فوق . 9  . لإ افة هذه التلمية إلى م ر

ات والعودة إلى محرر البيانا OKق" انلأر فوق "مواف. 10  .Data Editorت لحف  التغثت 
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 الفصل الرابع

 إحصائيات المتغيرات الفردية

 

ات الفردية  تلخيص البيانات للمتغي 

ي برنامج  
ات الفردية فى يناقش هذا اللألااااااام بعج الملأاييس البلااااااايطة الهادف إلى تل يص البيانات للمتغت 

ي  
ي يجااب  SPSSالتحليااال الإحصاااااااااااااااااائ 

، و يف يؤار ملاااااااااااااااتوى قيااااس المتغت  عل أنواع الإحصاااااااااااااااااائياااات الت 
. كما يم ن مراجعة مو اااااوع "ملفات الأم لة"  demo.savاسااااات دامها. سااااايتم اسااااات دام ملف البيانات 

 لمزيد من المعلومات. أو لتحميل الملفات. 

ي يتم تل يصااها، وذلك 
وتلااتلزم عمليات تل يص البيانات المعرفة الملاابلأة بملااتوى قياس البيانات الت 

لأن طميلأة التل يص ت تلف باختلاف نوع البيانات وملااااااااااتوى اللأياس الملاااااااااات دم فثها. م لا قد ت ون  
، وهذا الأمر يؤدي إلى اختلاف طميلأة   التل يص بشكل البيانات من نوع ملتوى اللأياس الفئوي أو ال  ي

ي 
ي برنامج التحليل الإحصائ 

 .SPSSعام فى

م لا، إذا أردناااا تل يص بيااااناااات اساااااااااااااااتجااااباااة مجموعاااة من الطلاب عل اساااااااااااااااتبياااان خاااا  بلأيااااس قااادرة  
الاستيعاب، قد يلزم است دام تلأليم البيانات وفق فئات متعددة أو بناء عل متغت  من نوع قياس فئوي 

، بحياا  تظهر النتيجااة وفق هااذا التصاااااااااااااااويف.   وه ااذا يحاادد نوع الجوس للطااالااب ومااا إذا كااان ذ ر أو أنتح
ات اللأياس ال  ي   . بالولبة لمتغت 

ي 
ى
 SPSSمستوى القياس للبيانات ف

ي  
ا عل ملاااااااااااااااتوى  SPSSإن ملأاااييس تل يص البيااانااات مناااسااااااااااااااابااة لأنواع م تلفااة من البيااانااات فى

ً
، اعتماااد

 اللأياس: 

 . البيانات التصنيفية )بيانات مستوى القياس الفئوية(1

ة )عل سابيل   Categoricalالبيانات التصاويفية   ى هي بيانات ذات عدد محدود من اللأيم أو الفئات الممت 
ا باسم البيانات النوعية 

ً
 .Qualitative Dataالم ال، الجوس أو الحالة الاجتماعية(.  شار إلثها أيض

ات الفئوية عبارة عن بيانات ساااللااالة   أو   Alphanumericأبجدية رقمية   Stringيم ن أن ت ون المتغت 
ات رقمياة   ا رقمياة لتم يال الفئاات. )عل سااااااااااااااابيال الم اال:   Numericمتغت 

ً
ي تلااااااااااااااات ادم رموز

= غت     0الت 
وج و ى وج(.  1مت  ى  = مت 

 : هناك نوعان أساسيان من البيانات الفئوية

ملازم للفئات. عل ساااااااااااابيل   Orderب  وهي البيانات الفئوية حي  لا يوجد ترتي:  Nominal  اساااااااااااا ي  •
ق ليلااااااااااات أعل أو أقل من فئة وظائف قلااااااااااام التلاااااااااااوي  Salesت الم ال، فئة وظائف قلااااااااااام المبيعا

Marketing  العل ي  أو البحResearch. 

ي  • ذو معتى للفئاات، ولكن لا توجاد   Orderب هي البيااناات الفئوياة حيا  يوجاد ترتيا:  Ordinal  ترتثت 
ى الفئاااات  Distanceة  ملااااااااااااااااااافااا عل سااااااااااااااابيااال الم اااال، هنااااس ترتياااب لللأيم عاااالياااة   . قاااابلاااة لللأيااااس ب  

ى تلك اللأيم  . ومتوسطة ومن فضة، ولكن لا يم ن حلاب "الملافة" ب  
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ي .  2
 بيانات القياس الكم 

ي يتم تلأاااديرهااا:  Scale  بيااااناااات اللأيااااس ال  ي 
ي  وهي البيااااناااات الت  ي   Interval  ا بااااللأيااااس الفت   أو الولااااااااااااااات 

Ratio  .م  حي  تشاااات  قيم البيانات إلى كل من ترتيب اللأيOrder  ى اللأي عل .  Distanceم  والملااااافة ب  
دولارًا أممي يًا،    52398دولارًا أممي يًا أعل من راتب قدره    72195ساااااااابيل الم ال، يعد الراتب الذي يبل   
 هي  
ى ى اللأيمت   باااااالبيااااااناااااات ال ميااااا  19797كماااااا أن الملاااااااااااااااااااافاااااة ب   ا 

ً
أيضااااااااااااااااااا إلثهاااااا  ا.  شاااااااااااااااااااار  ة دولارًا أممي ياااااً

Quantitative  ة المتصلالبيانات أوContinuous. 

 إجراءات تلخيص البيانات التصنيفية

ي إجراءات تل يص البيااااناااات التصاااااااااااااااويفياااة أو الفئوياااة  
ي    Categoricalفى

، فاااإن ملأيااااس المل ص SPSSفى
ي كل فئة. 

  الأ تح شثوعًا هو عدد أو  لبة الحالات فى

ي بها أ ت  عدد من الحالات.  Modeالمنوال 
 هو الفئة الت 

تيبياة   ي يلأع عنادهاا نصاااااااااااااااف   Median، قاد ي ون الوساااااااااااااااي  Ordinalباالولاااااااااااااااباة للبيااناات الت 
)اللأيماة الت 

ا تل يصااااااااااااايًا   ا إذا كان هناس عدد  بت  من الحالات أعل منها والنصاااااااااااااف الآخر أقل منها( هو ملأياساااااااااااااً
ً
مفيد

 .Categoriesالفئات 

   Frequency Tablesجاااداول ت رارياااة أو    Frequenciesيوتج عن إجراء فحص الت رارات  
ً
تعرل كلا

 .  من عدد الحالات و لبتها المئوية ل ل قيمة ملحوظة لمتغت 

 خطوات تلخيص البيانات الفئوية

 . اخت  من اللأوائم: 1

 ...  تحليل < إحصائيات وصفية < التكرارات

Analyze > Descriptive Statistics > Frequencies... 

 Frequenciesيظهر ممنااع حوار الت رارات أو 

ة خيار قاعدة الإحصائيات ملاحظة ى  .Statistics Base option: تتطلب هذه المت 

وحلأل "يمتلك    Owns PDA [ownpda]" حدد حلأل "يمتلك جهاز الملاااااااااعد الرق ي الشاااااااا صىااااااااي . 2
 .Variable (s) وانلألهما إلى قائمة المتغت  )ات(  Owns TV [owntv]ن" جهاز تليفزيو 

 
ي 
ي ممنااع حوار الت رارات فى

ات الفئوية المحددة للتحليل فى  SPSS المتغت 
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 . لتشغيل الإجراء  OKق" انلأر فوق زر "مواف. 3

ي نافذة العار 
ي الشكل التالىي   Viewerل يتم عرل جداول الت رارات فى

 : كم رجات كما فى

 
ي   -الجداول الت رارية 

 SPSS تل يص البيانات التصويفية أو الفئوية فى

 ٪ فلأ  من الأشااااا ا  يمتلكون أجهزة الملااااااعد الرق ي الشااااا صىاااااي 20.4ت شاااااف جداول الت رارات أن  
Owns PDA  . ا يمتلااك جهاااز تلفزيو قااد لا ت ون هااذه (.  ٪99) حوالىي    ،Owns TVن  لكن الجمثع تلأميبااً

ة للاهتمام، عل الرغم من أنه قد ي ون من الم ت  للاهتمام معرفة المزيد عن المجموعة   ا تشااااااااافات م ت 
ة من الأش ا  الذين لا يمتلكون أجهزة تلفزيون  . الصغت 

ي 
ى
ي للبيانات التصنيفية ف

 SPSSالتخطيط البيانى

ي 
ي للبيانات التصاااااااااويفية أو الفئوية فى

ي الت طي  البيائى
ي جدول   SPSSفى

يم نك عرل المعلومات الواردة فى
 .Pie Chartأو الم ط  الدائري  Bar Chartالت رار بيانيًا باست دام م ط  الأعمدة 

ي  تخطوا
 إجراء التخطيط البيانى

ي ال طوة  Frequency. فتح ممنااع حوار الت رارات  1
ين كمااا فى ى تحااديااد المتغت  مرة أخرى. )لا يزال يتع  
: حدد حلأل "يمتلك جهاز الملاااعد الرق ي الشاا صىااي  ي المو ااوع اللااابق وهي كما يلي

 Owns"  ال انية فى
PDA [ownpda]  ن"  وحلأال "يمتلاك جهااز تليفزيوOwns TV [owntv]    وانلألهماا إلى قاائماة المتغت

 .Variable (s)  )ات( 

ي  الأدوات للعودة    Dialog Recallر" يم نك اسااااااااااااات دام زر "اساااااااااااااتدعاء ممنااع الحوا الموجود عل شر
ي المو وع اللابق( 

ي حالة است دام الم ال المذ ور فى
 . ب عة إلى الإجراءات الملت دمة مؤخرًا )كما فى

 
 "زر "استدعاء ممنااع الحوار
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 .Chartsة" المخططات البياني" انلأر فوق. 2

 .Continueة" ام انلأر فوق زر "متابع Bar Charts" م ططات الأعمدة"حدد . 3

ي ممنااع الحوار الرئيشي لتشغيل الإجراء  OKق" انلأر فوق "مواف
 . فى

ي يظهر 
ي نافذة العار الم ط  البيائى

ي الشاكل    Viewerل  للبيانات التصاويفية أو الفئوية المطلوب فى
كما فى

 : التالىي 

 
ي العارل 

ي للبيانات التصويفية أو الفئوية  -م ط  الأعمدة يظهر فى
 الت طي  البيائى

 النتيجة

ي شاااكل م ط  أعمدة،  Frequenciesر  بالإ اااافة إلى جداول الت را
، يتم الآن عرل نفس المعلومات فى

مما يجعل من اللااهل ر ية أن معظم الأشاا ا  لا يمتلكون أجهزة الملاااعد الرق ي الشاا صىااي ولكن كل 
 . ش ص تلأميبًا يمتلك جهاز تلفزيون

ي 
ى
 SPSSتلخيص بيانات القياس الكمي )البيانات الكمية( ف

ي  
ي SPSSهناااس العااديااد من ملأاااييس تل يص بيااانااات اللأياااس ال  ي أو البيااانااات ال ميااة المتاااحااة فى

، بمااا فى
 ذلك: 

ع  ة المر  ي  ة   • ى عاااة المر زياااة  Measures of central tendencyمق  اس ا اليى ى : وأ تح ملأااااييس التى

ي  وسااااااااااا   متشاااااااااااثوعًا هي المتوسااااااااااا  أو ال   والوساااااااااااي  Mean or Arithmetic Averageالحلاااااااااااائ 
Median  (ي تلأع عندها نصف الحالات فوقها والنصف الآخر تحته

 ا(. اللأيمة الت 

ي تلأيس ملأدار التباين :  Measures of Dispersion  مقاس ا التش      تت •
تتضااااااامن الإحصاااااااائيات الت 

Variation    أو الانتشارSpread    ي البيانات، وتشمل الانحراف المعياري
  Standard Deviationفى

 .Maximum، واللأيمة الأعل Minimumواللأيمة الأدئى 
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 خطوات تلخيص البيانات

 . مرة أخرى Frequenciesت افتح ممنااع حوار الت رارا. 1

ى " انلأر فوق. 2  . لملح أي إعدادات سابلأة Reset" إعادة تعيي 

)ا [income]ف حدد دخل الأشة بالآلا. 3  .Variable(s)ت( وانلأله إلى قائمة المتغت 

 .Statisticsت" إحصائيا" انلأر فوق. 4

حاااااااا5 "الاماتاوساااااااااااااااا.  الا ايااااااااارات:  الاماعايااااااااار "ا  ،Median "  الاوساااااااااااااااايا"،  Mean "  دد   .Stdي  لاناحاراف 
deviation" ، ى" الصغرMinimum  ى" ، و"الكتMaximum. 

 .Continueة" انلأر فوق زر "متابع. 6

. )عااادة مااا   Frequency Tablesقم بااللغاااء تحااديااد عرل جااداول الت رار  .  7 ي ممنااع الحوار الرئيشاااااااااااااااي
فى

ات اللأياااااس ال  ي حياااا  قااااد ي ون هناااااس عاااادد  بت  من اللأيم   ت ون جااااداول الت رار غت  مفياااادة لمتغت 
ي ملف البيانات( 

 . الفميدة تلأميبًا كما هو الحال فى

 . لتشغيل الإجراء  OK" وافق ر "مز فوق انلأر . 8

ي نافذة العارل  Statisticsت يتم عرل جدول إحصائيا
ي الشكل التالىي   Viewerالت رارات فى

 : كما فى

 
ي  -جدول إحصائيات الت رارات 

 SPSS تل يص بيانات اللأياس ال  ي أو البيانات ال مية فى

 نتائج التلخيص

لا  ي هذا الم ال، ي 
ى المتوساااااحفى أ ت  فالمتوسااااا     ،Median  الوسااااايو   Mean    أنه يوجد فرق  بت  ب  

. يم نك  من الوسااااااااي   25000بنحو   ي هذا الم ال لا يتم توزيعها بشااااااااكل طبيعي
شاااااااات  إلى أن اللأيم فى

، مما   
ي لهذه الت رار 

ي اللألم التالىي االتحلأق بلايًا من التوزيااااع باست دام الرسم البيائى
 . ت فى
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ي 
ى
ي للبيانات الكمية ف

 SPSSإنشاء التخطيط البيانى

ي 
ي للبيااااناااات ال مياااة أو بيااااناااات اللأيااااس ال  ي فى

ساااااااااااااااوف نلأوم    ،SPSS  من أجااال إ شاااااااااااااااااااء الت طي  البياااائى
ي اللألم اللابق، وذلك كما يلي 

 : باستكمال الم ال الوارد فى

 . مرة أخرى Frequencies فتح ممنااع حوار الت رارات. ا1

 .Chartsة" الرسوم البياني"ق انلأر فو . 2

 .With normal curveي" مع منحبى عاد"د وحد Histogramsي" المدرج التكرار "د حد. 3

ي ممنااع الحوار الرئيشي لتشغيل الإجراء  OKق" مواف"ق ام فو  ،Continueة" متابع"ر انلأر فوق ز 
 . فى

ي العار 
ي كم رجات فى

ي الرسم البيائى
ي الشكل التالىي   Viewerل يظهر المدرج الت راري فى

 : كما فى

 
ي 
ي للبيانات ال مية أو بيانات اللأياس ال  ي فى

 SPSS الت طي  البيائى

 تفسي  النتائج ودلالة التخطيط 

ي الطرف الأدئى من التاادريااااج، مع ان فااال  
ي أعلاه أنااه تم تجمثع غااالبيااة الحااالات فى

ظهر الم ط  البيااائى ي 
ي نطااااق  ( 100000) معظمهاااا إلى أقااال من  

وماااا    ( 500000) . ومع ذلاااك، هنااااس عااادد قليااال من الحاااالات فى
ي أو ت بت   

ا لا يظهر عل الرسااام هنا ونحي  لا يم ن ر يته بدون تعديل الرسااام البيائى
ً
بعده )عدد قليل جد

ي    Mean  الرسام(. هذه اللأيم المرتفعة لعدد قليل فلأ  من الحالات لها ت ات   بت  عل المتوسا  الحلاائ 
ها  اااااويل أو شااااابه معدوم عل الوساااااي ا أفضااااال للأياس Median  ولكن ت ات  ً ، مما يجعل الوساااااي  مؤشر

ي هذا الم ال
عة المر زية فى ى  . التى
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 الفصل الخامس

 جداول الاقتران المزدوج

 

ان مزدوج   بسيط  إنشاء جدول اقير

تلأااااااطع الاحتماااااالا  ان مزدوج أو جااااادول  هو طميلأاااااة لعرل   Crosstabulation Tablesت  جااااادول اقت 
ين أو أ تح من النوع الفئوي ى متغت  (. يتم تحديد حجم الجدول   Categorical  العلاقة ب   ي )اس ي أو ترتثت 

ي الجادول تر ثباة فميادة من اللأيم. تتوفر  
، حيا  تم ال كال خلياة فى من خلال عادد اللأيم الفميادة ل ال متغت 

ي هاذا 
ي الجادول. فى

ات فى ى المتغت  العادياد من الاختباارات الإحصااااااااااااااااائياة لتحادياد ماا إذا كاانات هنااس علاقاة ب  
راجع مو وع "ملفات الأم لة" لمزيد من المعلومات، من .  demo.savف المو وع، يتم است دام المل

ي 
ان مزدوج بلي  فى  .SPSS أجل إ شاء جدول اقت 

ان مزدوجخطوات   إنشاء جدول اقير

يااها  ي  شاات 
ي تؤار عل المنتجات الت 

 ت  تلااا ل حول ما هي العوامل الت 
لو افت  اانا أن أحد أبحاث اللااوق ي 

ي هاذا 
ى عل النااس إنفااقهاا. فى ي يتع  

ا هو عل الأرجح ملأادار الأموال الت  النااس  إن العاامال الأ تح و اااااااااااااااوحاً
 ملاااااااتوى الدخل وملكية الملااااااااعد الرق ي الشااااااا 

ى عن طميق   (PDA) صىاااااااي الم ال، سااااااانفحص العلاقة ب  
ان مزدو  ي  Crosstabulation Tablesج إ شاء جدول اقت 

 .SPSS فى

 م: اخت  من اللأوائ. 1

ي ل < تحلي
ان < الإحصاء الوصفى  جداول الاقير

Analyze > Descriptive Statistics > Crosstabs 

ة خيار قاعدة الإحصائيات ملاحظة ى  .Statistics Base option: تتطلب هذه المت 

ان  ي الشكل التالىي   Crosstabsيظهر ممنااع حوار جداول الاقت 
 : كما فى

 
ا   Crosstabsن ممنااع حوار جداول الاقت 
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 .Row(s)ف كمتغت  الص  Income (inccat)ف" دد فئة "الدخل بالآلا. ح2

 .Column(s)كمتغت  العمود   Owns PDA (ownpda)" حدد "ملكية الملاعد الرق ي الش صىي . 3

ي الشكل التالىي  OKق" انلأر فوق "مواف. 4
 : لتشغيل الإجراء. يظهر الجدول كما فى

 
ى متغت  الدخل بالآلاف وملكي ان ب  

 PDAة  جدول الاقت 

 النتائج ودلالة الجدول

ى الصاااافوف والأعمدة(. عل ساااابيل    ة من اللأيم )ب  
تعرل خلايا الجدول عدد الحالات ل ل تر ثبة مشاااات 

ى    455الم اال،   اوح ب  
ي نطااق الادخال الاذي يت 

ا فى دولار يمتلكون    ( 49000) دولار و  ( 25000) شااااااااااااااا صااااااااااااااااً
ي هذا الجدول، ب ي .  PDA  أجهزة الملااااااااعد الرق ي الشااااااا صىاااااااي 

ز أي من الأرقام الواردة فى ومع ذلك، لا تت 
ات ى تلك المتغت   . طميلأة، ما  شت  إلى وجود أي علاقة وا حة ب  

ان المزدوج بالنسب المئوية  تحليل جدول الاقير

ان المزدو  ي  Crosstabulationج غالبًا ما ي ون من الصاااااااااااااعب تحليل جدول الاقت 
بمجرد النظر  SPSS  فى

ي الم ال اللااابق، ) 
ي كل خلية. فى

ي مو ااوع  إلى الأعداد البلاايطة فى
ان مزدوج بلاايفى إن   (،إ شاااء جدول اقت 

 من  اااااااااعف عدد مال ي أجهزة الملااااااااااعد الرق ي الشااااااااا صىاااااااااي 
ي  PDA حلأيلأة وجود أ تح

ي فئة الدخل الت 
فى

ى   اوح ب  
ي الك ت  )أو قد   ( 25000) دولار ملأارنة بالفئة الأقل من    ( 49000) و  ( 25000) تت 

دولار قد لا تعتى
ي فئاة الادخال هاذه.  

ا فى
ً

ء عل الإطلاق( نظرًا لوجود أ تح من  اااااااااااااااعف عادد الأشااااااااااااااا اا  أيضااااااااااااااا ي
ي شر
لا تعتى

ى  ان المزدوج بالولااااااااااااب المئوية من أجل إظهار العلاقة ب  
ونالتالىي فإننا بحاجة لإجراء تحليل جدول الاقت 

ي 
ات بشكل أو ح فى  .SPSS المتغت 

ان بالنسب المئويةخطوات   تحليل جدول الاقير

ان المزدو .  1 ى تحاااادياااد    Crosstabulationج  افتح ممنااع الحوار جاااداول الاقت  مرة أخرى. )لا يزال يتع  
ين(   . المتغت 

ي  الأدوات للعودة    Dialog Recallر"  يم نك اساااات دام زر "اسااااتدعاء ممنااع الحوا. 2 الموجود عل شر
 . ب عة إلى الإجراءات الملت دمة مؤخرًا 

 
 زر استدعاء ممنااع الحوار



 

ي 
ح برنامج التحليل الإحصائ   مصطفى فؤاد عبيد د. م.                        خطوة خطوة                                       - SPSSشر

 

41 

 

 .Cellsا" ام انلأر فوق "ال لاي. 3

 :  يظهر ممنااع حوار عرل ال لايا كما يلي

 
ان المزدوج  ي جدول الاقت 

 ممنااع حوار عرل ال لايا فى

ي مجموعة الولب المئوي Rowف" نلأر فوق )أو تحلأق من تحديد( خيار "ص. 4
 .Percentagesة فى

ي ممنااع الحوار الرئيشااااااي لتشااااااغيل  OKق"  ، ام انلأر فوق زر "موافContinueة"  انلأر فوق زر "متابع. 5
فى

 . الإجراء 

 
ان المزدوج  ي جدول الاقت 

 الولب المئوية فى
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 نتائج التحليل ودلالته

ين.   ى المتغت  كما يظهر من التحليل الجديد، بدأت الآن الصااااااااااااااورة تتضااااااااااااااح بشااااااااااااااكل أ ت  وتظهر العلاقة ب  
مع ارتفاع فئة   PAD  حي  ترتفع  لاااااااابة الأشاااااااا ا  الذين يمتلكون أجهزة الملاااااااااعد الرق ي الشاااااااا صىااااااااي 

 .Incomeالدخل 

ي  
ى
ان المزدوج ف  SPSSاختبار دلالة جداول الاقير

ان المزدوج   هو إظهاار العلاقاة )أو تا  ياد عادم وجودهاا(   Crosstabulationإن الغرل من جاداول الاقت 
ين.  ى متغت   ب  

ي فئة الدخل  ى متغت  ي الم ال اللااااااااابق، عل الرغم من وجود علاقة ما ب  
وملكية الملاااااااااعد   Incomeففى

ي ملكية الملااااااااااااااعد الرق ي PDAالرق ي الشااااااااااااا صىاااااااااااااي 
، فهل هناس أي سااااااااااااابب للاعتلأاد ب ن الاختلافات فى
ي 
 فئات الدخل الم تلفة هي أ تح من مجرد اختلاف عشوائ 

ى  الش صىي ب  

ي  
ان المزدوج فى يتوفر عااادد من   . SPSSوللرد عل م ااال هاااذه التلاااااااااااااااااا لات يتم اختباااار دلالاااة جاااداول الاقت 

عد اختبار ممنااع كاي )أو كاي تمنثع ى مهمة. ي  ين متداخل   ى متغت    الاختبارات لتحديد ما إذا كانت العلاقة ب  
ي أنه مناساااااب لأي نوع    Square-Chi( 2أو كا

أحد أ تح الاختبارات شاااااثوعًا. تتم ل إحدى مزايا ممنااع كاي فى
 من البيانات تلأميبًا. 

 خطوات إجراء الاختبار

ان" 1  مرة أخرى.  Crosstabs. افتح ممنااع حوار "جداول الاقت 

 : ان كما يلي
 يظهر ممنااع حوار جداول الاقت 

 
ان   Crosstabsممنااع حوار جداول الاقت 
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 .Statistics. انلأر فوق "إحصائيات" 2

:  Statisticsيظهر ممنااع حوار إحصائيات  ان كما يلي
 المنب ق من ممنااع حوار جداول الاقت 

 
ان ،ممنااع حوار إحصائيات  Statistics جداول الاقت 

 .Chi-squareع" اختبار كاي تربي"ر انلأر فوق )أو تحلأق من( الاختيا. 3

ي ممنااع الحوار الرئيشاااااااااااااااي لتشاااااااااااااااغيااال   OKق"  ام انلأر زر "مواف،  Continueة"  انلأر فوق زر "متاااابعااا.  4
فى

 . الإجراء 

ي   Chi-squareع  يتم عرل نتيجاااة اختباااار كااااي تمنث
ان المزدوج الاااذي تم تحااادياااده، كماااا فى لجااادول الاقت 

 : الشكل التالىي 

 
 square-Chi( 2ع أو كاكاي تمنثممنااع كاي )نتيجة اختبار 
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ان المزدوج  دلالة جداول الاقير

سو  ي الصف   Pearson chi-squareن  إن اختبار كاي تمنثع لبت  يلأوم باختبار الفر ية اللأائلة ب ن متغت 
ي ليلاات مفيدة إلى حد  بت    Valueة"  والعمود ملااتلألان. و"اللأيمة الفعلي

ولكن   ،لهذا الاختبار الإحصااائ 
ي نبحا  عنهاا. كلماا ان فضااااااااااااااات   (Asymp. Sig)ة"  الأهمي "ة  قيما

ي تحتوي عل المعلوماات الت 
وهي الت 

ي هااذه الحااالااة، ت ون قيمااة  
(. فى ى ى )غت  مرتبط   ين ملاااااااااااااااتلأل   قيمااة الأهميااة، قاال احتمااال أن ي ون المتغت 

ا بحي  يتم عر ااااااااها  ااااااااااااااااااااااا
ً
ين مرتبطان    (،000.لأيمة ) الأهمية من فضااااااااة جد ي أنه يبدو أن المتغت 

مما يعتى
 . بالفعل

ان المزدوج  إضافة متغي  طبقة لجدول الاقير

ي   Layerة  يم نك إ اااااااااااافة متغت  طبلأ
ان المزدوج فى ي الاتجاها   SPSS لجدول الاقت 

ت  لإ شااااااااااااء جدول الائح
Three-Way Table  ات الصااااا ي  Columnد والعمو  Rowف يتم فيه تلألااااايم فئات متغت 

بشاااااكل إ اااااافى
ا باساااااام متغت  التحك

ً
شااااااار إلى هذا المتغت  أحيان

لأنه قد   Controlم حلااااااب فئات متغت  الطبلأة الجديد.   
ات الصاااااااااااااف والعمود عندم ى متغت  ات هذا المتغت  م"  تتحك"ا  ي شاااااااااااااف عن  يفية تغت  العلاقة ب   ي ت ات 

فى
 . ال ال 

 إضافة متغي  الطبقة خطوات

 
ً
ي للم ال اللابق )من مو وع  استكمالا

ان المزدوج أو ال نائ   (: اختبار دلالة جدول الاقت 

ا. 1  . مرة أخرى Crosstabsن افتح ممنااع حوار جدول الاقت 

 
ي 
ان المزدوج فى  SPSS إ افة متغت  طبلأة لجدول الاقت 

 .Cells" ال لايا"انلأر فوق . 2

 .Row Percent'sقم بللغاء تحديد )أو ملح(  لب الصفوف . 3

https://www.mdrscenter.com/kb/%d8%a7%d8%ae%d8%aa%d8%a8%d8%a7%d8%b1-%d8%af%d9%84%d8%a7%d9%84%d8%a9-%d8%ac%d8%af%d8%a7%d9%88%d9%84-%d8%a7%d9%84%d8%a7%d9%82%d8%aa%d8%b1%d8%a7%d9%86-%d8%a7%d9%84%d9%85%d8%b2%d8%af%d9%88%d8%ac/
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 .Continueة" متابع"ر انلأر فوق ز . 4

 .Layerة كمتغت  الطبلأ  Level of Education (ed)م" مستوى التعلي"د حد

 . لتشغيل الإجراء  OKق" مواف"ر انلأر فوق ز . 6

ان الجديد وإحصاااااااائيات اختبار كاي تمنثع مع إ اااااااافة متغت     square-Chi(  2)كا  تظهر نتائج جدول الاقت 
ي الشكل التالىي   Layerم تحك

 : كما فى

 
 Layerم مع إ افة متغت  التحك Chi-squareع نتائج اختبار ممنااع كاي تمنث

ء الوحيد الذي أنجزناه بل ااااااااااافة متغت  الطبلأة  ي
ان المزدوج، فلأد يبدو أن الشاااااااااار إذا نظرت إلى جدول الاقت 

. ولكن إذا نظرت إلى جدول إحصااااااااااااااائيات ممنااع كاي ي التفلاااااااااااااات 
-Chi  هو جعل الجدول أ ت  وأصااااااااااااااعب فى

squareي جمثع فئات ملتوى التعليم
، باست ناء  Level of Education  ، يم نك بلهولة أن ترى أنه فى

ى الاادخاا ي العلاقااة الظاااهرة ب  
 PDA  وملكيااة الملااااااااااااااااااعااد الرق ي الشااااااااااااااا صىاااااااااااااااي   Incomeل  واحاادة، ت تفى

Ownership   ( 
 
، ت
ً
ة قيماهي    ( 0.05) الأقال من   Significance Valueة"  الأهمي "د تت  قيماة عمو ععاادة

ي  Significantذات دلالة  أو ة"مهم"
 (. بالمعتى الإحصائ 

 الدلالة والتفسي  

ى الدخ شااااات  النتائج أعلاه، إلى أن العلاقة الوا اااااحة ب  
 
  وملكية الملااااااعد الرق ي الشااااا صىاااااي  Incomeل ت

PDA Ownership  ى ملااااااااتوى التعلي ز العلاقة الأساااااااااسااااااااية ب    Level ofم هي مجرد وساااااااايلة أو أداة تت 
Education  وملكية الملاعد الرق ي الش صىي PDA Ownership. 

ى   Incomeل  نظرًا لأن الاادخااو  يمياال إلى الارتفاااع مع ارتفاااع التعليم، فلأااد ت ون العلاقااات الوا اااااااااااااااحااة ب  
ي التعليم

ي الواقع هي نتيجة للاختلافات فى
ات الأخرى فى  . الدخل والمتغت 



 

ي 
ح برنامج التحليل الإحصائ   مصطفى فؤاد عبيد د. م.                        خطوة خطوة                                       - SPSSشر

 

46 

 

 الفصل السادس

 إنشاء وتحرير المخططات البيانية

 

ي 
ى
 SPSSإنشاء المخططات البيانية ف

ي برنااامج التحلياال  Chartsيم نااك إ شاااااااااااااااااء وتحمير مجموعااة متنوعااة من أنواع الم ططااات البيااانيااة أو  
فى

ي 
ح أسااااسااايات إ شااااء الرساااوم البيانية، سااانوشااار  ونعدل الااة  SPSSالإحصاااائ  ي الأم لة الم صاااصاااة ل ااار

. فى

 :  أنواع شائعة الاست دام من الرسوم، وهي

 Bar Chartم ط  أعمدة بلي  أو  .1
 Pie Chartم ط  دائري أو  .2
 Scatterplot with groupsالم ط  المبعتح مع مجموعات أو  .3

، سااانوشااار  م ط  أعمد ي
( لمتوسااا  الدخ  Barة  لتو اااثح أسااااسااايات إ شااااء الم ط  البيائى يطي

ل )أو شر
Income  لااااااااااات دم هذا الم ال ملف البيانا  . ي

.  demo.savت لملاااااااااااتويات م تلفة من الر اااااااااااا الوظيفى

 . راجع مو وع "ملفات الأم لة" لمزيد من المعلومات

ي إنشاء المخططات البيانية
ى
 الخطوة الأولى ف

 م: اخت  من اللأوائ. 1

ئ المخطط   المخططات البيانية < منش 

Graphs > Chart Builder... 

وشر  الم ططات يظهر  هو نافذة تفاعلية تتثح لك معاينة الشكل الذي ، و Chart Builderممنااع حوار م 
 . سيبدو عليه الم ط  أاناء إ شائه

 
وشر  الم ططا   Chart Builderت ممنااع حوار م 
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ي إنشاء المخططات البيانية الخطوة الثانية
ى
 ف

ي 2
ي المو اااااااوعات التالية لهذا المو اااااااوع(، بحي  يم ن اللأيام ب ي . يتم فى

ال طوات التالية )مو اااااااحة فى
 : من العمليات التالية لاستكمال المهمة

 است دام معرل موشر  الم ط  •

ات والإحصاءات •  تحديد المتغت 

 إ افة نص وإ شاء الم ط  •

ئ المخطط    استخدام معرض منش 

ي 
:  SPSSيم ن است دام معرل موشر  الم ط  فى  لإ شاء م ط  أعمدة بلي  كما يلي

 إذا لم ت ن محددة.  Galary. انلأر فوق علامة التبويب "المعرل" 1

ي يتم تنظيمها حلاب    Galaryيتضامن المعرل  
ا، والت 

ً
العديد من الم ططات الم تلفة المحددة ملابلأ

ا عناة أسااااااااساااااااية    Basic Elements"العناصر الأس      اس      ية" نوع الم ط . توفر علامة التبويب  
ً
أيضااااااا

 )م ل المحاور والعناة الرسومية( لإ شاء م ططات من البداية، ولكن من الأسهل است دام المعرل. 

 إذا لم يتم تحديده.  Bar. انلأر فوق "عمود" 2

ي تم ل م ططات الأعمدة  
ي ممنااع الحوار. يجب أن    Bar Chartsتظهر الرموز الت 

ي المعرل فى
المتوفرة فى

مزياد من المعلوماات،  إلى  توفر الصاااااااااااااااور معلوماات كاافياة لتحادياد نوع الم ط  المحادد. إذا  نات بحااجاة 
ا فوق رمز.  ToolTip فيم نك عرل وصف تلمثح الأدوات

ً
 للم ط  عن طميق إيلأاف المؤشر مؤقت

، وهي الملاااااااااااحة Canvasم"  لوحة الرساااااااااا "إلى  Bar Chart اسااااااااااحب رمز م ط  الأعمدة البلااااااااااي . 3
ة الموجودة أعل المعرل  . الكبت 

ي 
 : معاينة للم ط  عل لوحة الرسم كما يلي  SPSS يعرل موشر  الم ط  فى

 
ي 
  شاء م ط  أعمدة بلي  لإ  SPSS است دام معرل موشر  الم ط  فى

 . لاح  أن البيانات الملت دمة لرسم الم ط  ليلت بياناتك الفعلية. هي مجرد أم لة لبيانات وهمية
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ات والإحصائيات للمخططات  تعريف المتغي 

ي 
، إلا أنه غت  م تمل نظرًا لعدم وجود Canvasعل اللوحة    Chartعل الرغم من وجود الم ط  البيائى

ي تتوافق مع كاال 
طااة ولتحااديااد فئااة المتغت  الت  ي طول الأعماادة أو الأشر

ات أو إحصااااااااااااااااائيااات للتحكم فى متغت 
ي 
ات والإحصاااااائيات ال اصاااااة به فى ي . لا يم نك الحصاااااول عل م ط  بدون تعميف المتغت  عمود أو شر

SPSS .ات الموجودة عل  لار اللوحة ات عن طميق سحبها من قائمة المتغت   . يم نك إ افة المتغت 

ات، ت ون الأهداف "مناطق الإسااااااااااالأاط"   .  Canvasعل اللوحة    Drop Zonesعندما تلاااااااااااحب المتغت 

ا بينماا البعج الآخر لا يتطلاب ذلاك. منطلأاة الإسااااااااااااااالأااط للمحور  ً تتطلاب بعج منااطق الإسااااااااااااااالأااط متغت 
طااة( عل  x ""س ي مكااان ظهور الأعماادة )أو الأشر

ي منطلأااة الإسااااااااااااااالأاااط هااذه فى
مطلونااة. يتحكم المتغت  فى

ي منطلأاة  (. x)   المحور س
ا إلى متغت  فى

ً
ا عل نوع الم ط  الاذي تلأوم بال شاااااااااااااااائاه، قاد تحتااج أيضااااااااااااااا

ً
اعتمااد
ي لمتغت   خر )م ال (.  y)   إسااااااااااااااالأااط المحور  

عل سااااااااااااااابيال الم اال، عنادماا تمياد عرل مل ص إحصااااااااااااااااائ 
ي منطلأة إسااااااااااااااالأاط المحور  متوسااااااااااااااا   

ة"  تتطلب "اللأطع المبعتح . y الراتب(، فإنك تحتاج إلى متغت  فى
Scatterplots   ي المحور

ا فى ً ا متغت 
ً
ي هذه الحالة، تحدد منطلأة الإسااااالأاط  (. y  )   أيضااااا

 Drop Zoneفى
 .Dependent Variable المتغت  التابع

ا يعرل أعمد
ً
ي "ل ل فئة من فئات    Incomeل الدخلمتوساااااا    Barsة  سااااااتوشاااااار  م طط

 "الر ااااااا الوظيفى
Job Satisfaction متغت  فئو ساااااااااااااااي ون هناااااااس  ي الإسااااااااااااااالأاااااااط. 

منطلأت  حاااااااجااااااة إلى  لااااااذلااااااك هناااااااس  ي ، 
Categorical   س  عل المحور (x )  قياس ك ي   ومتغت Scale   عل المحور    (y  )لحلااااااااااااب المتوسااااااااااا   

Mean. 

وشاااار  الم ططات ي م 
ي .  Chart Builder  ملااااتوى قياس المتغت  مهم فى

 سااااتلاااات دم متغت  الر ااااا الوظيفى
Job Satisfaction   س  عل المحور   (x  .)  ي تشابه الملاطرة( بجوار المتغت

ومع ذلك، تشات  الأيلأونة )الت 
لإ شااااااااااااااء الم ط  الصاااااااااااااحثح، يجب عليك  .  Scale ك ي   إلى أن ملاااااااااااااتوى قياساااااااااااااه محدد عل أنه قياس

ي طميلأة عرل  .  Categoricalي  اساات دام ملااتوى قياس فئو 
بدلا من الرجوع وتغثت  ملااتوى اللأياس فى

ي موشر  الم ط ،Variable View المتغت  
ا فى
ً
 .Chart Builder  يم نك تغثت  ملتوى اللأياس مؤقت

ي 
ى
ات والإحصائيات للمخططات ف  SPSS خطوات تعريف المتغي 

ي "انلأر بزر المااااااوس الأيمن فوق  .  1
ات واخت    Job Satisfaction"  الر اااااااااااااااااااا الوظيفى ي قاااااائماااااة المتغت 

فى
ي  " يم ن  .  Ordinal"  "ترتثت  ي

ي "الر اااااااااااا الوظيفى
ي هو ملاااااااااااتوى قياس مناساااااااااااب لأن الفئات فى تثت 

النوع الت 
 . ترتيبها حلب ملتوى الر ا )تنازليًا أو تصاعديًا(. لاح  أن الرمز يتغت  بعد تغثت  ملتوى اللأياس

ي . 2
ات إلى منطلأة إساااالأاط Job Satisfaction" الآن اسااااحب "الر ااااا الوظيفى  Drop من قائمة المتغت 

Zone  س المحور  (x .) 

ى منطلأة إسااااااالأاط المحور  ي  (  y)   يتم تعث  
ا ااااااايًا عل الملأياس الإحصاااااااائ  إذا  نت  .  Countد" العد"افت 

ي  خر )م ل الولااااااااااااااابة المئوية
 ،( Meanأو المتوسااااااااااااااا    Percentage  تميد اسااااااااااااااات دام ملأياس إحصاااااااااااااااائ 

اجع   ي هذا الم ال، لكننا سااااااتى
ها بلااااااهولة. لن تلاااااات دم أيًا من هذه الملأاييس الإحصااااااائية فى فيم نك تغثت 
ي وقت  خر 

ي فى
ي حال احتجت إلى تغثت  هذا الملأياس الإحصائ 

 . العملية فى

ي لموشااااار    Element Properties" انلأر فوق علامة التبويب "خصااااائص العنلااااا. 3 ي  الجانت 
ي ال اااار
فى

ي الزاوياااة . ) Chart Builder  الم ط 
، فاااانلأر فوق الزر الموجود فى ي ي  الجاااانت 

إذا لم يتم عرل ال ااااااااااااااار
ي  ي  الجانت 

 (. اليمتى العليا من موشر  الم ط  لعرل ال ر
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ي  - ممنااع حوار خصائص العنلا 

ات والإحصائيات للم ططات فى  SPSS تعميف المتغت 

 خصائص العنصر

بتغثت  خصااائص عناة الم ط    Element Properties"  خصااائص العنلااا" لاامح لك ممنااع حوار  
ي م ط  الأعماادة،    ة العنااا  ،الم تلفااة. تتضااااااااااااااامن هااذه العناااة 

طااة فى الرساااااااااااااااوميااة )م اال الأعماادة، الأشر
ي قائمة "تحمير ال صاااائص ل

( والمحاور عل الم ط . حدد أحد العناة فى يطي
 Editااااااااااااااااااا  الم ط  ال ااار

Properties of ا علام
ً
الحمراء الموجودة عل  Xة  لتغثت  ال صااائص المرتبطة بهذا العنلااا. لاح  أيضاا

 اللأائمة. يحذف هذا الزر عنلااااااااا رسااااااااوري من اللوحة. نظرًا لأنه تم تحديد "العمود
ى ي هذا   Bar1"1يم  

فى
، خاصااااااااة عنلااااااااا رساااااااام  ي

الم ال، فإن ال صااااااااائص المعرو ااااااااة سااااااااوف تنطبق عل عناة الم ط  البيائى
ي   .Bar العمود أو ال ر

الملأاييس الإحصااااااااااااائية المحددة المتوفرة. تتوفر   Statisticsت  تعرل اللأائمة المولاااااااااااادلة "الإحصااااااااااااائيا
 ل ل نوع من أنواع الم ططا

ً
اعلم أن بعج الإحصااااااااااااااائيات  .  Chart Typesت نفس الإحصااااااااااااااائيات عادة

 .Variable عل متغت  ( y)  تتطلب أن تحتوي منطلأة إسلأاط المحور  

ا  Incomeف" اساااااااااااااااحااب "دخاال الأشة بااالآلا.  4  إلى منطلأااة إسااااااااااااااالأاااط Variablesت  من قااائمااة المتغت 
Drop Zone   المحور  (y .) 

  Categoricalي  هو فئو (  x)   ومتغت  المحور س Scalar  هو ك ي   y)  )   نظرًا لأن المتغت  عل المحور  
ي هو نوع من ملتوى اللأياس الفئوي(، فإن منطلأة إسلأاط المحور  تثت 

ا ية ت ون عل (  y)     )الت  الافت 
ي من نوع المتوسااااااااااااااا

ي مناااسااااااااااااااااب لللأيم ال ميااة اللأااابلااة لللأياااس    Mean   الإحصااااااااااااااااائ 
)لأن هااذا الإحصااااااااااااااااائ 

ي تميدها، لذلك ليلااااات هناس حاجة لتغثت  خصاااااائص  
ات والإحصاااااائيات الت  والحلااااااب(. هذه هي المتغت 

 . العنلا 
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 إضافة نص إلى المخطط وإنشاؤه

ي 
ي سااافلية إلى الم ط  أو الرسااام البيائى

ي هذا اللألااام ساااوف يتم  Chartيم نك إ اااافة عناوين وحواشر
. فى

ي 
ح طميلأة إ افة نص إلى الم ط  فى  و ذلك طميلأة إ شاء الم ط .  SPSSشر

 خطوات إضافة نص إلى المخطط 

ي 
 ، قم بال طوات التالية: SPSSمن أجل إ افة نص إلى الم ط  فى

ي اللفلية"/. انلأر فوق علامة التبويب "العناوين1
 .Titles/Footnotes الحواشر

 .Title 1" 1العنوان ". ام حدد 2

:   T1يظهر عنوان الم ط  عل اللوحة مع التلمية  ي الشكل التالىي
 كما فى

 
 إ افة نص إلى الم ط   -معرول عل اللوحة   1العنوان 

ي علاماة التبوياب "خصاااااااااااااااائص العنلاااااااااااااااا"  3
ي   Title 1" 1، حادد "العنوانElement Properties. فى

فى
 .Edit Properties ofلا"  "تحمير ال صائص
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 "1علامة التبويب تحمير خصائص لا العنوان المحدد "العنوان  

ي ممنااع النص "المحتوى"  
ي Contentفى

 Income by Job  ، ا تاااب الااادخااال حلااااااااااااااااااب الر ااااااااااااااااااا الوظيفى
Satisfaction .هذا هو النص الذي سيعر ه العنوان . 

 إنشاء المخطط خطوات 

ي هذا اللألاااااااام والأقلااااااااام اللااااااااابلأة، وال اصااااااااة بل شاااااااااء الم ططات، 
بعد تنفيذ جمثع ال طوات أعلاه، فى

ي 
ة لتنفيذ الإجراء وإ شاء الم ط  فى  : كما يلي   SPSS نصل إلى ال طوة الأخت 

 .Bar Chartي لإ شاء م ط  عمود OKق" مواف" انلأر فوق زر . 1

ي موشر  الم ططا Bar Chartي يتم إ شاء الم ط  العمود
ي عارل الم رجات كما يلي ت فى

 : وعر ه فى

 
ي عارل الم رجات 

ي موشر  الم ططات معرول فى
 الم ط  العمودي فى

ى الذين  شاااااااااعرون بر اااااااااا أ ت  عن وظائفهم يميلون إلى  ي العمودي أن الملاااااااااتجثب  
ي شاااااااااف الرسااااااااام البيائى

 . الحصول عل دخل أشي أعل



 

ي 
ح برنامج التحليل الإحصائ   مصطفى فؤاد عبيد د. م.                        خطوة خطوة                                       - SPSSشر

 

52 

 

 الفصل السابع

 التعامل مع المخرجات

 

 Viewerاستخدام العارض 

ي نافذة العارل 
ي فى
ي    Viewerيتم عرل نتائج تشغيل إجراء إحصائ 

، يم ن أن ي ون الناتج عبارة SPSSفى
ي تحددها عند  

ا عل الاختيارات الت 
ً
عن جداول إحصاائية أو م ططات أو رساوم بيانية أو نصاو ، اعتماد

 تشغيل الإجراء. 

ي    Viewerسااوف يتم اسااتعرال طرق اساات دام العارل  
ي هذا اللألاام. ويلاات دم هذا اللألاام  SPSSفى

فى
لمزياد "ملف ات الأمثل ة"  . راجع مو اااااااااااااااوع  demo.savو  viewertut.spvوالأم لاة الواردة فياه الملفاات 

 من المعلومات. 

ي 
ى
 SPSSطريقة استخدام نافذة العارض ف

عل م ط    Outline Pane نافذة العارل ملألاااااااااااااامة إلى جزأين. يحتوي جزء الم ط  التفصاااااااااااااايلي أو 
ي العاااااارل. يحتوي جزء المحتوياااااات  

عل   Contents Paneتفصااااااااااااااايلي لجمثع المعلوماااااات الم زناااااة فى
 . جداول إحصائية وم ططات وم رجات نصية

 
ي  Viewerل العار نافذة م ال است دام 

 مع ر ية كلا الجزأين فيه  SPSS فى

طة التممير للتنلأل عت  محتويات نافذة العارل   ، رأساااااااايًا وأفلأيًا. لتلااااااااهيل التنلأل، Viewerاساااااااات دم أشر
ي جزء المحتويات

ي جزء الم ط  التفصيلي لعر ه فى
 . انلأر فوق عنلا فى

 . انلأر واسحب الحد الأيمن لجزء الم ط  التفصيلي لتغثت  عر ه. 1
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ي العارل، عل الرغم من 
ي حاليًا فى

ي جزء الم ط  التفصااااااااايلي إلى أنه مرئ 
شااااااااات  أيلأونة الكتاب المفتوح فى

 
ت

ي من جزء المحتويات
ي الجزء المرئ 

 . أنه قد لا ي ون حاليًا فى

ي جزء الم ط  التفصيلي . 2
 . لإخفاء جدول أو م ط ، انلأر نلأرًا مزدوجًا فوق رمز الكتاب ال ا  به فى

 . يتغت  رمز الكتاب المفتوح إلى رمز  تاب مغلق، مما يدل عل إخفاء المعلومات المرتبطة به الآن

 . لإعادة عرل الم رجات الم فية، انلأر نلأرًا مزدوجًا فوق رمز الكتاب المغلق . 3

ي العارل
ى أو كل الم رجات فى ي مع  

ا إخفاء كل الم رجات من إجراء إحصائ 
ً
 . يم نك أيض

( عل  لاااااااااااااااار الإجراء الاذي تمياد إخفااء نتاائجاه، أو -انلأر فوق الممنااع الاذي يحتوي عل علاماة الطمح ) .  4
ي جزء الم ط  التفصيلي لإخفاء كل الم رجات

 . انلأر فوق الممنااع الموجود بجوار العنلا الأعل فى

، بحي  يظهر للمشاهد أن هذه النتائج م فية  . ينضم الم ط  التفصيلي

تيب الذي يتم عرل الم رجات ا تغثت  الت 
ً
 . يم نك أيض

ي 5
ي تميد نلألها . فى

، انلأر فوق العناة الت   .  جزء الم ط  التفصيلي

ي الم ط  التفصيلي . 6
 . اسحب العناة المحددة إلى موقع جديد فى

 
ي العارل

 إعادة ترتيب الم رجات فى

ان المزدوج   ي جااداول الاقت 
الآن أول م رجااات يتم  ، Crosstabsأصااااااااااااااابحاات الم رجااات، المتم لااة هنااا فى

ي العارل
 . عر ها فى

ي جزء 
ا نلأاال عناااة الم رجااات من جزء الم ط  التفصااااااااااااااايلي بااالنلأر فوقهااا وساااااااااااااااحبهااا فى

ً
يم نااك أيضااااااااااااااااا
 . المحتويات
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 استخدام محرر الجداول المحورية

ي ت ون عبااااارة عن نتااااائج معظم  Outputsبعرل عثنااااات الم رجااااات أو    Viewerيلأوم العااااارل  
، والت 

ي جاااداول محورياااة أو  Statisticsالإجراءات الإحصاااااااااااااااااائياااة  
 SPSS Pivot. يتم عرل هاااذه الم رجاااات فى

Tables   ي
، حي  يم ن اساااااااات دام محرر الجداول المحورية فى ي الشااااااااكل التالىي

لللأيام بالعديد    SPSSكما فى
 من المهام: 

 
ي جداول محورية 

 عرل الم رجات فى

ي    يم ن
ي برنامج التحليل الإحصاااااااااااااااائ 

، وذلك من أجل اللأيام SPSSاسااااااااااااااات دام محرر الجداول المحورية فى
ناااامج، وعمليااة   ي الت 

ي كااال من: الوصاااااااااااااااول إلى تعميفاااات الم رجاااات فى
ي تتم ااال فى

بمجموعاااة من المهاااام والت 
، وتحمير الجاااداول Layersمحورة الجاااداول أو اساااااااااااااااتحاااداث المحااااور فثهاااا، وإ شااااااااااااااااااء وعرل الطبلأاااات  

ي الجداول )إخفاء صاااااااف أو مجموعة من الصااااااافوف أو 
وتعديلها وتولااااااايلأها، إخفاء الصااااااافوف والأعمدة فى

ي البح  أو الدراسة، تغثت  تولثق عرل البيانات. 
 عمود أو مجموعة من الأعمدة( بحلب الاحتياج فى

تيب:   وفيما يلي قائمة بهذه المو وعات بالت 

 الوصول إلى تعميفات الم رجات •

 محورة الجداول •

 إ شاء وعرل الطبلأات •

 تحمير الجداول •

 إخفاء الصفوف والأعمدة •

 تغثت  تولثق عرل البيانات •

ء من التفصيل.  ي
ح كل منها بشر  وفيما يلي سوف يتم شر
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 الوصول إلى تعريفات المخرجات

ي نافذة الم رجات أو 
. يم ن الوصااااااااول إلى Outputsيتم عرل العديد من المصااااااااطلحات الإحصااااااااائية فى

ي نافذة العارل 
ة فى ي   Viewerتعميفات الم رجات لهذه المصطلحات مباشر

ي برنامج التحليل الإحصائ 
فى

SPSS. 

 الخطوات: 

، الذي Owns PDA * Gender * Internet Crosstabulation. انلأر نلأرًا مزدوجًا عل الجدول 1
ي نافذة الم رجات 

 .Outputsيظهر فى

 What'sواخت  "مااا هااذا "    Expected Count. ام انلأر بزر الماااوس الأيمن فوق "العاادد المتوقع"  2
This  .من اللأائمة المنب لأة 

 : ي الشكل التالىي
ي نافذة منب لأة كما فى

 يتم عرل التعميف فى

 
ي جدول بالوصول إلى تعميفات الم رجات  

 SPSSلظهار التعميف المنب ق لأحد البيانات فى

ي 
ى
 SPSS بنية تعريفات المخرجات ف

ي 
، بحيااا  يتم  SPSS تم حف  وننااااء تعميفاااات الم رجاااات  ااااااااااااااامن هيكلياااة برناااامج التحليااال الإحصااااااااااااااااااائ 

نامج بالمصااااطلحات الملاااات دمة فيه واساااات داماتها، وذلك من أجل  اساااات دامها لتعميف ملاااات دم الت 
 .تلهيل است دامه لها وتوظيفها بالشكل الصحثح

ي 
ي موقع مر ز البحوث والدراساااااااات متعدد الت صاااااااصاااااااات، يم ن ملاحظة اسااااااات دام نفس الأسااااااالوب فى

فى
ي أي مو ااااااااوع أاناء تصاااااااافحه، بحي  يتم ن اللأار  

ي قد تظهر فى
تعميف بعج المصااااااااطلحات العلمية الت 

 
ً
ي   ،من الاطلاع عل الملأصااااود بهذا المصااااطلح أاناء اللأراءة. م لا
ي عل فى الموقع م صااااص  أي راب  تشااااعت 

فيظهر لللأااار    ( الأزرقالراب  )عااادة ي ون باااللون  يم ن التاا شااااااااااااااات  بااالفاا رة عل  لتعميف المصاااااااااااااااطلحااات  
هذه الوظيفة   SPSSج  ، دون الحاجة للضاااااااااااااااغ  عليه. ونالم ل  لااااااااااااااات دم برنامالمصاااااااااااااااطلحتعميف هذا  

ح تلك المصطلحات  . المضمنة للتلهيل عل الملت دم وشر



 

ي 
ح برنامج التحليل الإحصائ   مصطفى فؤاد عبيد د. م.                        خطوة خطوة                                       - SPSSشر

 

56 

 

ي نافذة المخرجات 
ى
 محورة الجداول ف

ة   ى ي تم إ شااا ها، المعلومات بدقة أو و ااوح كما تميد. باساات دام مت 
ا ااية، الت  قد لا تعرل الجداول الافت 

ي برنامج    Pivoting Tablesمحورة الجداول 
يم نك تبديل الصفوف والأعمدة )قلب الجدول(   SPSSفى

Flip the table ي الجدول، وتعديل الجدول بعدة طرق أخرى. عل سااااااااابيل
، و اااااااااب  ترتيب البيانات فى

الم ااااال، يم نااااك تغثت  جاااادول قصااااااااااااااات  وعميج إلى جاااادول طوياااال ورفثع عن طميق تباااادياااال الصااااااااااااااافوف 
 والأعمدة. 

ي 
، لا يؤار تغثت  شااااااااااااااكل الجدول عل النتائج، ولكنها فلأ   SPSSعند محورة الجداول أو محورة الأدراج فى

 .  طميلأة لعرل معلوماتك بطميلأة م تلفة أو مرغونة أ تح

 خطوات محورة الجدول

 Owns PDA * Gender * Internet. إذا لم يتم توشاااااايطه بالفعل، فانلأر نلأرًا مزدوجًا فوق جدول 1
Crosstabulation  .لتوشيطه 

 
ي نافذة العارل 

 جدول بلي  فى

 . إذا لم ت ن نافذة محورة الأدراج مرئية، فاخت  من اللأوائم: 2

 محوري < محورة الأدراج

Pivot > Pivoting Trays... 

ى الأعمدة والصفوف والطبلأات ة محورة الأدراج للجدول طميلأة لنلأل البيانات ب   ى  . توفر مت 

 :  يظهر ممنااع الحوار كما يلي
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 ) ي
ان مزدوج )انائ  ي  - ممنااع حوار محورة الأدراج لجدول اقت 

 SPSS محورة الجداول فى

عد الصاااف Statisticsت  اساااحب عنلاااا الإحصاااائيا. 3 عد العمود   Row من ب  ي المكان Columnإلى ب 
، فى

 .Gender المحدد أسفل الجوس

اتك  . تتم إعادة ت وين الجدول عل الفور ليع س تغثت 

ن  Owns PDA"  قم بلاااااااااااحب وإفلات عنلاااااااااااا "ملكية جهاز رق ي شااااااااااا صىاااااااااااي . 4 ت"  قبل عنلاااااااااااا "الإنت 
Internet  ى عد الصف لع س ترتيب هذين الصف  

ي ب 
 . فى

ي  
ي الجاااادول المعرول فى

ي الاااادرج المحوري ترتيااااب العناااااة فى
نااااافااااذة  يع س ترتيااااب العناااااة الجااااديااااد فى

ي الشكل التالىي   Viewer  العارل
 : كما فى

 
) ي
ان مزدوج )انائ  ي ال لفية  ممنااع حوار محورة الأدراج لجدول اقت 

 بعد تعديل المحاور وتغت  الجدول فى

بعاااااد إجراء عمليااااا ت طميلأاااااة عرل الجااااادول المحوري  ى و يف تغت  ى الشاااااااااااااااكل   ة محورة  لاح  الفرق ب  
 .Pivoting Tablesالجداول 



 

ي 
ح برنامج التحليل الإحصائ   مصطفى فؤاد عبيد د. م.                        خطوة خطوة                                       - SPSSشر

 

58 

 

ي الجدول
ى
 إنشاء الطبقات وعرضها ف

ة ذات فئااات المعلومااات المتااداخلااة. من خلال  Layersيم ن أن ت ون الطبلأااات   مفياادة للجااداول الكبت 
ي 
ي برنامج التحليل الإحصاائ 

ائح وعر اها فى ، يم نك تبلاي  مظهر الجدول، SPSSإ شااء الطبلأات أو ال ار
 مما  لهل قراءته وفهم بياناته. 

ح طميلأة وخطوات إ شاء الطبلأات   وعر ها:  Layersفيما يلي شر

 
ي 
ان ال نائ  ي العارل  Owns PDA * Gender * Internet Crosstabulationجدول الاقت 

ى
 معرول ف

ي 1
ان ال نائ  بالفعل، فانلأر نلأرًا    Owns PDA * Gender * Internet. إذا لم يتم توشااااااي  جدول الاقت 

 مزدوجًا فوق الجدول لتوشيطه. 

 فاخت  من اللأوائم:  Pivoting Trays. إذا لم ت ن نافذة محورة الأدراج 2

 محوري < محورة الأدراج

Pivot > Pivoting Trays 

يتم إ شااااء .  Layerة عد الطبلأإلى ب    Columnعد العمود  من ب    Genderس"  ام اساااحب عنلاااا "الجو. 3
 . الطبلأات

 
عد العمود   Genderسحب عنلا "الجوس"  عد الطبلأة  Columnمن ب   Layerإلى ب 
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 عرض الطبقات المختلفة

ي الجااادول، ام تاااابع بلأياااة    Categoryة  لعرل طبلأاااة م تلفاااة، حااادد فئااا.  4
من اللأاااائماااة المولاااااااااااااااااادلاااة فى

 . ال طوات

ي العارض
ى
 تحرير الجداول ف

ا لإ شااااااااااااااااء مظهر م صاااااااااااااااص للجدو 
ً
يتم إ شااااااااااااااااء الجداول   ،TableLookل ما لم ت ن قد اساااااااااااااااتغرقت وقت

ي العاااارل وتغثت     Pivot Tablesة  المحوريااا
. ومع ذلاااك، يم ناااك تحمير الجاااداول فى باااالتولاااااااااااااااثق اللأيااااشي

ي جتولثق ال
 .SPSS داول أو أي نص داخل الجدول فى

ها اسم ال   وحجم ال   ونم  ال   )غامق أو مائل( واللون ي يم نك تغثت 
 . تتضمن التوليلأات الت 

 .Level of educationم انلأر نلأرًا مزدوجًا فوق جدول ملتوى التعلي. 1

ي  أدوات التولث. 2  م: مرئيًا، فاخت  من اللأوائ Formatting toolbarق إذا لم ي ن شر

يط الأدوات  ...  عرض < سر 

View > Toolbar... 

 .Level of educationم" ملتوى التعلي" انلأر فوق نص العنوان. 3

ي  الأدوات، اخت  . 4  . 12من اللأائمة المولدلة لأحجام ال طوط عل شر

  Aص لتغثت  لون نص العنوان، انلأر فوق أداة ألوان الن. 5
ً
ا )اللون الأحمر م لا

ً
ا جديد

ً
 (. واخت  لون

 
ي 
ي العارل فى

ي الجدول المحوري ،  SPSS تحمير جدول فى
 تمت إعادة تولثق نص العنوان فى

ا تحمير أو تغثت  تولااااثق محتويات الجداول والتلااااميا. 6
ً
ي العار   Labelsت يم نك أيضاااا

ي   Viewerل  فى
 فى

SPSS .عل سبيل الم ال، يم نك تغثت  عنوان هذا الجدول . 

 . انلأر نلأرًا مزدوجًا فوق العنوان. 7

 . ا تب ملتوى التعليم للتلمية الجديدة لتحل محل التلمية اللأديمة. 8

ي جدول، فلن تتم إعادة حلاااب الإجماليات والإحصااائيات الأخرى، بل ملاحظة
: إذا قمت بتغثت  اللأيم فى

 .  ستظل كما هي
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ي 
ى
 SPSS إخفاء الصفوف والأعمدة ف

ي الجدول مفيدة أو قد تؤدي إلى تعلأيد الجدول دون داع  
لن قد لا ت ون بعج البيانات المعرو ة فى . لح 

ي 
 .SPSS الح ، يم نك إخفاء صفوف وأعمدة ب  ملها دون فلأد أي بيانات فى

 
 ل كما يظهر قبل التعدي  Education Levelم  جدول ملتوى التعلي

 خطوات إخفاء عمود

 Education Levelم"  إذا لم يتم توشااااااااايطه بالفعل، فانلأر نلأرًا مزدوجًا فوق جدول "ملاااااااااتوى التعلي. 1
 . لتوشيطه

 . لتحديده Valid Percentة" انلأر فوق تلمية العمود "الولبة الصالح. 2

ي تظهر بالنلأر بزر الماوس الأيمن Editر" من قائمة "تحمي. 3
 : أو من اللأائمة المنب لأة الت 

 البيانات وتسمية الخلايا<  اخير 

Select > Data and Label Cells... 

ي تظهر باالنلأر بزر المااوس الأيمن، .  Hideء"  من قاائماة العرل، اخت  "إخفاا .  4
أو من اللأاائماة المنب لأاة الت 

 .Hide Categoryة" اخت  "إخفاء الفئ

ا من جااادول البيااااناااات. ويظهر جااادول  ا الآن، ولكن لم يتم حاااذفاااه كلياااً تم إخفااااء العمود وأصااااااااااااااابح م فياااً
ي الشكل التالىي 

 : البيانات كما فى

 
 Valid Percentة" كما يظهر بعد إخفاء "الولبة الصالح  Education Levelم جدول ملتوى التعلي
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 إعادة عرض العمود

 : اخت  من اللأوائم. 5

 عرض < إظهار الكل

View > Show All 

 خطوات إخفاء صف

ي . ي6
 .SPSS م ن إخفاء الصفوف وعر ها بنفس طميلأة إخفاء وعرل الأعمدة فى

ي 
ى
 SPSSتغيي  تنسيق عرض البيانات ف

ي الجداول المحورية 
ي  Pivot Tablesيم نك بلهولة تغثت  تولثق عرل البيانات فى

 .SPSSفى

 
 قبل تغثت  التولثق Education Levelجدول "ملتوى التعليم" 

 Education Level. إذا لم يتم توشاااااااااايطه بالفعل، فانلأر نلأرًا مزدوجًا فوق جدول "ملااااااااااتوى التعليم"  1
 لتوشيطه. 

 لتحديده.  Percent. انلأر فوق تلمية عمود "الولبة المئوية" 2

:  Edit. من قائمة "تحمير" 3 ي تظهر بالنلأر بزر الماوس الأيمن، اخت 
 أو من اللأائمة المنب لأة الت 

 ...  خلايا البياناتد <  حد

Select > Data Cells... 

ي تظهر باااالنلأر بزر المااااوس الأيمن، اخت    Formatمن قاااائماااة التولاااااااااااااااثق  .  4
أو من اللأاااائماااة المنب لأاااة الت 

 .Cell Propertiesة" "خصائص ال لي

 .Format Valueة" انلأر فوق علامة التبويب "تولثق اللأيم. 5

ي 0ر"  ا تب "صااااااااف. 6 ي حلأل "الكلااااااااور الع اااااااار
ي هذا   Decimalsة"  فى

ية فى لإخفاء جمثع الكلااااااااور الع اااااااار
 . العمود 
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 ممنااع حوار خصائص ال لية مع تحديد علامة التبويب تولثق اللأيمة

ي قااااائمااااة  Categoryة"  حاااادد النوع الااااذي تميااااده من قااااائمااااة "الفئاااا.  7
، ام حاااادد التولاااااااااااااااثق لهااااذا النوع فى

 .Formatق" "التولث

ات ال اصة بك Applyق" أو زر "تطبث OKق" انلأر فوق زر "مواف. 8  . لتطبثق التغثت 

ي 
 : كما يلي   SPSS يظهر الجدول بعد تغثت  تولثق عرل البيانات فى

 
 بعد تغثت  التولثق  Education Levelم" جدول "ملتوى التعلي

ي عمود الولبة المئوية
ية م فية الآن فى  . الكلور الع ر
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ي  
ى
 TableLooksباستخدام  SPSSتعديل مظهر الجداول ف

ي 
عد تولاثق الجداول جزءًا هامًا من تلأديم نتائج وا احة وموجزة وذات معتى أو مغزى للإحصاائيات الت  ي 

 يتم تنفيذها. 

 إذا كان من الصعب قراءة الجدول ال ا  بك، فلأد لا ت ون المعلومات الواردة فيه سهلة الفهم. 

ح طرق تعديل مظهر الجداول باست دام  ي هذا اللألم سوف يتم شر
ي  TableLooksفى

 :SPSSفى

 
 viewertut.spvمن الملف  Marital Statusجدول "الحالة الاجتماعية" 

ي المو ااااااوعات التالية سااااااوف يتم اسااااااتعرال طرق اللأيام بالمهام التالية  اااااامن خيارات مظهر الجدول 
فى

TableLooks  ي
ي برنامج التحليل الإحصائ 

 :SPSSفى

ا للجاداول، وت صااااااااااااااايص أنمااط مظهر هاذه الجاداول عن طمي
ً
ق اسااااااااااااااات ادام تولااااااااااااااايلأاات محاددة ملااااااااااااااابلأا

TableLooks  . ي
اضى ي للجدول واختيار تولاااااثق محدد لي ون هو التولاااااثق الافت 

اضى تغثت  التولاااااثق الافت 
ي برنام

ي كلما تم إ شااااء جدول جديد(. ت صااايص إعدادات    SPSSج  فى
)بحي  يتم اسااات دامه بشاااكل تللأائ 

ا، مو اااااااااااااوع خا  بعرل    . العرل الأولية، بحي  يتم تطبيلأها بحلاااااااااااااب الاحتياج ل ل ملااااااااااااات دم ً وأخت 
ات أ  .Value Labelو وتلميات اللأيمة أ Variable Labelو تلميات المتغت 

 : وفيما يلي ترتيب هذه المو وعات

ا •
ً
 است دام توليلأات محددة ملبلأ

 TableLooksل ت صيص أنماط مظهر الجدو  •

ي للجدول •
اضى  تغثت  التولثق الافت 

 ت صيص إعدادات العرل الأولية •

ات واللأيمة •  عرل تلميات المتغت 
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ا
ً
 استخدام تنسيقات محددة مسبق

ي  
ي برنامج التحليل الإحصائ 

ا فى
ً
ي    SPSSيم ن است دام توليلأات محددة ملبلأ

  TableLooksوالمعرّفة فى
 ومن ام تطبيلأها عل جدول محدد: 

ي نافذة العارل.  Marital status. انلأر نلأرًا مزدوجًا فوق جدول "الحالة الاجتماعية" 1
 لعر ه فى

 
ا وتطبيلأها عل جدول الحالة الاجتماعي

ً
 Marital statusة است دام توليلأات محددة ملبلأ

 م: ام اخت  من اللأوائ. 2

 ...  < مظهر الجدول تنسيق

Format > TableLooks... 

   TableLooksر مظهر الجااااداول    اااااااااااااااد ممنااع الحوا
ً
ا  مجموعاااة متنوعااااة من الأنماااااط المعرّفااااة ملااااااااااااااابلأاااا

TableLook Files   ي
ي نااافااذة  .  SPSS  فى

ا من اللأااائمااة لمعااايوتااه فى
ً
عل جهااة    Sample  المعاااينااةحاادد نمطاا
، ام اتبع ال طوات التالية لاست دامه ى  : اليم  

 
ى  TableLooksر ممنااع حوا  ا عل اليلار ومعاينة نموذجية للنم  المحدد عل اليم  

ً
 مع قائمة بالأنماط المحددة ملبلأ
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ي  أو يم نك است دام نم  كما هو، 
 .SPSS تعديل نم  موجود لثناسب احتياجاتك بشكل أفضل فى

ا ام انلأر فوق زر "مواف. 3
ً
 .OKق" لاست دام نم  موجود، حدد نمط

ي  
ى
 SPSSتخصيص أنماط مظهر الجدول ف

ي 
واختيار تولاااااااثق يناساااااااب احتياجاتك ال اصاااااااة. يم ن   SPSS يم نك ت صااااااايص أنماط مظهر الجدول فى

 . ت صيص جمثع جوانب الجدول تلأميبًا، من لون ال لفية إلى أنماط الحدود 

 خطوات تخصيص أنماط مظهر الجدول

 .Marital statusة" انلأر نلأرًا مزدوجًا فوق جدول "الحالة الاجتماعي. 1

 
 جدول الحالة الاجتماعية قبل ت صيص أنماط مظهر الجدول 

 : ام اخت  من اللأوائم. 2

 تنسيق < مظهر الجدول

Format > TableLooks... 

:  TableLooksل" يظهر ممنااع حوار "مظهر الجدو   كما يلي

 
 TableLooksل ممنااع حوار مظهر الجدو 
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 .Edit Lookر" حدد النم  الأقرب إلى التولثق الذي تميده وانلأر فوق زر "تحمير المظه. 3

 . لعرل خيارات التولثق  Cell Formatsة" ام انلأر فوق علامة التبويب "توليلأات ال لي. 4

 
 ممنااع حوار خصائص الجدول مع تحديد علامة التبويب توليلأات ال لية 

 خيارات تخصيص أنماط مظهر الجدول

ي برنام
اساااااااااام ال   وحجم ال   والنم  واللون. كما   Text ، تتضاااااااااامن خيارات تولااااااااااثق ال  SPSSج  فى

  Background Colorال لفية  لون وألوان النص و  Alignmentة تتضاااامن ال يارات الإ ااااافية المحاذا
 .Inner Marginsة وأحجام الهوامش الداخلي

ات التولاااثق عل الجدول ال ا    Sampleة" توفر نافذة "المعاين عل اليلاااار معاينة لكيفية ت ات  تغثت 
من الجدول عل أنماط تولاثق م تلفة. عل سابيل الم ال، رنما    Areaة  بك. يم ن أن تحتوي كل منطلأ

جادول لتحميرهاا، يم ناك إماا اختياار  Areaة  لا تمياد أن ي ون للعنوان نفس نم  البيااناات. لتحادياد منطلأا
ي اللأائمة المولادلة "المنطلأ

ها   ،Areaة" المنطلأة بالاسام فى ي تميد تغثت 
أو يم نك النلأر فوق المنطلأة الت 

ي نافذة "المعاين
 .Sampleة" فى

 .Areaة" من اللأائمة المولدلة "المنطلأ Dataت" حدد منطلأة "البيانا. 5

ا لل لفياااة من اللأاااائماااة المولااااااااااااااااادلاااة "اللو . حااا6
ً
ا جااادياااد

ً
ي لوحاااة تحااادياااد لون ال لفيااا  Colorن"  دد لونااا

ة  فى
Background Color ( .ي هذا الم ال

 (. اللون الأزرق فى

ي )  Textص" ام حدد لون جديد للنص من لوحة "الن. 7
ي هذا الم ال التطبيف 

 (. اللون أبيج فى

ي الشكل التالىي 
ظهر نافذة المعاينة النم  الجديد الذي قمت بتحديده كما فى

 
 : ت
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ي نافذة المعاينة   -تغثت  توليلأات خلايا الجدول 

ى
 ظهور نتائج ت صيص أنماط مظهر الجدول ف

 .TableLooksل" للعودة إلى ممنااع حوار "مظهر الجدو  OKق" ام انلأر فوق "مواف. 8

 حفظ الأنماط لإعادة الاستخدام

يم نك حف  النم  الجديد ال ا  بك، والذي  لااامح لك بتطبيلأه عل الجداول الملاااتلأبلية بلاااهولة 
ي 
 .SPSS فى

 .Save Asم" انلأر فوق "حف  باس. 9

ي ممنااع النص "اسم المل. 10
 .File Nameف" انتلأل إلى الدليل الهدف وأدخل اسمًا لنمطك الجديد فى

 .Save " ام انلأر فوق "حف. 11

ات والعودة إلى نافذة العار . 12  .Viewerل انلأر فوق "موافق" لتطبثق التغثت 

 : يظهر الجدول الآن وهو يحتوي عل التولثق الم صص الذي حددته كما يلي 

 
ي 
 SPSS جدول الحالة الاجتماعية بعد ت صيص أنماط مظهر الجدول فى
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ي 
ى
ي للجدول ف

اضى  SPSS تغيي  التنسيق الافير

ي 
فلأد ي ون من الأفضااااااااااااال تغثت     ،SPSS عل الرغم من أنه يم نك تغثت  تولاااااااااااااثق الجدول بعد إ شاااااااااااااائه فى

ي للجدول ومظهره
اضى ي كل   TableLook التولااااثق الافت 

بحي  لا تضااااطر إلى تغثت  التولااااثق أو المظهر فى
 . مرة تلأوم فثها بل شاء جدول جديد 

 
ي نافذة العارل Marital statusة جدول الحالة الاجتماعي

 فى

ي 
اضى  التالية:  تل طوااة، اتبع لجداولك المحوري Default TableLookلتغثت  نم  المظهر الافت 

 م: اخت  من اللأوائ. 1

 تحرير < خيارات ... 

Edit > Options... 

ي ممنااع الحوار "خيارا Pivot Tablesانلأر فوق علامة التبويب "الجداول المحورية" . 2
 .Optionsت" فى

 : كما يلي   Optionsت يظهر ممنااع حوار ال يارا

 
 Pivot Tablesة  مع تحديد علامة التبويب الجداول المحوري  Optionsت ممنااع حوار ال يارا 
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 . الذي تميد است دامه ل افة الجداول الجديدة TableLook حدد نم  مظهر الجدول. 3

ظهر ناافاذة "نموذج المعااينا
 
ى معاايناة للنم  الاذي يتم تحادياده من قاائماة الأنماا Sampleة"  ت ط عل اليم  

TableLook. 

 . لحف  الإعدادات وإغلاق ممنااع الحوار  OKق" انلأر فوق زر "مواف. 4

ي 
ي للجااااادول فى

اضى ي   SPSS  الآن، بعاااااد تغثت  التولاااااااااااااااثق الافت 
اضى   ،Default TableLook  والمظهر الافت 

ي تلأوم بل شائها تللأائيًا مع قواعد التولثق والمظهر الجديدة
 . سوف تتوافق جمثع الجداول الت 

ي 
ى
 SPSSتخصيص إعدادات العرض الأولية ف

ي   Initial Display Settingsتتضاااااااااااااامن عملية ت صاااااااااااااايص إعدادات العرل الأولية 
محاذاة ال ائنات فى

ي برنامج    Viewerنافذة العارل  
ا اااااااااايًا، وعرل نافذة  SPSSفى ، سااااااااااواء تم إظهار ال ائنات أو إخفا ها افت 

ها من الإعدادات.   العارل وغت 

 خطوات تغيي  الإعدادات

 م: اخت  من اللأوائ . 1

 ...  خياراتر < تحري

Edit > Options... 

 .Viewerل" م انلأر فوق علامة التبويب "العار . ا2

 : كما يلي   Viewerل" مع تحديد علامة تبويب التبويب "العار  Optionsت" يظهر ممنااع حوار "خيارا

 
ي ممنااع حوار "خيارا  Viewer" علامة التبويب "العارل

 مع تحديد أيلأونة العنوانت" فى



 

ي 
ح برنامج التحليل الإحصائ   مصطفى فؤاد عبيد د. م.                        خطوة خطوة                                       - SPSSشر

 

70 

 

ي 
ل ااال كاااائن عل حااادة. عل سااااااااااااااابيااال الم اااال، يم ناااك    SPSS  يتم ت صااااااااااااااايص إعااادادات العرل الأولياااة فى
ات عل طميلأااااة عرل الجااااداول   Chartsت صااااااااااااااايص طميلأااااة عرل الم ططااااات   باااادون إجراء أي تغثت 

Tables .ات  . ما عليك سوى تحديد العنلا الذي تميد ت صيصه وإجراء التغثت 

ي حاوية "الحاالة الأولياة للعرل" . 3
لعرل   Title ، انلأر فوق أيلأونة العنوانInitial Output Stateفى

 . إعداداتها 

ي  Justification " من خيارات "الضااااااااااااب  Center "  ام حدد خيار "توسااااااااااااي. 4
لعرل كافة العناوين فى

 . وس  العارل أفلأيًا 

ا تحديد خيار  
ً
ي تميل إلى Hiddenأو   "إخفاء العناة"يم نك أيضاااااا

، م ل اللااااااجل ورسااااااائل التحذير، الت 
 . تشويش م رجاتك. يؤدي النلأر المزدوج فوق رمز إلى تغثت  خاصية عرل هذا ال ائن تللأائيًا 

ي الم رجات. 5
 . انلأر نلأرًا مزدوجًا فوق رمز التحذيرات لإخفاء رسائل التحذير فى

ات وإغلاق ممنااع الحوار  OKق" ام انلأر فوق زر "مواف. 6  . لحف  التغثت 

ي 
ى
ات والقيم ف  SPSSعرض تسميات المتغي 

ات   ي معظم الحاالات، ي ون عرل تلااااااااااااااامياات المتغت 
 Valueوتلااااااااااااااامياات اللأيم    Variable Labelsفى

Labels    فااعليااة من عرل اسااااااااااااااام المتغت 
ي   Valueأو قيمااة البياااناات الفعليااة   Variable Nameأ تح

فى
SPSS .ومع ذلك، قد ت ون هناس حالات تميد فثها عرل كل من الأسماء والتلميات معًا . 

، والاذي يظهر Marital statusساااااااااااااااوف يتم تطبثق ال طوات التاالياة عل جادول "الحاالاة الاجتمااعياة" 
 كما يلي قبل بدء التطبثق: 

 
 Marital statusجدول الحالة الاجتماعية  

 . اخت  من اللأوائم: 1

 تحرير < خيارات ... 

Edit > Options... 

 .Output Labels. انلأر فوق علامة التبويب "تلميات الم رجات" 2
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ي ممنااع الحوا  Output Labelsت" علامة التبويب "تلميات الم رجا 

 Optionsت خيارا ر فى

وتلاااااااااااااااميااات   Outline Labeling  يم نااك تحااديااد إعاادادات م تلفااة لتلاااااااااااااااميااات الم ط  التفصااااااااااااااايلي 
 .Pivot Table Labelingة الجداول المحوري

ا  Labelsت عل سااابيل الم ال، لإظهار التلاااميا ي الم ط  التفصااايلي وأساااماء المتغت 
وقيم   Namesت فى

ي المحتويات Valuesت البيانا
 : فى

ي المجموعة "تلااااااااميات الجداول المحوري. 3
  Namesحدد "الأسااااااااماء"    Pivot Table Labelingة" فى

ي التلميات تظهر 
ات فى ، لإظهار Variables in Labels shown asاااااااا"     من اللأائمة المولدلة "المتغت 
 من التلميات

ً
ات بدلا  . أسماء المتغت 

ي التلاااااااااااااااميااات تظهر    Valuesم"  بعااد ذلااك، حاادد "اللأي.  4
ات فى ا من اللأااائمااة المولااااااااااااااااادلااة "قيم المتغت 

Variable Values in Labels shown as من التلميات 
ً
 . لإظهار قيم البيانات بدلا

ي هذه الجللااااااااااااة، تلك  
ي يتم إ شااااااااااااا ها، بالإ ااااااااااااافة للجدول الحالىي فى

سااااااااااااوف تع س الجداول اللاحلأة الت 
ات : التغثت   . ويظهر كما يلي

 
ات واللأيم  Marital statusة جدول الحالة الاجتماعي  بعد تغثت  عرل تلميات المتغت 
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ي تطبيقات أخرى SPSSاستخدام النتائج من 
ى
 ف

ي 
ي برنامج التحليل الإحصاااااااااااائ 

ي العديد من   SPSSيم ن اسااااااااااات دام النتائج أو الم رجات ال اصاااااااااااة بك فى
فى

ي عرل تلأااادي ي  
ى جااادول أو م ط  فى ي تضااااااااااااااام  

التطبيلأاااات الأخرى. عل سااااااااااااااابيااال الم اااال، قاااد ترغاااب فى
Power Point   ي برنامج معالجة النصو

ي تلأمير م توب فى
 .Microsoft Wordأو فى

 
ي تطبيلأات أخرى SPSSنموذج أحد نتائج إحصائيات 

 واست دامها فى

ي هذا اللألاااااااام، وهي خاصااااااااة بالتطبثق عل برنامج معالجة  
سااااااااوف يتم اسااااااااتعرال مجموعة من الأم لة فى

ي تطبيلأات معالجة ال لمات الأخرى. Microsoft Wordالنصو  
 ، لكنها قد تعمل بشكل مشابه فى

ح طرق اللأيام بالمهام التالية:  ي المو وعات التالية  من هذا اللألم، سوف يتم شر
 فى

ي 
ي م رجات برنامج التحليل الإحصااااااااائ 

ي برنامج معالجة النصااااااااو    SPSSاساااااااات دام النتائج فى
ولصاااااااالأها فى

Word  وذلااك باا  تح من طميلأااة، منهااا لصاااااااااااااااق النتااائج  نص عااادي، أو تصاااااااااااااااادير الم رجااات إلى ملفااات ،
Microsoft Word  وPowerPoint  وExcel  أف ي دي  الم رجااااااات إلى ملف ئ  تصااااااااااااااااااااادير  أو   ،PDF ،

 .HTMLبالإ افة إلى تصدير النتائج إلى ملف 

تيب: فيما يلي قائمة بتلك المهام   بالت 

ي  •
 Word لصق الم رجات فى

 لصق النتائج  نص عادي •

 Excelو PowerPointو Word تصدير الم رجات إلى ملفات •

 PDFف تصدير الم رجات إلى مل •

 HTML تصدير النتائج إلى •

ي   SPSSلصق مخرجات  
ى
 Wordف

ي 
ي    SPSSيوفر برنامج التحليل الإحصاااائ 

، م لا يم نك لصاااق Wordإمكانية لصاااق الم رجات أو النتائج فى
ي برنامج  

ي نافذة العارل فى
ي تظهر فى

أصاالية. يتم الاحتفاظ    Word جداول    Wordالجداول المحورية الت 
بجمثع ساااااااااامات الجدول، م ل أحجام ال طوط أو الألوان. نظرًا لأنه تم لصااااااااااق الجدول بتولااااااااااثق جدول  

Word ي
 تمامًا م ل أي جدول  خر.  Word، يم نك تحميره فى
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ي  SPSSخطوات لصق المخرجات من 
ى
 Wordف

ي العارل 1
 لتحديده.  Viewer. انلأر فوق أي جدول فى

 تحرير < نسخ . ام اخت  من اللأوائم: 2

Edit > Copy 

 .Microsoft Wordافتح تطبثق معالجة النصو  ال ا  بك، م لا تطبثق . 3

4 . :  ام من قوائم معالج النصو  الذي قمت بفتحه، اخت 

 تحرير < لصق خاص

Edit > Paste Special... 

ي ممنااع الحوار لصق خا  Formatted Text (RTF) دد نص مولق . ح5
 . فى

ي الملتند الحالىي م OKق" ام انلأر فوق "مواف. 6
 .Wordن للصق الم رجات أو النتائج ال اصة بك فى

ي الملاااااااااااااااتند ال ا  بك. يم نك تطبثق تولاااااااااااااااثق م صاااااااااااااااص وتحمير البيانات 
يتم عرل الجدول الآن فى

 . وتغثت  حجم الجدول لثناسب احتياجاتك

  نص عادي  SPSSلصق النتائج من 

ي برنااام
ي   SPSSج  يم ن  لااااااااااااااان الجااداول المحوريااة من العااارل فى

ومن ام لصاااااااااااااااق النتااائج  نص عااادي فى
ي هذه الطميلأة، ولكن يم نك تحمير بيانات الجدول 

تطبيلأات أخرى. لا يتم الاحتفاظ ب نماط التولاثق فى
ي التطبثق الهدف

 . بعد لصلأها فى

 : خطوات اللصق

ي العار . 1
 . لتحديده Viewerل انلأر فوق أي جدول فى

 م: ام اخت  من اللأوائ. 2

 نسخر < تحري

Edit > Copy 

3 . 
ً
 .Microsoft Word افتح تطبثق معالجة النصو  ال ا  بك، م لا

 : ام من قوائم معالج النصو ، اخت  . 4

 لصق خاصر < تحري

Edit > Paste Special... 

ي ممنااع الحوار "لصق خا Unformatted Textق" حدد "نص غت  مول. 5
 .Paste Special " فى

ي الملتند الحالىي  OKق" ام انلأر فوق زر "مواف. 6
 . للصق نتائجك فى

ي ملتن SPSSن يتم لصق النتائج م
ي الشكل التالىي   Wordد فى

 :  نص عادي كما يظهر فى
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ي ملتن Marital Statusة لصق جدول الحالة الاجتماعي 

ى
 Wordد بتولثق نص عادي ف

  يتم فصاااااال كل عمود من أعمدة الجدول بعلامات تبويب. يم نك تغثت  عرل الأعمدة عن طميق  ااااااب 
ي تطبثق معالجة ال لمات ال ا  بك Tab Stopsة" علامات الجدول"

 . فى

 تصدسر المخرجات إلى تطبيقات أخرى

  PowerPointأو   Microsoft Wordإلى تطبيلأات أخرى م ل ملف    SPSSيم نك تصااااااااااادير م رجات  
ي العارل  Excelأو 

.  لااااات دم هذا اللألااااام Viewer. يم نك تصااااادير عناة محددة أو جمثع العناة فى

 . راجع مو وع "ملفات الأم لة" لمزيد من المعلومات. demo.savو msouttut.spvت الملفا

ي أنظمة تشااااااااغي  PowerPoint ملاحظة: يتوفر التصاااااااادير إلى
ولا يتوفر مع إصاااااااادار   Windowsل  فلأ  فى

 .Student Editionب  الطال

 خطوات تصدسر المخرجات إلى تطبيقات أخرى

ي جزء الم ط  التفصااااااايلي للعار 
، يم نك تحديد عناة معثنة تميد تصاااااااديرها أو تصااااااادير  Viewerل فى

 . كل العناة أو تصدير كل العناة المرئية

 
ي العار 

 Viewerل  جداول الت رارات يظهر فى
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 : من قوائم العارل اخت  . 1

 ملف < تصدسر

File > Export... 

ي العارل، يم نك اختيار تصاااااادير الم رجات أو ال ائنات المرئية فلأ   
 من تصاااااادير جمثع ال ائنات فى

ً
بدلا

. إذا لم  ي جزء الم ط  التفصااااااااايلي
ي حددتها فى

( أو تلك الت  ي جزء الم ط  التفصااااااااايلي
)فتح رموز الكتب فى

، فلن ي ون متاحًا لديك خيار تصااااااااااااادير ال ا ي جزء الم ط  التفصااااااااااااايلي
ة  ئنات المحدد تحدد أي عناة فى

Export إلى تطبيلأات أخرى . 

 
 Export Outputت ممنااع حوار تصدير الم رجا

ي مجموعة . 2
 .Allل" ، حدد خيار "ال Objects to Exportر" كائنات للتصدي"فى

 .Word/RTF (*.doc)ف ، حدد ملType" من اللأائمة المولدلة "النوع. 3

ي خااناة تحادياد "اسااااااااااااااام المل.  4
، ا تاب اسااااااااااااااام الملف الجادياد حلااااااااااااااااب احتيااجاك، أو File Nameف"  فى

ي كما ه
اضى  .OUTPUT.docو است دم الاسم الافت 

 .Wordف لإ شاء مل OKق" انلأر فوق زر "مواف. 5

ي 
 ، يم نااك مشاااااااااااااااااهاادة  يف تم تصاااااااااااااااادير النتااائج. تظهر الملاحظاااتWord  عناادمااا تفتح الملف الناااتج فى

Notes ي
ت تصدير جمثع ال ائنا Word ، وهي كائنات غت  مرئية، فى  .Allت لأنك اخت 

 نتائج عملية التصدسر

ي 
، مع  Wordل  إلى تطبيلأات أخرى، تصاااااااااااابح الجداول المحورية جداو  SPSS عند تصاااااااااااادير الم رجات فى

ي ذلاك ال طوط والألوان والحادود وماا إلى 
، بماا فى الاحتفااظ بكال تولااااااااااااااايلأاات الجادول المحوري الأصااااااااااااااالي

ي ملتن
ي الشكل التالىي   Wordد ذلك. وتظهر فى

 : كما فى
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ي تم تصديرها  جداو  Wordف مل 

 Wordل الجديد ويظهر فيه الجداول المحورية الت 

ى الم ططات ي ملاااااتن  Charts  يتم تضااااام  
ي ملاااااتن  Wordد  فى

ي   Wordد   صاااااور رساااااومية. وتظهر فى
كما فى

 : الشكل التالىي 

 
ي ملتن Chartsت تظهر الم ططا 

  صور رسومية   Wordد فى

ي العاااار   Textة  يتم عرل الم رجاااات النصااااااااااااااايااا
.  Viewerل  بنفس ال   الملااااااااااااااات ااادم ل اااائن النص فى

 
ً
ا اااابتاا

ً
ي الم رجااات النصااااااااااااااايااة خطاا

أحااادي )   fixed-pitchا  للمحاااذاة الصاااااااااااااااحيحااة، يجااب أن  لااااااااااااااات اادم فى
 (. الملافة
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ي 
ي   SPSS تصدير الم رجات النصية فى

 Word      اابت )أحادي الملافة( فى

، فلااايتم و اااع كل عنلاااا تم تصاااديره  PowerPointف إلى مل SPSSت  إذا قمت بعملية تصااادير م رجا
يحة منفصاااااااااااالة. تصاااااااااااابح الجداول المحوري ي شر

ي تم تصااااااااااااديرها إلى  Pivot Tablesة فى
  PowerPoint  الت 

ي ذلك ال طوط والألوان والحدود Wordل جداو 
، بما فى ، مع كل تولاااااااااااايلأات الجدول المحوري الأصاااااااااااالي

 . وما إلى ذلك

 
 Power Pointف بعد تصديرها إلى مل   Wordل الجداول المحورية تظهر  جداو 
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ى الم ططات ي مل PowerPoint المحددة للتصدير إلى Charts يتم تضم  
 .PowerPointف فى

 
ي نافذ

 Microsoft PowerPointة  تظهر الرسوم البيانية فى

ولا يتوفر مع إصااادار   Windowsفلأ  عل أنظمة تشاااغيل   PowerPoint: يتوفر التصااادير إلى ملاحظة
 الطالب. 

، فلااااااااايتم تصااااااااادير النتائج بشاااااااااكل م تلف. تتحول  Excelف  إذا قمت بعملية تصااااااااادير الم رجات إلى مل
ي 
 .Excel صفوف وأعمدة وخلايا الجدول المحوري إلى صفوف وأعمدة وخلايا فى

 
ي 
 Excel تتحول صفوف وأعمدة وخلايا الجدول المحوري إلى صفوف وأعمدة وخلايا فى

ي مل
ي الم رجات النصاااية عبارة عن صاااف فى

ي خلية  Excelف كل ساااطر فى
، مع محتويات اللاااطر بال امل فى

 . واحدة
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ي مل
 Excelف الم رجات النصية عبارة عن صف فى

 PDFإلى ملف    SPSSتصدسر المخرجات من 

 Portable Documentتولاثق ملاتند محمول )  PDFإلى ملف    SPSSيم نك تصادير الم رجات من 
Format ي العارل فلأ  إلى ملف

 .PDF(، ويم نك تصدير كل العناة أو العناة المحددة فى

. راجع مو اوع "ملفات الأم لة" لمزيد demo.savو msouttut.spv لات دم هذا المو اوع الملفات 

 . من المعلومات

 
ي العارل Frequenciesت جدول الت رارا

 PDFف قبل التصدير إلى مل  فى
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ي نافذة "العارل". 1
ي تميد تصااااااااااديرها    Viewer من اللأوائم الموجودة فى

ي تحتوي عل الم رجات الت 
الت 

 : ، اخت  PDF إلى

 رتصدسف <  مل

File > Export... 

ي ممنااع حوار "تصاااااااااااااااادير الم رجااات.  2
، Typeع"  ، من اللأااائمااة المولاااااااااااااااادلااة "النو Export Output"  فى

 .Portable Document Formatل" لاختيار تولثق ملف التصدير، اخت  "تولثق ملتند محمو 

 
 PDFف  مع تحديد نوع تولثق ملف التصدير كمل  Export Outputت ممنااع حوار تصدير الم رجا 

 PDFف إلى مل SPSSت ملاحظات على تصدسر مخرجا

ي مل
 . لتلهيل التنلأل PDFف يتم تحويل جزء الم ط  التفصيلي لملتند العارل إلى إشارات مرجعية فى

ي حجم الصااااااااااااااافحاااة والاتجااااه والهوامش والمحتوى وعرل أو إخفااااء ر وس الصااااااااااااااافحاااات 
يتم التحكم فى

ي ملاااتندا
بواساااطة خيارات إعداد الصااافحة )قائمة ملف،   PDFت  وتذييلاتها وحجم الم ط  المطبوع فى
ي نافذة العارل

 (. إعداد الصفحة فى

ي   PDFد لملااااااتن( DPI) ح  دقة الو ااااااو 
ا ااااااية أو المحددة حاليًا )والت  هي إعداد الدقة الحالىي للطابعة الافت 

ها باساااات دام إعداد الصاااافح ي البوصااااة. إذا كان إعداد   ( 1200) الدقة اللأصااااوى هي ة(. يم ن تغثت 
نلأطة فى

 . نلأطة ل ل بوصة ( 1200) هي  PDFد الطابعة أعل، فلت ون دقة ملتن

: قد تؤدي الملاااتندات عالية الدقة إلى نتائج سااايئة عند طباعتها عل طابعات من فضاااة  ةة مهمملاحظ

 الدقة. 
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 الجديد بعد التصدير مع الإشارات المرجعية  PDFف  مل

 HTML إلى  SPSSن تصدسر المخرجات م

ي 
ي برنامج التحليل الإحصاااااااااائ 

ا تصااااااااادير النتائج أو الم رجات إلى  SPSS فى
ً
ى   HTML يم نك أيضااااااااا )لغة ترمت 

(. عند الحف  بتولث ي  HTMLف  ، يتم تصدير جمثع النتائج غت  الرسومية إلى ملHTMLق  النص التشعت 
 . واحد 

ي  HTMLق  إلى ملف بتولااااااااث  SPSSج  الشاااااااكل التالىي يو اااااااح عملية تصااااااادير الم رجات من برنام
مفتوح فى

 : ملتعرل الويب

 
ي ملتعرل الويب   HTMLق تصدير م رجات إلى ملف بتولث

 مفتوح فى
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ا، ولكن ليس إلى ملف واحد HTML إلى SPSSن عند تصدير النتائج م
ً
 . ، يم ن تصدير الم ططات أيض

ي مل
ي  رسم فى

 :HTMLف الشكل التالىي يو ح عملية تصدير الرسم البيائى

 
ي 
ي الذي تم تصديره  رسم فى

 HTML الرسم البيائى

سيتم حف  كل م ط  كملف بالتولثق الذي تحدده، وسيتم و ع المراجع إلى ملفات الرسومات هذه 
ي 
ا خيار لتصاادير جمثع الم ططات )أو الم ططات المحددة( إلى ملفات رسااومات  .  HTML فى

ً
يوجد أيضاا

 . منفصلة

ي إلى تطبيلأاات أخرى، م ال تطبثق معاالجة  
للأراءة المزيد حول تصااااااااااااااادير نتاائج برنامج التحليال الإحصاااااااااااااااائ 

ونيMicrosoft Word  النصااااااااو  ، أو تطبثق Microsoft Excelة  ، أو تطبثق معالجة الجداول الإلكت 
ي اللألااااااااااااااام اللاااااااااااااااابق، مال، يم ن مراجعة  Microsoft Power Pointة  العرول التلأديمي

و اااااااااااااااوعات فى
 . إلى تطبيلأات أخرى SPSSن تصدير النتائج م
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 الفصل الثامن

 كتابة الجمل والأوامر البرمجية

 

ي برنامج 
ى
مجية ف  SPSSبناء الجمل الي 

مجية أو  بلغة الأوامر   Syntaxيم نك حف  وأتمتة العديد من المهام الشااائعة عن طميق بناء الجمل الت 
ي 
ي اللأوائم وممنعات الحوار. يم ن الوصااااول إلى SPSSاللأوية فى

. كما توفر بعج الوظائف غت  الموجودة فى

معظم الأوامر من اللأوائم وممنعاات الحوار. ومع ذلاك، لا تتوفر بعج الأوامر وال ياارات إلا بااسااااااااااااااات ادام  
ي ملف بناء جملة بحي  يم نك ت رار  

ا حف  وظائفك فى
ً

تحليلك  لغة الأوامر. تتثح لك لغة الأوامر أيضااااااااااااا
ي وقت لاحق. 

 فى

مجية هو ببلااااااااااااااااطة ملف نصىاااااااااااااااي  يم نك  .  SPSSة  يحتوي عل أوامر بناء جمل  ملف أوامر بناء الجمل الت 
، ولكن غالبًا ما ي ون من الأسااااااااهل اللااااااااماح لممنعات الحوار 

ً
ة فتح نافذة بناء الجملة و تابة الأوامر مباشر
 . بتنفيذ بعج الأعمال أو كلها نيابة عنك

ي هذا اللألااااااام ملف البيانا
راجع مو اااااااوع "ملفات الأم لة" لمزيد من .  demo.savت  تلااااااات دم الأم لة فى

 حول هذا الملف.  المعلومات

 .SPSSمن  Student لا تتوفر صيغة الأمر مع إصدار الطالب: ةملاحظ

 موضوعات القسم

ي 
مجية فى : لصااااق الجمل الت  ح كل من المو ااااوعات التالية بالتفصاااايل، وهي

ي هذا اللألاااام، سااااوف يتم شر
فى

ي 
ا، SPSS برنامج التحليل الإحصاااااااائ  ً مجية، وفتح وتشاااااااغيل ملف جمل برمجية، وأخت  ، وتحمير الجمل الت 

مجية. وقد تم تلألااايم هذه المو اااوعات إلى أرنعة أقلاااام، ويم ن   ي الجمل الت 
اسااات دام نلأاط التوقف فى

ة من خلال الا   : الرواب  التاليةنتلأال إلثها عت  تصفحها مباشر

مجية •  لصق الجمل الت 

مجية •  تحمير الجمل الت 

 فتح وتشغيل ملف جمل برمجية •

 است دام نلأاط التوقف •

ي 
ى
 SPSSلصق جملة برمجية ف

ي معظم ممنعات  
مجية هي اسااااااااات دام الزر "لصاااااااااق" الموجود فى إن أساااااااااهل طميلأة لإ شااااااااااء بناء الجملة الت 

ي 
 لحفظها وإعادة تشغيلها.  SPSSالحوار من أجل لصق جملة برمجية فى

. راجع مو اااااااااااااااوع "ملفااات الأم لااة" لمزيااد من المعلومااات حول هااذا demo.sav. افتح ملف البيااانااات  1

 الملف. 

 ام اخت  من اللأوائم:   2

 تحليل < إحصائيات وصفية < التكرارات ... 
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Analyze > Descriptive Statistics > Frequencies... 

ا [Marital]ة ام حدد الحالة الاجتماعي. 3  .Variablesت وانلألها إلى قائمة المتغت 

 .Chartsة انلأر فوق الرسوم البياني. 4

ي ممنااع الحوار "م ططا. 5
يطية" Chartsت" فى  .Bar Charts، حدد "الم ططات ال ر

ي 6
 .Percentages ، حدد "الولب المئوية"Chart Values  مجموعة قيم الم ط . فى

الذي  من أجل لصااااااااق بناء الجملة  Pasteق" ، ام انلأر فوق "لصااااااااContinueة"  انلأر فوق زر "متابع. 7
 . تم إ شا ه  نتيجة لاختيارات ممنااع الحوار إلى محرر بناء الجملة

 
ات ي قائمة المتغت 

 ممنااع حوار الت رارات مع تحديد الحالة الاجتماعية فى

مامنااا مان  إ شااااااااااااااااااااااا ه  تام  الااااااااذي  الاجامالااااااااة  باناااااااااء  ماجايااااااااة  الات  الاجامالااااااااة  باناااااااااء  ماحارر  الاتا اراراتع  ياعارل    حاوار 
Frequencies: 

 
ي 
ي تم لصلأها فى

مجية يعرل بناء الجملة الت   SPSS محرر بناء الجمل الت 

مجية، اخت  من اللأوائ. ل8 ي محرر بناء الجمل الت 
 م: تشغيل الصيغة المعرو ة حاليًا فى

 التحديدل < تشغي

Run > Selection 
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ي 
ى
مجية ف  SPSS تحرير الجمل الي 

مجياااا ي نااااافااااذة محرر الجماااال الت 
ي Syntaxة  فى

مجيااااة و تااااابتهااااا فى  .  SPSS  ، يم نااااك تحمير الجماااال الت 
ً
، م ل

   Frequenciesت لعرل الت رارا  BARCHART /  يم ناك تغثت  الأمر الفرعي 
ً
ة من الولااااااااااااااااب المئويا بادلا

Percentages  .   ( إذا  نت تعرف ال لمة الأسااااااااااااااساااااااااااااية لعرل .)طة مائلة أ شاااااااااااااار إلى الأمر الفرعي ب ااااااااااااار
ة. إذا  نااات لا تعرف ال لماااة الأسااااااااااااااااااساااااااااااااااياااة، يم ناااك  Frequenciesت  التكرارا ، يم ناااك إدخاااالهاااا مبااااشر

ي أي مكان بعد اساام الأمر بالحصااول عل قائمة بال لمات الأساااسااية المتاحة لفمر الفرعي  
و ااع المؤشر فى

ي لفمر الفرعي +  Ctrl مفتاح التحكم الفرعي والضغ  عل
 . الملافة. يعرل هذا التحكم الإ مال التللأائ 

ي 
ى
مجية ف  SPSS خطوات تحرير الجمل الي 

 .BARCHART من الأمر الفرعي  PERCENTة احذف ال لمة الأساسي. 1

 .Ctrl-Spacebarة" ملافالا غ  عل زر "التحكم + . 2

ي عنلاااااااااا تحكم الإ مال   FREQ انلأر فوق العنلاااااااااا الملااااااااا . 3
للت رارات. ساااااااااثؤدي النلأر فوق عنلاااااااااا فى

 الحالىي 
ي مو ع المؤشر

ي إلى إدراجه فى
 .Prompt التللأائ 

ي بلأائمة من المصااااطلحات المتاحة أاناء الكتابة.  
، ساااايطالبك عنلااااا تحكم الإ مال التللأائ  ي

اضى بشااااكل افت 
ى م ط  دائر  ي تضم  

يطي   Pie Chartي  عل سبيل الم ال، قد ترغب فى
.  Bar Chart  مع الم ط  ال ر

 . يتم تحديد الم ط  الدائري ب مر فرعي منفصل

طة مائلة لفمام للإشاااااارة إلى بداية الأمر  FREQة  بعد ال لمة الأسااااااساااااي  Enter ا اااااغ  عل. 4 وا تب شر
. يطالبك محرر بناء الجملة بلأائمة الأوامر الفرعية لفمر الحالىي   . الفرعي

 
ي المملوء بالأوامر الفرعية ل

ي المحرر ويعرل عنلا تحكم الإ مال التللأائ 
مجية فى ا  نافذة تحمير الجمل الت 

FREQUENCIES 

5 . 
ً
، ا ااااااااغ  عل المفتا   للحصااااااااول عل تعليمات أ تح تفصاااااااايلا ة إلى .  F1ح لفمر الحالىي ينلألك هذا مباشر

مجية لفمر الحالىي ل SPSS معلومات مرجع  . بناء الجملة الت 

ي 
ى اللوئى مت 

مجية ملون.  لاااااااامح لك الت  ي نافذة بناء أو تحمير الجمل الت 
رنما لاحظت أن النص المعرول فى

ف بها، حي  يتم تلوين المصااااااااااطلحات المعروفة فلأ .   بالتعرف ب ااااااااااعة عل المصااااااااااطلحات غت  المعت 
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ي  تابة الأمر الفرعي 
يتم تلوين الأوامر .  FRMATااااااااااااااااا  و تبته    FORMAT عل ساابيل الم ال، إذا أخط ت فى

ا يًا، لكن الن  . سيظهر غت  ملون لأنه لم يتم التعرف عليه FRMATص الفرعية باللون الأخلاى افت 

ي 
ى
مجية ف  SPSSفتح وتشغيل ملف الجمل الي 

ي 
ي برنامج التحليل الإحصائ 

مجية فى  ، قم بال طوات التالية: SPSSمن أجل فتح وتشغيل ملف الجمل الت 

 محفوظ، اخت  من اللأوائم:  Syntax. لفتح ملف بناء جملة 1

 ملف < فتح < بناء الجملة

File > Open > Syntax... 

مجية. 2  . يتم عرل ممنااع حوار قياشي لفتح ملفات الجمل الت 

 Syntax (* .sps). حادد ملف بنااء الجملاة. إذا لم يتم عرل ملفاات بنااء الجملاة، فتا  اد من تحادياد 3
  نوع الملف الذي تميد عر ه. 

 .Open. انلأر فوق "فتح" 4

ي نافذة بناء الجملة لتشغيل الأوامر 5
 .Run. ام است دم قائمة التشغيل فى

ي  
مجيااة فى ،  SPSSعنااد فتح وتشاااااااااااااااغياال ملف الجماال الت  ى ، إذا كاااناات الأوامر تنطبق عل ملف بيااانااات مع  

ى أمر يفتح ملف البيانات. يم نك   فيجب فتح ملف البيانات قبل تشااااغيل الأوامر، أو يجب عليك تضاااام  
ي تفتح ملفات البيانات. 

 لصق هذا النوع من الأوامر من ممنعات الحوار الت 

 Breakpointsاستخدام نقاط التوقف 

ي    Breakpointsتلااااااااااااااامح لااك نلأاااط التوقف  
ي برنااامج التحلياال الإحصااااااااااااااااائ 

بااليلأاااف تنفيااذ جملااة   SPSSفى
ي نلأاااط محااددة داخاال بناااء الجملااة ومتااابعااة التنفيااذ عناادمااا ت ون جاااهزًا. يتثح لااك هااذا عرل  

برمجيااة فى
ي تعرل  

الم رجاات أو البيااناات عناد نلأطاة تتوسااااااااااااااا  مهماة بنااء الجملاة، أو لتشاااااااااااااااغيال صااااااااااااااايغاة الأمر الت 
 .FREQUENCIESمعلومات حول الحالة الحالية للبيانات، م ل الت رارات 

ي 
ى نلأاط التوقف فى  إلا عل ملتوى الأمر، وليس عل أسطر معثنة داخل الأمر.  SPSSلا يم ن تعث  

 الخطوات: 

ي  Breakpointلإدراج نلأطة توقف 
ي جملة برمجية فى

 :SPSSفى

ي المنطلأة عل  لار النص المرتب  بالأمر. 1
ي أي مكان فى

 . انلأر فى

ي المنطلأة عل  لاااااااار نص الأمر وعل نفس اللاااااااطر م ل اسااااااام    Breakpointيتم تم يل 
 دائرة حمراء فى

 الأمر بغج النظر عن المكان الذي نلأرت فيه. 
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ي 
ى
ي تم إيلأاف التنفيذ عند نلأطة التوقف ف

مجية الت   وتعرل سهم مؤشر التلأدم SPSS نافذة محرر بناء الجملة الت 

ي تحتوي عل
مجية الت  ، يتوقف التنفيذ قبل كل أمر  Breakpoints نلأاط توقف  عند تشاغيل الجملة الت 

 .Breakpointsنلأاط التوقف  يحتوي عل

ي 
ظهر سااااااهم الت شاااااات  المتجه لفساااااافل الموجود عل  لااااااار نص الأمر تلأدم تشااااااغيل بناء الجملة. يمتد فى

ي 
ا بشاااااااااكل خا  عند تشاااااااااغيل بناء جملة  يالمنطلأة من أول أمر تشاااااااااغيل إلى  خر أمر تشاااااااااغ

ً
ل وي ون مفيد

 . لمتابعة ست  العملية Breakpoints تحتوي عل

 :لاستئناف التنفيذ بعد نقطة توقف

ي محرر بناء الجملة، اخت  . 2
 : من اللأوائم فى

 تشغيل < متابعة

Run > Continue 
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 الفصل التاسع

 تعديل قيم البيانات

 

ي 
ى
 SPSSطرق تعديل قيم البيانات ف

ي تبدأ بها بالطميلأة الأ تح فائدة لتحليلك أو لاحتياجات إعداد التلأارير. 
قد لا يتم دائمًا تنظيم البيانات الت 

ي 
ي برناامج التحليال الإحصاااااااااااااااائ 

ي إجراء بعج طرق تعاديال قيم البيااناات فى
عل سااااااااااااااابيال الم اال، قاد ترغاب فى

SPSS  :لتناسب احتياجاتك، م ل 

 .  إ شاء متغت  فئوي من متغت  من نوع اللأياس ال  ي

ي فئة واحدة. 
ى عدة فئات للاستجابة فى  جمع ب  

 . ى ين حالث   ى متغت   إ شاء متغت  جديد يم ل الفرق المحلوب ب  

، حلاب الفرق بينهما وإ افة مدة إلى تارياااان.  ى ى تاري     حلاب المدة الزمنية ب  

. راجع مو اوع "ملفات الأم لة الملات دمة" لمزيد من demo.sav لات دم هذا اللألام ملف البيانات 

 المعلومات حول هذا الملف وطميلأة تحميله. 

تيبهي مو وعات هذا الفصل   : كما يلي   بالت 

 إ شاء متغت  فئوي من متغت  ك ي  .1
ات الجديدة .2  حلاب المتغت 

ات • ي التعبت 
 است دام الدوال فى

طية • ات ال ر  است دام التعبت 

 العمل مع معالج التوارياااان والأوقات .3

ى  • ى تاري     حلاب الفرق ب  

 إ افة مدة إلى تارياااان •

 .  وسوف يتم عر ها بالتفصيل فيما يلي

 إنشاء متغي  فئوي من متغي  كمي 

ات الفئوياة   ي ملف البيااناات   Categoricalإن العادياد من المتغت 
ي الواقع من   demo.savفى

ملاااااااااااااااتمادة فى
ات اللأياس ال  ي  ي ملف البيانات هذا. عل ساااااااابيل الم ال، تظهر ف رة إ شاااااااااء متغت  فئوي   Scaleمتغت 

فى
ي المتغت  

ي   inccatمن متغت  ك ي فى
، فهو ببلاااااااااااااااطة متغت  يعت  عن فئة الدخل ملألاااااااااااااامة إلى أرنااع SPSSفى
ائح.  لت دم هذا المتغت  الفئوي    لتم يل فئات الدخل التالية )بالآلاف(:   4إلى    1لصحيحة من  الأيم  الشر

 دولارًا أممي يًا 25أقل من  .1

 دولارًا أممي يًا  49إلى   25من  .2

 دولارًا أممي يًا  74إلى   50من  .3

 .دولارًا أممي يًا أو أعل  75من  .4
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ي 
ى
 :SPSS خطوات إنشاء متغي  فئوي من متغي  كمي ف

 :inccatي لإ شاء المتغت  الفئو 

ي نافذة محرر البيانات . 1
 : ، اخت  Data Editorمن اللأوائم فى

ي ل < تحوي
  ... تجميع مرنئ

Transform > Visual Binning... 

ي 
ي ممنااع الحوار "تجمثع مرئ 

، يم نك تحديد اللأياس ال  ي   Visual Binning"  فى وأ أو  Scale الرئيشاااااااااااي
تيبي ات الت  ي التجمث  Ordinalة المتغت 

ات جديدة ومرفلأة لها. يعتى ي تميد إ شاااااء متغت 
أخذ    Binningع الت 

ي نفس الفئ
ى أو أ تح وتجميعهما فى ى متجاورت    .Categoryة قيمت  

 ملاحظة

ي 
ي ملف البيانات لملااااااعدتك عل   Visual Binning نظرًا لأن التجمثع المرئ 

يعتمد عل اللأيم الفعلية فى
. نظرًا لأن 

ً
ات اذ خيارات تجمثع جيدة عند إ شااااااااااااااااء متغت  فئوي، فإنه يحتاج إلى قراءة ملف البيانات أولا

هاذا قاد  لاااااااااااااااتغرق بعج الوقات إذا كاان ملف البيااناات ال اا  باك يحتوي عل عادد  بت  من الحاالات، 
ا بتحديد عدد الحالات المراد قراءتها "الملح"فإن ممنااع الحوار الرئي

ً
هذا .  Scan  شي هذا  لمح لك أيض

ا لملف البيااانااات ال ااا  بنااا. عل الرغم من أنااه يحتوي عل أ تح من   وريااً حااالااة، إلا أن    ( 6000) ليس ةى
 
ً
ا طويلا

ً
 . فحص هذا العدد من الحالات لا  لتغرق وقت

 وهو الحلأال Household income in thousandsف" قم بلاااااااااااااااحاب وإفلات "دخال الأشة باالآلا.  2
[income]ا المتغت  قااااااائمااااااة  ي سااااااااااااااالااااااة التجمثع  Variablesت  ، من 

فى ات  المتغت  انلأر فوق  Bin  إلى  ، ام 
 .Continueة" "متابع

 
ي 
 الرئيشي  Visual Binning ممنااع حوار التجمثع المرئ 

"الاتاجاما.  3 الاحاوار  مامناااع  ي 
ي ثافى

الامارئ  بااااااااالآلا   Visual Binning  ع  الأشة  "دخاااااااال  حاااااااادد   ، ف"  الارئايشاااااااااااااااي
Household income in thousands  وهو الحلأااال  [income]ات المملاااااااااااااااوحااا ي قاااائماااة المتغت 

ة  ، فى
Scanned Variables. 

ي هذه الحالة( 
ي توزيااااع المتغت  المحدد )والذي ي ون شديد الانحراف فى

 . يعرل الرسم البيائى
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ي خااانااة اسااااااااااااااام المتغت  التجميعي الجاادياا  inccat2م  أدخاال الاسااااااااااااااا.  4
،  Binned Variable: Nameد  فى
ي   Household income in thousands Binnedف"  ع فئة الدخل بالآلاثوأدخل التلااااااااااامية: "تجم

فى
 .Binned Variable: Labelد خانة تلمية هذا المتغت  الجدي

 .Make Cutpointsع" انلأر فوق "اصنع نلأاط قط. 5

ات عرل متلاوية. 6  .Equal Width Intervals حدد فت 

 number of  لعاااادد نلأاااااط اللأطع  3، وfirst cutpoint locationل  لموقع اللأطع الأو   25أدخاااال  .  7
cutpointsللعرل 25، و width. 

ي هذا الم ال، ساااااي ون للمتغت  المجمع الجديد  
عدد الفئات المجمعة أ ت  من عدد نلأاط اللأطع. لذلك فى

ة تحتوي عل جمثع    25أرنااع فئاات، مع أول الاث فئاات تحتوي كال منهاا عل نطااقاات من  )ألف( والأخت 
 . )ألف(  75اللأيم فوق أعل قيمة قصوى وهي 

 .Applyق" انلأر فوق "تطبث. 8

ي الشاااااااااااااااب ة نلأاط اللأطع المحددة، وهي نلأاط النهاية العليا ل ل  :  النتيجة
تم ل اللأيم المعرو اااااااااااااااة الآن فى

ا إلى مواقع نلأاط اللأطع
ً
ي أيض

ي الرسم البيائى
 . فئة. تشت  ال طوط العمودية فى

ي الفئات الملأابلة. عل سااااابيل الم ال، ساااااتتضااااامن 
ى قيم نلأطة الفصااااال هذه فى ، يتم تضااااام   ي

اضى بشاااااكل افت 
ي تلأااال عن    25اللأيماااة الأولى  

ي    25جمثع اللأيم الت 
ي هاااذا الم اااال، نمياااد الفئاااات الت 

أو تلااااااااااااااااااويااهاااا. ولكن فى
 . أو أعل 75، و74–50، و49-25، و25تتوافق مع أقل من 

ي مجموعة نلأاط النهاية العلي. 9
 . (>) Excludedاستبعاد الأصغر من"  ، حدد "Upper Endpointsا فى

 .Make Labelsت" إنشاء تسميا" ام انلأر فوق . 10

 
ي 
 مع تلميات تم إ شا ها تللأائيًا  Visual Binning ممنااع حوار التجمثع المرئ 
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الم صااااصااااة للمتغت    Valuesة  وشاااار  هذا تللأائيًا تلااااميات وصاااافية للأيمة كل فئة. نظرًا لأن اللأيم الفعليي  
، لذا فإنه يم ن أن ت ون  1المجمع الجديد هي ببلااااااااااطة مجرد أعداد صاااااااااحيحة متلاااااااااللااااااااالة تبدأ بالرقم  

ا لتو ثح معتى هذه البيانات
ً
 . تلميات هذه اللأيم مفيدة جد

ي الشااااااب 
ا إدخال أو تغثت  نلأاط اللأطع والتلااااااميات يدويًا فى

ً
، وتغثت  مواقع اللأطع عن Gridة  يم نك أيضاااااا

، وحذف نلأاط اللأطع عن طميق سااحب خطوط  ي
ي الرساام البيائى

طميق سااحب وإساالأاط خطوط اللأطع فى
ي 
 . اللأطع من الرسم البيائى

ع OKق" انلأر فوق "مواف. 11 جمَّ  . لإ شاء المتغت  الجديد الم 

ي محرر البيااناات. نظرًا لأناه تمات إ اااااااااااااااافاة المتغت  إلى نهااياة الملف، فاإناه يتم  
يتم عرل المتغت  الجادياد فى

ي نافذة عارل البيانا
ي العمود الأيمن الأقصىاااا فى

ي طميلأة    Data Viewerت عر ااااه فى
ي الصااااف الأخت  فى

وفى
 .Variable View عرل المتغت  

 : مثال آخر 

يم ن تطبثق نفس ال طوات اللااااابلأة من أجل إ شاااااء متغت  فئوي من متغت  ك ي عل بيانات الملااااتوى 
 
ً
 : ، ك ن ت خذ اللأيم التاليةالتعلي ي م لا

 تعليم أساشي  .1

 تعليم اانوي .2

 التعليم الجامعي  .3

 التعليم ما بعد الجامعي  .4

 وه ذا. 

ي 
ى
ات جديدة ف  SPSSحساب متغي 

، يم نك حلاااااااااااااااب  Mathematical Functionsة  باساااااااااااااات دام مجموعة متنوعة من الدوال الميا ااااااااااااااي
ي 
ات جديدة فى ي هذا الم ال، ساااااااااااااانحلاااااااااااااب   SPSS متغت 

بناءً عل معادلات شااااااااااااااديدة التعلأيد. ومع ذلك، فى
ى  ين حالث   ى قيم متغت  ا يم ل الفرق ب  

ً
ا جديد ً  . ببلاطة متغت 

 respondent's current"  عل متغت  "العمر الحااااالىي للمجيااااب  demo.savت  يحتوي ملف البيااااانااااا
age  ومتغت  لعدد سااااانوات الوظيفة الحاليةnumber of years at current job  . ومع ذلك، فإنه لا

ي الوقات الاذي بادأ فياه هاذه الوظيفاة. راجع مو اااااااااااااااوع: ملفاات الأم ل
ة  يحتوي عل متغت  لعمر المجياب فى

 لمعرفة المزيد عن هذا الملف ومحتوياته. 

 العمر الحالىي وعدد ساااااااااااانوات  
ى يم ننا إ شاااااااااااااء متغت  جديد بحي  ت ون قيمته هي الفرق المحلااااااااااااوب ب  

ي الذي بدأ فيه المجيب تلك الوظيفة  . الوظيفة الحالية، والذي يجب أن ي ون العمر التلأميت 

ي 
ى
ات جديدة ف  SPSS خطوات حساب متغي 

ي نافذة محرر البيانا. 1
 : ، اخت  Data Editorت من اللأوائم فى

  ... حساب المتغي  ل < التحوي

Transform > Compute Variable... 
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 .jobstartم: ، أدخل الاسTarget Variableف" بالولبة إلى "المتغت  الهد. 2

ي قائمة المتغت  المصاااااااد Age in years [age]ت"  ام حدد "العمر باللااااااانوا. 3
 Source Variableر فى

List  وانلأر عل زر اللهم لول ه إلى ممنااع نص التعبت  الرق ي . 

ي ممنااع الحوار )أو ا اغ  عل مفتاح  (  -) انلأر فوق زر إشاارة . 4
إشاارة اللاالب عل لوحة الآلة الحاسابة فى

 (. عل لوحة المفاتثح(  -) 

ام انلأر    Years with current employer [employ]" حدد "اللنوات مع صاحب العمل الحالىي .  5
 . فوق زر اللهم لول ه إلى التعبت  

 
ي 
ات جديدة فى  SPSS ممنااع حوار حلاب متغت 

ها من   "التوظيف" ن حذرًا لتحديد متغت   ة:  ملاحظ ى ا  لااااااااااااااا ة فئوية معاد ترمت 
ً

الصاااااااااااااااحثح. هناس أيضااااااااااااااا
هاو:  الارقا ي  الاتاعابات   يا اون  أن  ياجااااااااب  تاميااااااااده.  مااااااااا  لاياس  وهااااااااذا   ، –ageولاياس:    age–employ  الاماتاغات 

empcat. 

 . لحلاب المتغت  الجديد  OKق" انلأر فوق زر "مواف. 6

ي محرر البيااناات. نظرًا لأناه تمات إ اااااااااااااااافاة المتغت  إلى نهااياة الملف، فاإناه يتم  
يتم عرل المتغت  الجادياد فى

ي طميلأة عرل البيانا
ي العمود الأيمن الأقصىااااااا فى

ي الصاااااااف   ،Data Viewerت عر اااااااه فى
كما يتم عر اااااااه فى

ي طميلأة عرل المتغت  
 .Variable View الأخت  فى
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ات ي التعبي 
ى
 استخدام الدوال المضمنة ف

ا اسات دام الدوال  
ً
ي  Functionsيم نك أيضا

ات فى ي التعبت 
ي SPSSفى

ا فى
ً
، وهي دوال معرّفة ومدمجة ملابلأ

ي ذلك 70تتوفر أ تح من . SPSSج برنام
 : دالة مدمجة، بما فى

 دوال حلابية •

 الدوال الإحصائية •

 دوال التوزيااااع •

 دوال منطلأية •

 دالتا تجمثع واست راج التارياااان والوقت •

 دوال اللأيمة المفلأودة •

 دوال تلأاطع الحالات •

 دوال الللللة •

ا، م ال مجموعة العملياات الحلاااااااااااااااابياة وأخرى لحلااااااااااااااااب   ة منطلأياً ى ي مجموعات متمت 
يتم تنظيم الدوال فى

ات النظاام الشاااااااااااااااائعاة  ى عادد من متغت  ا تضااااااااااااااام  
ً

الادوال أو الملأااييس الإحصاااااااااااااااائياة. للتلاااااااااااااااهيال، يتم أيضااااااااااااااا
ي مجموعات الدوال المناسبة TIME$ة الاست دام، م ل دال

(، فى ى  . )دالة التارياااان والوقت الحالث  

ات ي التعبي 
ى
 طرق استخدام الدوال ف

ي تعبي   •
ى
 SPSS لصق دالة ف

ي تعبت  
 : للصق دالة فى

ي التعبت  .  1
ي تميد أن تظهر فثها الدالة expression ع المؤشر فى

 . عند النلأطة الت 

توفر المجموعااة .  Function group listحاادد المجموعااة المناااسااااااااااااااابااة من قااائمااة مجموعااة الاادوال  .  2
ات النظام المتاحة أو الملموحة Allل"  الملماة "ال   . قائمة بجمثع الدوال ومتغت 

ات ال اااااصااااااااااااااااااا ي قااااائمااااة الاااادوال والمتغت 
ا فوق الاااادالااااة فى  Functions and Specialة  انلأر نلأرًا مزدوجااااً

Variables list )أو حدد الدالة وانلأر فوق اللهم المجاور للأائمة مجموعة الدوال . 

ي التعبت  
ى جزء من التعبت  ام أدخلت الدالة، فلاااااااااااايتم اساااااااااااات دام الجزء   . يتم إدراج الدالة فى إذا قمت بتمثت 

ى من التعبت  ك ول وسيطة  ي الدالة Argumentالممت 
 . فى

ي تعبي   •
ى
 SPSS تحرير دالة ف

لصاااااااااالأة.  Arguments  لا ت تمل الدالة حت  تدخل الوساااااااااايطات ي الدالة الم 
، مم لة بعلامات اسااااااااااتفهام فى

 .  شت  عدد علامات الاستفهام إلى الحد الأدئى لعدد الوسيطات أو العوامل المطلونة لإ مال الدالة

ي الدالة الملصلأة. 1
ى علامة )علامات( الاستفهام فى  . قم بتمثت 

ا. 2 ، فيم نك  Variable Namesت  أدخل الوساااااااااايطات، إذا كانت الوساااااااااايطات عبارة عن أسااااااااااماء متغت 
ا  .Variables Listت لصلأها من قائمة المتغت 
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ي 
ى
طية ف ات الش   SPSSاستخدام التعبي 

طية   ات ال اااااااااااااار ي   Conditional Expressionsيم نك اساااااااااااااات دام التعبت 
ي برنامج التحليل الإحصااااااااااااااائ 

فى
SPSS    الماناطالأايااااااااة ات  التاعابات  ا 

ً
أيضاااااااااااااااااااااا التاحاوياااااااا(  Logical Expressions)تلااااااااااااااا   عمالايااااااااات  ل  لتاطاباثاق 

Transformations   يي قيمة صاواب أو
رجع التعبت  ال ار

عل مجموعات فرعية محددة من الحالات. ي 
يي صااااااااحيحة، فلاااااااايتم تطبثق التحويل عل هذه 

خط  أو مفلأود ل ل حالة. إذا كانت نتيجة التعبت  ال اااااااار
 . الحالة. إذا كانت النتيجة خاطئة أو مفلأودة، فلن يتم تطبثق التحويل عل الحالة

طي ات سر   ة: لاستخدام تعبي 

ط. 1 ي ممنااع الحوار حلاااااااااب المتغت   IF  انلأر فوق ال اااااااار
 هذا يفتح ممنااع حوار .  Compute Variable فى

IF Cases. 

ى إذا كانت الحالة تحلأق ال ر . 2  .Include if case satisfies conditionط" حدد "تضم  

يي . 3
 . أدخل التعبت  ال ر

طية عل عامل ارتباط ات ال ر ي  relational operator تحتوي معظم التعبت 
 : واحد عل الأقل، كما فى

 21< = العمر 

 :أو م ل

 100>   3× الدخل 

ي الم اال الأول، يتم تحادياد الحاالات ذات اللأيماة 
، يجب  . Age [age]ر  أو أ ت  للعم  21فى ي

ي الم اال ال اائى
فى

ي   Household income in thousands [income]ف  أن ي ون دخل الأشة بالآلا
ونًا فى أقل  3ملاااااااااااااى

 . حت  يتم اختيار الحالة  100من 

ي 
طية باست دام العوامل المنطلأية فى ات ال ر  من التعبت 

ى أو أ تح ا رن  اان  
ً
ي SPSS يم نك أيض

 : ، كما فى

Age >= 21 | ed >= 4 

:   أو  ي
 كما فى

income*3 < 100 & ed=5 

ط العمر أ ت  أو  لاااااوي   ي ب اااار
ي تفى
ي الم ال الأول، يتم تحديد الحالات الت 

ملااااتوى التعليم أ ت   ( أو)   21فى
وط  4أو  لااااااااوي   ، يجب اساااااااتيفاء شر ي

ي الم ال ال ائى
  100أ ت  من هو   3×  دخل الأشة بالآلاف  كل من . فى

 . حت  يتم اختيار الحالة 5ملتوى التعليم =   ذلكو 

ي 
ى
 SPSS معالج التاري    خ والوقت ف

  Date and Timeت  يم ن تنفيااذ عاادد من المهااام الشااااااااااااااااائعااة بلاااااااااااااااهولااة عنااد العماال مع التااارياااان والوقاا
. Date and Time Wizard بااسااااااااااااااات ادام حلأول التوارياااان والأوقاات من خلال معاالج التاارياااان والوقات

 ك: باست دام هذا المعالج، يم ن

 . إ شاء متغت  تارياااان أ وقت من متغت  سلللة يحتوي عل تارياااان أو وقت •

ي تحتوي عل أجزاء م تلفة من التارياااان  •
ات الت  إ شااااااااء متغت  للتارياااان أ الوقت عن طميق دمج المتغت 

 . أو الوقت
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ين للتاارياااان أ  • ي ذلاك إ اااااااااااااااافاة أو طمح متغت 
ات التاارياااان أ الوقات، بماا فى إ اااااااااااااااافاة أو طمح قيم من متغت 

 . الوقت

أو الوقااااات؛ عل سااااااااااااااابيااااال الم اااااال، الثوم من الشاااااااااااااااهر من متغت    • اسااااااااااااااات راج جزء من متغت  التاااااارياااان 
 .mm/dd/yyyyل  التارياااانأالوقت الذي له الشك

ي هذا اللألاااااااام ملف البيانا
راجع مو ااااااااوع "ملفات الأم لة" لمزيد .  Upgrade.savت تلاااااااات دم الأم لة فى
 . من المعلومات

 التارياااان والوقت:  لاست دام معالج

 م: اخت  من اللأوائ. 1

 ...  تحويل < معالج التاري    خ والوقت

Transform > Date and Time Wizard... 

 
ي معالج التارياااان والوقت

 Date and Time Wizard  الشاشة الافتتاحية فى

مجموعة   Date and Time Wizardت تلأدم لك الشاااااااشااااااة الافتتاحية ال اصااااااة بمعالج التارياااان والوق
ي لا تنطبق عل البيانات الحالية. عل ساااااااااااابيل الم ال، لا يحتوي  

من المهام العامة. يتم تعطيل المهام الت 
ات من نوع اللاااااااااااااااللااااااااااااااالا  Upgrade.savت  ملف البيااناا ، لاذلاك يتم تعطيال مهماة  stringة عل أي متغت 

 .create a date variable from a stringة إ شاء متغت  تارياااان من سللل

ي 
، يم ناك تحادياد التعرف عل IBM® SPSS® Statistics إذا  نات حاديا  العهاد باالتوارياااان والأوقاات فى

لأدم لمحة موجزة عن 
 
. يؤدي هذا إلى شاااااااااشااااااااة أخرى ت  يفية تم يل التوارياااان والأوقات والنلأر فوق التالىي

 
ً
ا، من خلال زر الملاعدة، للحصول عل معلومات أ تح تفصيل

ً
ات التارياااانأالوقت ورابط  . متغت 
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ي 
ى
ى ف ى تاريخي   SPSS حساب الفرق بي 

ي 
ى فى ى تاري    ي تتضااامن توارياااان هي حلااااب الفرق ب  

وكم ال، ف ر    SPSS برنامج  من أ تح المهام شاااثوعًا الت 
قية من خلال تحديد عدد اللااااااااانوات منذ  خر  يات تراخيص الت  ي شر ة برمجيات مهتمة بتحليل مشااااااااات 

فى
اء ترقية. يحتوي ملف البيانا عل متغت  للتارياااان الذي قام   Upgrade.savت مرة قام فثها كل عميل ب ااااار

اء. سااااااثوفر متغت  جديد يم ل طول  اء ترقية ولكن ليس عدد اللاااااانوات منذ ذلك ال اااااار فيه كل عميل ب اااااار
ا لهذه ال مية. )راجع   تارياااان  خر ترقية وتارياااان إصاااااااادار المنتج التالىي ملأياسااااااااً

ى ة الزمنية باللاااااااانوات ب  
الفت 

 ة(. الأم ل اتمو وع ملف

ى  ى تاريخي   خطوات حساب الفرق بي 

عل الشااااااااااااااااشاااااااااااااااة    Calculate with dates and timesت" حدد "حلااااااااااااااااب مع التوارياااان والأوقا. 1
 .Next" الافتتاحية لمعالج التارياااان والوقت وانلأر فوق "التالىي 

ى . 2 ى تاري     Calculate the number of time units" حدد "حلااااااااااااااااب عدد وحدات الوقت ب  
between two dates  وانلأر فوق "التالىي "Next ي

ى الأول وال ائى ى التاري     . ، لحلاب الفرق ب  

 
: ال طوة  ى ى تاري    ي معالج التارياااان والوقت 2حلاب الفرق ب  

 فى

ي ال طوة . 3
 .Date1ل لحلأ Date of next release"  ، حدد "تارياااان الإصدار التالىي 2فى

 .Date2ل لحلأ Date of last upgradeة" حدد "تارياااان  خر ترقي. 4

ح"  وحدد "قطع إلى عدد صاااااااااااااحث  Unitة"  من اللأائمة المولااااااااااااادلة "الوحد  Yearsت" دد "اللااااااااااااانوا. ح5
Truncate to Integer  )ا ية  . لإرجاع النتيجة ملأمنة باللنوات. )هذه هي التحديدات الافت 

 .Next" انلأر فوق زر "التالىي . 6

ي ال طوة  .  7
ات . Resultج"  لاسااااااااااااااام المتغت  "النااات  YearsLastUp  ، أدخاال3فى لا يم ن أن ي ون لمتغت 

 . النتيجة نفس اسم متغت  موجود 
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لمتغت  النتيجة.    Labelة   تلاااااااامي  Years since last upgradeة"  أدخل "اللاااااااانوات منذ  خر ترقي. 8
ات النتائج اختيارية ات لمتغت   . تلميات المتغت 

ي لإ شاااااااااااااااااء المتغت  الآن.  9
اضى ء"  ، وانلأر فوق "إنهااا Create the variable now  اترس التحااديااد الافت 

Finish  لإ شاء المتغت  الجديد . 

ى YearsLastUpالمتغت  الجااادياااد،   ي محرر البيااااناااات هو عااادد صاااااااااااااااحثح من اللااااااااااااااانوات ب  
، المعرول فى

ى  ي  ) التاري   
ى فى ى تاري    تم اقتطاع الأجزاء من اللااااااااااانة للحصاااااااااااول عل الفرق  (.  SPSS لحلااااااااااااب الفرق ب  

سااااااانوات    ( 6) أشاااااااهر يعطي نتيجة    ( 9) سااااااانوات و    ( 5) باللااااااانوات ملأرب لأقرب سااااااانة )م لا إذا كان الفرق 
 . فلأ ( 

 إضافة مدة إلى تاري    خ

ي 
شااااهرًا. متابعة    12أيام أو   10، م ل إ ااااافة SPSS يم نك إ ااااافة مدة إلى تارياااان أو طمح مدة من تارياااان فى

ي اعتبارس تحديد التارياااان الذي يوتهي فيه علأد  
مجيات من المو اااااااوع اللاااااااابق،  اااااااع فى مع م ال شر ة الت 

ي الأولىي ل ال عميال. يحتوي ملف البيااناا
عل متغت  لعادد سااااااااااااااانوات الادعم    Upgrade.savت  الادعم الفتى

. يم نااك بعااد ذلااك تحااديااد تااارياااان انتهاااء الاادعم الأولىي عن  اء الأولىي
المتعاااقااد عليااه ومتغت  لتااارياااان ال ااااااااااااااار

اء   . طميق إ افة سنوات من الدعم إلى تارياااان ال ر

 خطوات إضافة مدة إلى تاري    خ

عل الشاااااااااااااااااشااااااااااااااااة  Calculate with dates and timesت  حاادد "حلاااااااااااااااااب مع التوارياااان والأوقااا.  1
 .Next" الافتتاحية لمعالج التارياااان والوقت وانلأر فوق "التالىي 

ي 2
 Add or subtract a duration from aن"  ، حدد "إ اااااااااافة أو طمح مدة من تارياااا1 ال طوة . فى

date  وانلأر فوق "التالىي "Next. 

 
ي 
 من معالج التارياااان والوقت  2ال طوة  -  SPSS إ افة مدة إلى تارياااان فى
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ن"  التاريااااااااااااااااااااااااااااااا "ل  Date of initial product license" ام حدد حلأل "تارياااان ترخيص المنتج الأولىي . 3
Date. 

ي ال طوة . 4
ي 2فى

 .Durationلمتغت  "المدة"  Years of tech support ، حدد "سنوات الدعم الفتى

ي يجب  
، ف نت بحاجة إلى الإشاااااااااارة إلى الوحدات الت  ي هي مجرد متغت  رق ي

نظرًا لأن سااااااااانوات الدعم الفتى
ي إ افة مدة إلى تارياااان

 . است دامها عند إ افة هذا المتغت  كمدة فى

 .Unitsت" من اللأائمة المولدلة "الوحدا Yearsت" ام حدد "اللنوا. 5

6 ."  .Next انلأر فوق "التالىي

ي ال طوة  .  7
ات .  Resultة"  لاسااااااااااااااام متغت  "النتيجا  SupEndDateل ، أدخا3فى لا يم ن أن ي ون لمتغت 

 . النتيجة نفس اسم متغت  موجود 

  Resultة  لمتغت  النتيجا Labelة   تلاااااااااااااااميا  End date for supportم"  أدخال "تاارياااان انتهااء الادع.  8
ات النتائج اختيارية )يم ن إهمالها(   . تلمية المتغت  لمتغت 

 . لإ شاء المتغت  الجديد  Finishانلأر فوق "إنهاء" . 9

ي محرر البيانات 
 .Data Editorيتم عرل المتغت  الجديد فى

ي 
ى
 SPSS خطوات طرح مدة من تاري    خ ف

 . اتبع نفس ال طوات أعلاه، مع استبدال عملية الجمع بعملية الطمح من التارياااان
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 الفصل العاشر

 SPSSتوفير الوقت والجهد في 

 

ي  
ى
 SPSSطرق توفي  الوقت والجهد ف

ي 
ات برناامج التحليال الإحصااااااااااااااااائ  ى لملاااااااااااااااااعادتاك عل توفت  الوقات   SPSSيم ن اسااااااااااااااات ادام العادياد من مت 

 إذا  نت تلأوم باساااااتمرار بلجراء نفس أنواع التحليل عل مجموعات  
ً
والجهد عند تحليل بياناتك، خاصاااااة

 مماالة من البيانات. 

ي بحي  يم ن است دامها بحلب الاحتياج  
ي برنامج التحليل الإحصائ 

تتنوع طرق توفت  الوقت والجهد فى
ة  لااااااااااااااان  ى  يم ن اسااااااااااااااات ادام مت 

ً
ي تلأوم بهاا. م لا

ي أي مرحلاة من مراحال دراسااااااااااااااااة أو تحليال البيااناات الت 
وفى

ي كل مرة تلأوم بتحديد تلك خصائص لكتل البيان
ات المتماالة.  خصائص البيانات من أجل توفت  الوقت فى

ي 
ي سااااااااابق وتم اسااااااااات دامها فى

كما يم ن اسااااااااات دام قاموس البيانات أو إعادة اساااااااااتدعاء ممنعات الحوار الت 
 نفس جللة العمل. 

ح طرق كل من ي هذا اللألم سوف يتم شر
 :فى

 طرق  لن خصائص البيانات •

 عرل معلومات قاموس البيانات •

 Dialog Recallر استدعاء ممنااع حوا •

ي 
ى
 SPSSطرق نسخ خصائص البيانات ف

ي برنامج  
ات SPSSيتم حف  ساامات البيانات الوصاافية المرتبطة بملف البيانات فى ، م ل تلااميات المتغت 

ي ملف البيانات. وعادة، يجب عليك إعادة إ شااااااااااااااااء 
واللأيمة، وتعميفات اللأيمة المفلأودة، وما إلى ذلك، فى

ي كل مرة تبدأ فثها العمل عل ملف بيانات جديد. لتوفت  الوقت والجهد، يم نك  لن 
هذه المعلومات فى

ي ملف 
من أي ملف بيانات    Variable Settingsو لااااااااااان إعدادات المتغت    SPSSخصاااااااااااائص البيانات فى

SPSS   محفوظ. تعمال هاذه العملياة من خلال تطبثق خصااااااااااااااااائص المتغت  والملف من أحاد الملفاات إلى
 مجموعة البيانات الوشطة حاليًا. 

 استخدامات طرق نسخ خصائص البيانات

 يم نك است دام طرق  لن خصائص البيانات من أجل: 

ي ملف بيانات المصاااااااادر  •
ات فى ي مجموعة البيانات الوشااااااااطة بناءً عل المتغت 

ات جديدة فى إ شاااااااااء متغت 
 . ي  ال ارخ 

ات لهااا  Variable Propertiesتطبثق خصاااااااااااااااااائص متغت    • من ملف البيااانااات ال ااارجيااة عل متغت 
ي مجموعة البيانات الوشطة. 

 نفس الأسماء فى

من  ة(  محدد  Value Labelتطبثق خصااااااااااائص محددة لمتغت  )عل ساااااااااابيل الم ال، تلااااااااااميات قيمة  •
ات هااااد ي أو مجموعااااة البيااااانااااات الوشاااااااااااااااطااااة عل متغت  ي ملف البيااااانااااات ال ااااارخ 

ات فى ف أحااااد المتغت 
Targeted Variables ي مجموعة البيانات الوشطة

 . متعددة فى
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ات ولكن بااادون تحااادياااد أي  ي هاااذا الم اااال، ساااااااااااااااوبااادأ بملف بيااااناااات يحتوي باااالفعااال عل بعج المتغت 
فى

ات " لهذه المتغت   . "خصائص المتغت 

 نسخ خصائص البيانات خطوات

 م: اخت  من اللأوائ. 1

 بيانات ...  <ملف < فتح

File > Open > Data... 

 . راجع مو وع "ملفات الأم لة" لمزيد من المعلومات. smalldemo.savف ام افتح مل. 2

ا ية ي هذا الملف لها ال صائص أو اللمات الافت 
ات ال ملة فى  . حاليًا، المتغت 

ي نافذة محرر البيانا. 3
 : ، اخت  Data Editorت من اللأوائم فى

 البيانات < نسخ خصائص البيانات

Data > Copy Data Properties... 

ي 4
ا بالفعل، Copy Data Properties Wizardت  معالج  لان خصاائص البيانا. فى

ً
، إذا لم ي ن محدد

بيااااااناااااا ي   IBM SPSS Statisticsت  فاااااانلأر فوق ملف  انلأر فوق "اساااااااااااااااتعراExternal  خاااااارخ  ل"  ، ام 
Browse. 

 . يتم عرل ممنااع حوار قياشي لفتح الملفات

 . راجع مو وع "ملفات الأم لة" لمزيد من المعلومات. demo.savف افتح مل. 5

ي معالج  لن خصائص البيانا. 6
" Copy Data Properties Wizardت فى  .Next، انلأر فوق "التالىي

 
 تحديد بيانات المصدر - 2ال طوة  -معالج  لن خصائص البيانات 
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ات مجموعة بيانات المصااااااااااااااادر . 7 ا بالفعل، فانلأر فوق "تطبثق ال صاااااااااااااااائص من متغت 
ً
إذا لم ي ن محدد

، وانلأر )أو تحلأق  Apply properties from selected source dataset variablesة  المحاادد
ي مجموعة البيانات الوشااط

ات مطابلأة فى  Create matching variablesة" من تفعيل( "إ شاااء متغت 
in the active dataset. 

ات مجموعة بيانات المصد. 8 ي قائمة "متغت 
، انلأر فوق )أو حدد( Source Dataset Variablesر" فى

، ام ا غ  عل ي الملف Ctrl+a أي متغت 
ات فى  . لتحديد كافة المتغت 

 .Next" ام انلأر فوق "التالىي . 9

ي    Variable Propertiesمن المعالج بتحديد خصاااااااااااااائص المتغت   3تلااااااااااااامح لك ال طوة :  ملاحظة
الت 

ي   . تميد  ل ها من ملف البيانات ال ارخ 

 
 تحديد خصائص المتغت  المصدر - 3ال طوة  -معالج  لن خصائص البيانات 

ات بنفس الاسااااااااااااااام والنوع(،   ي المصااااااااااااااااادر والوجهااة )أي أن ت ون المتغت 
ى فى ي الملف  

ات فى لمطااابلأااة المتغت 
إذا كانت مجموعة  .  Value Labelsة تلاااااااااميات اللأيم  Mergeج أو دم  Replaceل  يم نك إما اساااااااااتبدا

ساااااااايحذف    Replaceل"  البيانات الوشااااااااطة تحتوي عل أي تلااااااااميات قيم محددة، فإن ال يار "اسااااااااتبدا
ي ملف  

ات المطابلأة واساااتبدالها بالتلاااميات من المتغت  المطابق فى جمثع تلاااميات اللأيمة الحالية للمتغت 
ى  ي هااااذا الم ااااال، لا توجااااد تلاااااااااااااااميااااات قيم محااااددة؛ لااااذلااااك، لا فرق ب  

. ومع ذلااااك، فى ي البيااااانااااات ال ااااارخ 
 ". "استبدال" و"دمج
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ي   Finishانلأر فوق زر "إنهاء" . 10 لتشااااغيل المعالج و لاااان خصااااائص المتغت  من ملف المصاااادر ال ارخ 
 . إلى ملف البيانات الحالىي 

هو النااااافااااذة الوشاااااااااااااااطااااة، وإذا لم ت ن طميلأااااة عرل المتغت    Data Editorت  اجعاااال محرر البيااااانااااا.  11
 .Variable View معرو ة بالفعل، فانلأر فوق علامة التبويب طميلأة عرل المتغت  

 : ملاحظات

ي بادأ بهاا. تم  
ات أ تح من ال ملاااااااااااااااة الت  ء قاد تلاحظاه هو أن ملف البيااناات يحتوي الآن عل متغت  ي

أول شر
ي ملف البيانات 

ي لم ت ن موجودة بالفعل فى
ي والت  ي ملف المصدر ال ارخ 

ات المحددة فى إ شاء كافة المتغت 
 . الحالىي 

المطااااااابلأاااااا ات  ي   Matching Variablesة  المتغت 
ي كلا ملفى

نفس الاسااااااااااااااام والنوع فى لهااااااا  ي 
الت  ات  )المتغت 

. عل  ي ي ملف البيانات ال ارخ 
ات المصادر فى البيانات( لديها الآن جمثع خصاائص المتغت  المحددة لمتغت 

  Variable Label"  الآن عل "تلاااااااااااامية المتغت    Maritalة"  ساااااااااااابيل الم ال، يحتوي المتغت  "الاجتماعي
م  و ااذلااك أصااااااااااااااابح يحتوي عل تلاااااااااااااااميااات اللأي   ،Marital statusة"  جاادياادة وهي "الحااالااة الاجتماااعياا

Value Labels  ،و  0 اللأيمة المرتبطة بلأيم البيانات )عل سبيل الم ال ى  1 اللأيمةو ( Singleج ) = غت  مت 
و  ى  (. Marriedج ) = مت 

ى  ي ملف البيااناات الحاالىي "المتى
ين فى لاح  أن المتغت 

بادون   ،Petsة" و"الحثواناات الأليفا Houseل"  كماا ي 
ي  ي ملف بيااانااات المصاااااااااااااااادر ال ااارخ 

ات مطااابلأااة فى ، لأنااه ليس لهمااا متغت  ونااالتااالىي لم يتم  لااااااااااااااان أيااة    ،تغثت 
 . خصائص جديدة لهما 

 عرض معلومات قاموس البيانات

لملف    Variable Definition Informationيحتوي قااموس البيااناات عل معلوماات تعميف المتغت   
ي برناامج  

، كماا يم ن عرل معلوماات قااموس البيااناات للملااااااااااااااات ادم أانااء العمال،  SPSSالبيااناات الحاالىي فى
 وهو يوفر بيانات مفصلة تشمل كل من: 

 أسماء المتغت   •

 تلميات المتغت   •

 ملتوى اللأياس •

 تلميات اللأيمة •

 اللأيم المفلأودة •

 خطوات عرض معلومات قاموس البيانات

ي 
ي برنامج التحليل الإحصائ 

 :SPSSلعرل قاموس البيانات فى

 :Data Editor"محرر البيانات" . اخت  من قوائم 1

 ملف < عرض معلومات ملف البيانات < ملف العمل

File > Display Data File Information > Working File... 
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، أو Output Fileيتم شد كل متغت  مع خصاااااااااااااائصاااااااااااااه، يم نك حف  هذه المعلومات كملف م رجات  
 طباعتها إذا  نت تفضل  ل ة مطبوعة. 

ي 
ة عرل معلومات قاموس البيانات فى ى لاااااااااات دم مت 

 
،    SPSSعادة ما ت ي

ي تواثق أعمال التحليل الإحصااااااااااائ 
فى

ي 
ب اصاة عندما ي ون مطلونًا تلأديم تلأمير مفصال عن بوية البيانات وخطة التنفيذ وعمليات التحليل الت 
ي المؤساااالااااات البح ية الأ اديمية أو المهنية. ويتم اسااااتعرال مجمل ما تم اللأيام به 

تم تنفيذها، سااااواء فى
. من عمليات تحليل  من هذا التلأمير أو   البح  الأ ادي ي

ي 
ى
 SPSSاستدعاء مرب  ع حوار ف

ي   Dialog Recallيوفر زر أداة اسااااااااااتدعاء ممنااع حوار 
ي برنامج التحليل الإحصااااااااااائ 

قائمة ب حدث   SPSSفى
ي هذه اللأائمة بنلأرة  

نك من العودة إلى أي ممنااع حوار مدرج فى
ا
ي تم الوصاااااااول إلثها ويم 

ممنعات الحوار الت 
ي 
ي برناامج التحليال الإحصااااااااااااااااائ 

ي العاادة إلى توفت  الوقات والجهاد فى
واحادة باالمااوس. ويااهادف هاذا الإجراء فى

SPSS ي كل مرة تميد فثها اساااااااااااات دام ممنااع
 من البدء من جديد فى

ً
جاع الممنااع بدلا ، وذلك من خلال اساااااااااااات 

 الحوار الذي سبق لك است دامه. 

 
 زر استدعاء ممنااع حوار

ي وقت ساااااابق من الجللاااااة وإعادة 
هذا مفيد بشاااااكل خا  للعودة ب اااااعة إلى ممنااع الحوار الملااااات دم فى
 إجراء تحليل، أو إجراء تعديل عليه وتشغيله مرة أخرى عند الحاجة. 

ي 
ى
 SPSSخطوات استدعاء مرب  ع حوار ف

ي برنامج 
ة فى ى جاع ممنااع الحوار، يم ن اتباع ال طوات التالية:  SPSSلاست دام هذه المت   لاست 

 .Dialog Recall. انلأر فوق الزر "استدعاء ممنااع حوار" 1

ي الجللة أو جللة العمل. 
 يتم عرل قائمة ممنعات الحوار الملت دمة مؤخرًا فى

ي اللأائمة، ما عليك سوى النلأر فوقه. . 2
 لفتح أي ممنااع حوار فى
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 الفصل الحادي عشر

 SPSSتخصيص برنامج 

 

ي تخصيص برنامج 
 SPSSماذا يعبى

ي 
 تلااااااااااااااعد    SPSSيم ن أن  لااااااااااااااعد ت صااااااااااااايص برنامج التحليل الإحصاااااااااااااائ 

ً
ي توفت  الوقت والجهد. م لا

فى
ات الملت دمة   ى ي توفت  الوقت عن طميق تلهيل الوصول إلى المت 

طة الأدوات الم صصة فى اللأوائم وأشر
بشاااااكل مت رر وتشاااااغيل المهام الشاااااائعة تللأائيًا. تلااااامح لك ممنعات الحوار الم صاااااصاااااة إ شااااااء واجهات 

مجية.   الملت دم ال اصة بك لتوليد الصث  الت 

 عل كل من:  SPSSتشتمل عمليات ت صيص 

ي   •
أو  Syntaxلتشاااااااااااااااغيال ملفاات بنااء جملاة الأوامر    SPSSإ شاااااااااااااااااء عنااة قاائماة م صاااااااااااااااصااااااااااااااااة فى

امج النصااية الأخرى بلااهولة. يم نك إ ااافة عنلااا إلى قائمة موجودة أو إ شاااء  و أالتطبيلأات   الت 
 قائمة كاملة خاصة بك. 

ي توفر طميلأة أخرى لأداء مهام محددة ب اااعة. عل سااابيل  •
طة أدوات م صاااصاااة، والت  إ شااااء أشر

طة أدوات م صاااصاااة من أجل تشاااغيل الإجراءات الملااات دمة بشاااكل  الم ال، يم نك إ شااااء أشر
مت رر أو لإ شااااااااااااء رساااااااااااوم بيانية وم ططات ب اااااااااااعة وساااااااااااهولة، كل ذلك من خلال نلأرة زر عل 

ي  الأدوات الم صص الج  ديد. شر

مجية أو الأوامر  • مجية أو صااااااااااااث  الجمل الت  إ شاااااااااااااء ممنعات حوار م صااااااااااااصااااااااااااة لتوليد الجمل الت 
Syntax  يتثح لك ذلك إ شااااااء  لااااا تك ال اصاااااة من ممنااع الحوار لإجراء إحصاااااائيات .SPSS أو ،

ي 
مجية الت  واجهة ملت دم لأمر ملحق، أو واجهة ملت دم لأي مجموعة من بناءات الجمل الت 

ي تحديد معلماتها بناءً عل إدخال الملت دم. 
 قد ترغب فى

،  و  ح كل فيما يلي تيب:  فصيلهذه الطرق بالتسوف يتم شر   من المو وعات التالية ونالت 

 إ شاء عناة قائمة م صصة •

طة أدوات م صصة •  إ شاء أشر

 إ شاء ممنعات حوار م صصة •

ي  
ى
 SPSSإنشاء عناصر قائمة مخصصة ف

ي 
أو التطبيلأات    Syntaxلتشااغيل ملفات بناء جملة الأوامر   SPSSيم ن إ شاااء عناة قائمة م صااصااة فى

امج النصااية الأخرى بلااهولة. يم نك إ ااافة عنلااا إلى قائمة موجودة أو إ شاااء قائمة كاملة خاصااة   أو الت 
 بك. 

 خطوات إنشاء عناصر قائمة مخصصة جديدة

 . اخت  من اللأوائم: 1

 ...  عرض < محرر القائمة

View > Menu Editor... 
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ى  ي ممنااع الحوار هذا، يم نك إ شااااء قوائم كاملة أو إ اااافة عناة إلى قوائم موجودة أو إدراج فواصااال ب  
فى

 عناة اللأائمة أو حذف اللأوائم أو حذف عناة من اللأائمة. 

 
 ممنااع حوار محرر اللأائمة 

ي سايتم إ اافة عنلاا اللأائمة أو اللأائمة  Apply To  ". اسات دم قائمة "تطبثق عل2
لتحديد النافذة الت 

ي هذا الم ال، حدد نافذة "محرر البيانا
 .Data Editorت" إلثها. فى

ي ممنااع Utilitiesة" انلأر نلأرًا مزدوجًا فوق "الأدوات الملاعد. 3
 . لتوسيعها  Menuة" اللأائم" فى

ي أسااافل  . 4
يتم إدراج عناة اللأائمة الجديدة فوق العنلاااا المحدد حاليًا. لذلك، لإ اااافة عنلاااا جديد فى

ي نهاية قائمة "الأدوات الملااعد
ى  )   Utilitiesة"  اللأائمة، حدد العنلاا فى ى قوس   ي تحتوي عل نص ب  

الت 
 (.  شت  إلى أن هذه هي نهاية اللأائمة

 .Syntaxة وحدد بناء الجمل Insert Item" انلأر فوق "إدراج عنلا. 5

 . كاسم العنلا الجديد   Create Dataت" ام ا تب "إ شاء البيانا. 6

 . ال ا  بدليل التثبيت Samplesج وانتلأل إلى دليل النماذ  Browseل" انلأر فوق "استعرا. 7

 .CreateData.spsف ام حدد مل. 8

 .Syntaxر الآن، عند تحديد عنلا اللأائمة هذا، سيتم تشغيل ملف بناء جملة الأوام

ات وإغلاق ممنااع الحوار "محرر اللأائم OKق" انلأر فوق زر "مواف. 9  .Menu Editorة" لحف  التغثت 

10 . :  ام من قوائم نافذة محرر البيانات، اخت 

 إنشاء البياناتة < الأدوات المساعد

Utilities > Create Data 

ي هاذا الم اال بال شااااااااااااااااء مجموعة  Syntaxر  يؤدي هاذا إلى تشاااااااااااااااغيال ملف بنااء جملاة الأوام
، والاذي يلأوم فى

 . متغت  بلأيم موزعة بشكل طبيعي  ( 20) حالة و ( 100) بيانات جديدة تحتوي عل 
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ي  إنشاء 
ى
طة أدوات مخصصة ف  SPSSأسر 

طة   طة الأدوات طميلأة أخرى لأداء مهام محددة ب ااااااعة. عل ساااااابيل الم ال، يم نك إ شاااااااء أشر توفر أشر
ي 
ي برنامج التحليل الإحصاااااائ 

من أجل تشاااااغيل الإجراءات الملااااات دمة بشاااااكل    SPSSأدوات م صاااااصاااااة فى
ي    مت رر أو لإ شااااااااااااااء رساااااااااااااوم بيانية وم ططات ب اااااااااااااعة وساااااااااااااهولة، كل ذلك من خلال نلأرة زر عل شر

 الأدوات الم صص الجديد. 

ي 
طة أدوات م صصة فى  .SPSSفيما يلي سوف يتم استعرال خطوات إ شاء أشر

طة أدوات مخصصة جديدة:   خطوات إنشاء أسر 

 . اخت  من اللأوائم: 1

طة الأدوات < تخصيص  عرض < أسر 

View > Toolbars > Customize... 

طة الأدوات"  طة الأدوات المتاحة للنافذة    Show Toolbars  اااااااااااااااد ممنااع الحوار "إظهار أشر جمثع أشر
 المحددة حاليًا. 

ا بالفعل، فاخت  "محرر البيانات" 2
ً
 .Windowمن قائمة النافذة  Data Editor. إذا لم ي ن محدد

 .New. انلأر فوق "جديد" 3

ي  الأدوات"  4 ي ممنااع حوار "خصااااااااااااااااائص شر
ي  الأدوات ال اا   Toolbar Properties. فى ا تاب "شر
 " ي ي  الأدوات الجديد.   My Toolbarئ   كاسم ل ر

ي نااافااذة محرر البيااانااات  5
ي  الأدوات هااذا فى فلأ . لااذلااك، قم بااللغاااء  Data Editor. يجااب أن يظهر شر

 . تحديد )أو ملح( الممنعات لأنواع النوافذ الأخرى

ي  الأدوات ال ا  ب Editر" انلأر فوق "تحمي. 6  ك. لإ افة أزرار إلى شر

ي فئا
ي  الأدوات فى حدد فئة لعرل عناةها. ويعرل ممنااع حوار .  Categoriesت  يتم توزيااااع عناة شر
ي  الأدوات" هااذه الفئااا ي  الأدوات  Categoriesت  "تحمير شر  عل جهااة اليلااااااااااااااااار، ويعرل عناااة شر

Tools  ي الشكل التالىي
ى كما يظهر فى  : من الفئة المحددة عل جهة اليم  

 
ي  الأدوات يعرل الفئات والأدوات ل ل فئة   ممنااع حوار تحمير شر
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 .Dataت" حدد فئة "البيانا. 7

ي  الأدوات Casesت" وحدد عناة "الحالا  Splitف سحب مل. ا8  . إلى شر

 .Analyzeل حدد فئة التحلي. 9

ي . 10
و"جداول    Descriptive Statistics Frequencies" اسااحب عناة "ت رارات الإحصاااء الوصاافى

ي 
ان الإحصاء الوصفى ي  الأدوا  Descriptive Statistics Crosstabs"  اقت  ملاحظة: ست ون  ت. ) إلى شر

 (. Statistics Baseت هذه العناة متاحة فلأ  إذا كان لديك خيار قاعدة الإحصائيا

يط أدوات مخصصة لتشغيل ملف بناء جملة أمر   : إنشاء عناصر سر 

ي  أدوات م صااااااصااااااة لتشااااااغيل ملف بناء جملة أم أو تطبثق  خر أو   Syntaxر  يم نك إ شاااااااء عناة شر
 .Script برنامج نصىي 

 Create Newة" لعرل ممنااع الحوار "إ شاااااااااااااااااء أداة جادياد  New Toolة" انلأر فوق "أداة جادياد.  11
Tool. 

ي حلأل التلمية Create Dataت" ا تب "إ شاء بيانا. 12
 . فى

 .Action Typeء  نوع الإجرا   Syntaxة" حدد "بناء الجمل. 13

 . ال ا  بدليل التثبيت Samplesج وانتلأل إلى دليل النماذ  Browseل انلأر فوق استعرا. 14

 .CreateData.spsد حد. 15

ي فئة "معرّفة من قبل الملت د
ي  الأدوات الم صصة فى يتم  .  User-Definedم"  يتم عرل عناة شر

ي تم إ شاااااااا ها باسااااااات دام محرر اللأائم
ا عرل عناة اللأائمة الم صاااااااصاااااااة الت 

ً
ي   Menu Editorة أيضااااااا

فى
 . هذه الفئة

ي  الأدوا Create Dataت" اسحب عنلا "إ شاء البيانا. 16  .Toolbarت إلى شر

 
ي مم 
ي  الأدوات نااتحديد أداة م صصة فى  ع حوار تحمير شر
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ا بتنفيذ مهمة إ شااااء عناة قائمة ملاحظة
ً
ي اللأائمة إذا قمت أيضااا

ى فى : قد يتم عرل إ شااااء البيانات مرت  

ء تمامًا، لذلك لا يهم أيهما تلااااااااات دمه. إذا   ي
ى بنفس الشااااااااار ي هذا الم ال، يلأوم كلا الإدخال  

م صاااااااااصاااااااااة. فى
هماة  قمات باالفعال بال شاااااااااااااااااء عنلاااااااااااااااا قاائماة م صاااااااااااااااص لمهماة محاددة، فلن تحتااج إلى إعاادة تعميف الم

ي اللأائمة المعرّفة من قبل 
طة الأدوات الم صاااااااصاااااااة. ما عليك ساااااااوى تحديد العنلاااااااا فى ي أشر

لتضااااااامثنها فى
 الملت دم إذا  نت قد حددت بالفعل عنلا قائمة م صصًا لنفس المهمة. 

يط الأدوات( ى صورة مختلفة للأداة الجديدة )أو لأي عنصر على سر   :تعيي 

ي  الأدوات المعرول. ح17  . دد العنلا عل شر

 . ، ام حدد ملف الصورة الذي تميد است دامهChange Imageة" انلأر فوق "تغثت  الصور . 18

ي هذا الم ال، انتلأل إلى دليل "النماذ . 19
ي دليل التثبيت وحد Samplesج" فى

 .RunButton.jpgد فى

ي    Continueة"  ، ام انلأر فوق زر "متااابعااOpenح"  انلأر فوق زر "فت.  20 ي ممنااع الحوار "تحمير شر
فى

"مواف  Edit Toolbarت"  الأدوا زر  فوق  انلأر  الأدوا  OKق"  ام  طااااااااة  أشر "إظهااااااااار  الحوار  ممنااع  ي 
ت" فى

Show Toolbars. 

ي ناافاذة "محرر البيااناا
ي  الأدوات الجادياد فى إذا اسااااااااااااااات ادمات أداة  .  Data Editorت"  يتم الآن عرل شر

والذي    ،CreateData.spsر فلاااوف تلأوم بتشاااغيل ملف بناء جملة الأم ،Create Dataت  إ شااااء بيانا
وشااااااااااااااار  مجموعااة بيااانااات جاادياادة تحتوي عل   ا بلأيم موزعااة بشاااااااااااااااكاال طبيعي   ( 20) حااالااة و  ( 100) ي 

ً   متغت 
normally distributed values. 

 
ي  أدوات م صص يظهر بعج الأزرار بالإ افة إلى زر م صص جديد  شر

ي 
ى
 SPSSإنشاء مربعات حوار مخصصة ف

ي 
ي برنامج التحليل الإحصاااااااائ 

مجية أو  SPSSيم نك إ شااااااااء ممنعات حوار م صاااااااصاااااااة فى لتوليد الجمل الت 
،  SPSS. يتثح لك ذلك إ شاء  ل تك ال اصة من ممنااع الحوار لإجراء إحصائيات Syntaxصث  الأوامر 

ي قد 
مجية الت  أو واجهة ملاااااااات دم لأمر ملحق، أو واجهة ملاااااااات دم لأي مجموعة من بناءات الجمل الت 

ي تحديد معلماتها بناءً عل إدخال الملت دم. 
 ترغب فى

 خطوات إنشاء مربعات حوار مخصصة

 .SPSS. حدد خصائص ممنااع الحوار نفله، م ل عنلا قائمة جديد لممنااع الحوار داخل قوائم 1

ي تشااااااااكل ممنااع الحوار أو أي ممنعات  . ح2
ات المصاااااااادر والهدف، الت  دد عناة التحكم، م ل قوائم متغت 

 . حوار فرعية

 . قم بل شاء قالب بناء الجملة الذي يحدد بناء جملة الأمر الذي سيتم إ شا ه بواسطة ممنااع الحوار . 3

ي 
ا حفظه فى

ً
ي اسااات دامه. يم نك أيضااا

بمجرد الانتهاء من مواصااافات ممنااع الحوار، يم نك تثبيته والبدء فى
ى  خمين ي بحي  يم نك مشار ته مع ملت دم    . ملف خارخ 

<    Analyzeل من قائمة التحلي)   One-Way ANOVAكم ال، سانوشار   لا ة من ممنااع الحوار المدمج  
ى "التباااااينااااا(  Compare Meansت  ملأااااارنااااة المتوساااااااااااااااطااااا   Contrastsت"  باااادون ممنعي الحوار الفرعث  
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يتطلب هذا الم ال خيار ) .  Post Hoc Multiple Comparisonsة  والملأارنات المتعددة الم صااااااااصاااااااا
 (. Statistics Baseت قاعدة الإحصائيا

ي ممنااع الحوار   sub-dialog"  ساااااااااااااااتحتوي خيااارات "ممنااع الحوار الفرعي 
عل كااافااة الإعاادادات المتوفرة فى

 .Means plotر: المضمن باست ناء ممنااع الاختيا

وشر  ممنااع الحوار صيغة الأمر م ل تلك المو حة أدنا  ه: سث 

ONEWAY var1 var2 BY factor 

     /STATISTICS DESCRIPTIVES BROWNFORSYTHE 

     /MISSING ANALYSIS. 

 ملاحظات

اوح من إ شاااااء ممنااع عمليات إ شاااااء ممنعات حوار م صااااصااااة  توفر   ي تت 
العديد من ال يارات المتاحة والت 

مجة   ا وتتطلب بعج مهارات الت 
ً
حوار بلي  لللأيام بوظائف محددة إلى إ شاء ممنعات حوار أ تح تعلأيد

ا 
ً
: أحيان ي تتعدى حدود هذا الكتاب. نذ ر منها ما يلي

 ، والت 

 إ شاء ممنااع حوار جديد وأ أو تحديد خصائص الممنااع •

 إ افة عناة تحكم إلى ممنااع الحوار ال ا  بك •

مجية أو النحوية •  Syntax بناء قالب الجمل الت 

 معاينة ممنااع الحوار ال ا  بك •

 تثبيت ممنااع الحوار ال ا  بك •

 حف  ممنااع الحوار ال ا  بك أو مشار ته •

 إلغاء تثبيت ممنااع الحوار ال ا  بك •

ي برنامج 
ى
 SPSSالإنتاج الآلىي ف

نامج  SPSSاللأدرة عل تشااااغيل برنامج   Production jobsتوفر وظائف الإنتاج   بطميلأة  لية. يعمل الت 
، بحي  يم نك أداء مهام أخرى أاناء تشاااااغيله أو جدولة مهمة  دون مراقبة ويوتهي بعد تنفيذ الأمر الأخت 

ي الأوقات المجدولة. 
 الإنتاج الآلىي للتشغيل تللأائيًا فى

عتت  وظائف الإنتاج مفيدة إذا  نت تلأوم غالبًا بتشااااغيل نفس مجموعة التحليلات الملااااتهلكة للوقت،  
 
ت

 م ل التلأارير الأسبوعية. 

ي 
ح طرق وخطوات إ شاء وظيفة إنتاج جديدة فى  .SPSS فيما يلي شر

ى  ى م تلفت    : يم نك تشغيل وظائف الإنتاج الآلىي بطميلأت  

ي جللااااااة منفصاااااالة عل جهاز   : بش      كل تفاعلىي  .1
نامج دون مراقبة فى المحلي  الحاسااااااوبيتم تشااااااغيل الت 

 حاسااوب ال ا  بك أو خادم بعيد. يجب أن يظل ال
ً
بال ادم البعيد،  المحلي قيد التشااغيل )ومتصاالا

 . إن أم ن( حت  ت تمل المهمة

ي الخلفي   ة على الخ   ادم .2
ى
ي جللاااااااااااااااااة منفصااااااااااااااالاااة عل خاااادم بعياااد. لا يلزم أن يظااال   : ف

ناااامج فى يعمااال الت 
 بال ادم البعيد. يم نك قطع الاتصااااااااااال  حاسااااااااااوب  ال

ً
المحلي قيد التشااااااااااغيل ولا يلزم أن يظل متصاااااااااالا

ا 
ً
داد النتائج لاحلأ  . واست 
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: يتطلب تشاااااااغيل وظيفة إنتاج عل خادم بعيد الوصاااااااول إلى خادم يلأوم بتشاااااااغيل خادم برنامج  ملاحظة

 .IBM SPSSت إحصائيا

.  لاااااات دم    الحاسااااااوب لاااااات دم هذا الم ال الو ااااااع التفاعلي لتشااااااغيل وظيفة إنتاج باساااااات دام   المحلي
للحصاااااااااااااااول عل مزيااد من ة"  ملفااات الأم لااع "راجع مو اااااااااااااااو . automaton.spsر  ملف بناااء جملااة الأم

 . المعلومات

 جديدةآلىي إنشاء وظيفة إنتاج 

ناامج. يم ناك إدراج رموز خااصااااااااااااااااة لوقات  تلااااااااااااااات ادم وظاائف الإنتااج صااااااااااااااايغاة الأوامر لأتمتاة وظاائف الت 
ي يم ن أن تطاالباك بالدخاال اللأيم قبال تشاااااااااااااااغيال 

ي ملفاات بنااء جملاة أوامر مهماة الإنتااج والت 
التشاااااااااااااااغيال فى

ي ساااطر الأوامر. كما يم نك اسااات دام رموز وقت
التشاااغيل  الوظيفة أو يم نها اسااات دام اللأيم المحددة فى

ات والمعلمات الأخرى  . هذه لتحديد ملفات البيانات وقوائم المتغت 

ي ممنعات الحوار للحصاااااول عل بناء الجملة الذي تم إ شاااااا ه بواساااااطة  
يم نك اسااااات دام الزر "لصاااااق" فى

ي ملفاات بنااء 
ي ناافاذة بنااء الجملاة. يم ن بعاد ذلاك حف  بنااء الجملاة فى

ي قمات بلصااااااااااااااالأهاا فى
التحاديادات الت 

 . الجملة

ي 
مجية فى  . لمزيد من المعلومات اللابعالفصل  راجع مو وع بناء الجمل الت 

 : لإ شاء وظيفة إنتاج

 : من اللأوائم، اخت  . 1

 الخدمات < وظيفة الإنتاج

Utilities > Production Job 

 . لإ شاء وظيفة إنتاج جديدة New" جديد"نلأر فوق . ا2

 : كما يلي   Generalم ، مع تحديد علامة التبويب عاProduction Facilityج يظهر ممنااع حوار مرفق الإنتا 

 
 Generalم عا ب  ، مع تحديد علامة التبويProduction Facilityج  ممنااع حوار مرفق الإنتا 
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، انلأر فوق الزر الذي يحتوي عل رمز علامة الجمع )+( syntax filesة  الولااااااااابة لملفات بناء الجمل. ب3
للحصاااااااااااااااول عل معلوماات حول مكاان  .  automaton.spsد وحاد  Samplesت  وانتلأال إلى مجلاد العثناا

 . الع ور عل مجلد العثنات، راجع مو وع ملفات الأم لة

لتحديد موقع    Browseل"  دخل اساااااااااااام ملف الإخراج والموقع. )يم نك اساااااااااااات دام الزر "اسااااااااااااتعرا. أ4
 (. واسم ملف

ملف و   Viewerف تتضاااامن التولاااايلأات المتاحة تولااااثق مل.  output formatج  دد تولااااثق الإخرا . ح5
Word   ملف  وExcel  وHTML وPDF  ي    والنص مج  ي هذا الم ال،  لاااااااااات دم تولااااااااااثق مل scriptالت 

ف  . فى
Viewer. 

 ملاحظة على ملف وظيفة الإنتاج

ي ملف    Runtime valuesل  تعمل قيم وقت التشااااااااغي
ي ملف وظيفة الإنتاج والملاااااااات دمة فى

المحددة فى
بناء جملة الأوامر عل تبلااااااااااااي  المهام م ل تشااااااااااااغيل نفس التحليل لملفات بيانات م تلفة أو تشااااااااااااغيل  
ات. عل سااااااااااااااابياال الم ااال، يم نااك تحااديااد قيمااة   نفس مجموعااة الأوامر لمجموعااات م تلفااة من المتغت 

ي كل مرة تلأوم فثها بتشااااااااغيل مهمة إنتاج    datafile@ل وقت التشااااااااغي
لمطالبتك باساااااااام ملف البيانات فى

ي ملف بناء جملة الأوامر  datafile@ة تلت دم اللللل
 من اسم الملف فى

ً
 . بدلا

ي هذا الم ال، سنحدد الاث قيم لوقت التشغيل. للأيمة وقت التشغيل الأولى
 : فى

 .location@ل ، أدخSymbolز بالولبة لاسم الرم. 6

@ ويجب أن تتوافق مع قواعد تلااااااااااااااامية  الرمز يجب أن تبدأ جمثع أساااااااااااااااماء رموز قيم وقت التشاااااااااااااااغيل ب
ات.   المتغت 

ا ي. 7  .Samples ، أدخل موقع مجلد العثناتDefault Valueة الولبة لللأيمة الافت 

ء من هذا User Promptم  الولااااااااااابة إلى موجه الملااااااااااات د. ب8 ي
، أدخل أين يوجد ملف البيانات  )أو شر

 . اللأبيل( 

ي خانة الاختيا check" تحلأق "حدد . 9
 .check the Quote Valueر فى

ا ااااااااااااااي   demo.savوأدخل  للرمز،   datafile@ل  للأيمة وقت التشااااااااااااااغيل ال انية، أدخ. 10 ة  لللأيمة الافت 
Default Value  ي خااانااة الاختيااا  -، ومااا اسااااااااااااااام ملف البيااانااات  لموجااه الملااااااااااااااات اادم

ر وحاادد )تحلأق( فى
check the Quote Value مرة أخرى . 

ا اية،    gender inccatأدخل  للرمز، و   varlist@ل للأيمة وقت التشاغيل ال ال ة، أدخ. 11 لللأيمة الافت 
ي يجب است دامها  لموجه الملت دم 

ات الت   . لكن هذه المرة لا تحدد خانة الاختيار  -وما المتغت 

ي ملف وظيفة الإنتاج
ى
 استبدال القيم المضمنة ف

ي توفرها لرموز وقت التشااااااااااغيل أينما تظهر هذه 
عند تشااااااااااغيل وظيفة الإنتاج، ساااااااااايتم اسااااااااااتبدال اللأيم الت 

ي وظيفة الإنتا 
ي ملفات الأوامر المضمنة فى

ي ج. الرموز فى
 :automaton.sps فيما يلي بناء الجملة فى

CD @location. 

GET FILE=@datafile. 

FREQUENCIES VARIABLES=@varlist 
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/BARCHART. 

ي أمر اللأر  المضغوط لتغثت  موقع دليل العمل location@م يتم است دا
 . فى

 . لفتح ملف بيانات GETر مع الأم datafile@م يتم است دا

ي   FREQUENCIESر  مع الأم  varlist@  يتم اسااااااااااااااات ااادام
ات المراد تضااااااااااااااامثنهاااا فى لتحااادياااد قاااائماااة المتغت 

 . التحليل

ي يم ن اسااااااتبدالها عند  
ا ااااااية، والت  ي جدول قيم وقت التشااااااغيل  لأيم افت 

يتم اساااااات دام اللأيم المتوفرة فى
 . تشغيل وظيفة الإنتاج

 .قبل اختبار وظيفة الإنتاج، يجب عليك حفظهاوالآن، 

 . وظيفة الإنتاجلحف   Save As" حف  باسم"انلأر فوق . 12

 . لاختبارها  Runل" الإنتاج، انلأر فوق "تشغيوظيفة بعد حف  . 13

ي ممنااع الحوار . 14
،  Interactively  انلأر فوق "بشاااااااكل تفاعلي ،  Run Optionsل" خيارات التشاااااااغي"فى

 .OKق" مواف"ام انلأر فوق 

 Userم نظرًا لأن وظيفة الإنتاج تحتوي عل قيم وقت التشاااااغيل، يتم فتح ممنااع حوار موجه الملااااات د
Prompt    ي علامااة

ا ااااااااااااااايااة المحااددة فى عنااد تشاااااااااااااااغياال وظيفااة الإنتاااج. يعرل نص المطااالبااة واللأيم الافت 
ي هاااذه المرحلاااة، يم ناااك تجااااوز أي من اللأيم  .  Runtime Valuesل"  التبوياااب "قيم وقااات التشاااااااااااااااغيااا

فى
ات م تلفة ا ية. عل سبيل الم ال، يم نك إدخال اسم ملف بيانات م تلف أو قائمة متغت 

 . الافت 

ا ية OKق" مواف"انلأر فوق . 15  . لتشغيل الوظيفة باللأيم الافت 

ي ملف بنااء 
ي هاذا الم اال، تلأوم وظيفاة الإنتااج بالنتااج ملف عاارل يحتوي عل نتاائج الأوامر الموجودة فى

فى
ا اااااااااااية. تم اسااااااااااات دام ملف البيانا ي يتم تشاااااااااااغيلها بلأيم وقت التشاااااااااااغيل الافت 

  demo.savت الجملة الت 
ي   يطيااة لمتغت   income"  فئااة الاادخاال"و  Gender"  الجوس"لإ شاااااااااااااااااء جااداول ت راريااة وم ططااات شر

category ر أو بالاختصاinccat. 

ر من أجاااال تشاااااااااااااااغياااال وعرل النتااااائج من الأم  Statistics Baseر  : يتطلااااب هااااذا الم ااااال خياااااملاحظ    ة
FREQUENCIES  .المتضمن 
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 دراسة حالة: الفصل الثاني عشر

 في التسويق استخدام النماذج التنبؤية

 

ي 
ى
 SPSS مفهوم النماذج التنبؤية ف

شاااااااار إلى عملية تطبثق نموذج توبؤي    Predictive Model   عل مجموعة من البيانات باسااااااام تلاااااااجيل
ي Scoring Data  البيااناات

إجراءات لبنااء النمااذج التوبؤياة م ال   SPSS  . لادى برناامج التحليال الإحصااااااااااااااااائ 
الانحدار والتجمثع أو التجزئة العنلأودية والشاااجرة ونماذج الشاااب ة العصااابية. بمجرد بناء النموذج، يم ن  
ي ملف يحتوي عل جمثع المعلوماات اللازماة لإعاادة بنااء النموذج. يم نك  

حف  مواصااااااااااااااافاات النموذج فى
ي مجموعات البيانات الأخرى. بعد ذلك است دام ملف النموذج هذا لإ شاء 

 نتائج توبؤية فى

، ونعج الإجراءات الأخرى توتج أرشااااااااااااااايف ملف    XMLف  : بعج الإجراءات توتج ململاحظ    ة ي نموذخ 
 (. zip.ف ملط ) مضغو 

ي التسويق لنماذج التنبؤيةاستخدام ا
ى
 ف

ى درجات الميل لبلأية قاعدة   ي لتعث  
وئى  لااات دم قلااام التلاااويق المباشر ل ااار ة ما نتائج اختبار بميد إلكت 

بيانات جهات الاتصاااااااااااال ال اصاااااااااااة بهم، وذلك باسااااااااااات دام ال صاااااااااااائص الديموغرافية الم تلفة لتحديد  
اء  ي من المرجح أن تلتجيب وتلأوم بعملية شر

 . جهات الاتصال الت 

يتم التعامل مع عملية التلجيل وك نها عملية تحويل للبيانات. يتم التعبت  عن النموذج داخليًا كمجموعة  
ات(   المتوبئات المحددة    -من التحويلات الرقمية لثتم تطبيلأها عل مجموعة معثنة من الحلأول )المتغت 

ي النموذج  
، فاااإن عمل  -فى ياااة تلاااااااااااااااجيااال البيااااناااات  من أجااال الحصاااااااااااااااول عل نتيجاااة متوقعاااة. ونااهاااذا المعتى

نيعي 
 هي بطبيعتهاا نفس عملياة تطبثق أي وظيفاة أو دالاة، م ال دالاة الجاذر الت 

ى  بااسااااااااااااااات ادام نموذج مع  
 
ً
 . ، عل مجموعة من البياناتم لا

 خطوات تسجيل البيانات

، هماالبيانات تت ون عملية تلجيل  ى ى أساسيت    :من خطوت  

 الخطوة الأولى: خطوة بناء النموذج .1

وحف  ملف النموذج. يم ناااك إ شااااااااااااااااااء   Predictive Modelال طوة الأولى هي بنااااء النموذج التوبؤي  
النموذج باساااااااااااات دام مجموعة بيانات تعرف نتيجة الاهتمام بها ) شااااااااااااار إلثها غالبًا باساااااااااااام الهدف(. عل 
ي  
وئى ي بناء نموذج يتنب  بمن من المحتمل أن  لاااااااااتجيب لحملة بميد إلكت 

سااااااااابيل الم ال، إذا  نت ترغب فى
، فا نات بحااجاة إلى البادء بمجموعاة بيااناات ت حتوي باالفعال عل معلوماات حول من قاام باالرد ومن مبااشر

ة من العملاء  ي لمجموعة صااغت 
وئى لم  لااتجب. عل ساابيل الم ال، قد ت ون هذه نتيجة اختبار بميد إلكت 

ي 
ي الماضى

 . أو معلومات عن الردود عل حملة مماالة فى

لاح  أنه بالولاااااابة لبعج أنواع النماذج، لا توجد نتيجة ملااااااتهدفة للاهتمام. نماذج التجزئة العنلأودية،  
 . عل سبيل الم ال، ليس لها هدف، ونعج نماذج الجار الأقرب ليس لها هدف
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 الخطوة الثانية: تطبيق النموذج .2

ي لا تعرف نتيجة الاهتمام 
قم بتطبثق النموذج التوبؤي الذي تم بنائه عل مجموعة بيانات م تلفة )والت 

 . بها( للحصول عل النتائج المتوقعة

 للتسويق المباسر  بناء نموذج تنبؤي  

ي  
 Predictiveعاااادة إجراءات من أجاااال بناااااء النماااااذج التوبؤيااااة    SPSSيوفر برنااااامج التحلياااال الإحصاااااااااااااااااااائ 

Models الميل إلى . ي خيار التلااااااااااااااويق المباشر
اء المتوفرة فى ة الميل إلى ال اااااااااااااار ى .  لاااااااااااااات دم هذا الم ال مت 

ي 
ي ال نائ 

اء يلأوم بعملية بناء نموذج توبؤي للانحدار اللوجلاات  ي ون    binary logistic regression ال اار
ي هذا الم ال، قامت جهات الاتصاااال  

ى فلأ . فى ى محتملت   فيه للنتيجة الملاااتهدفة مو اااع اهتمام نتيجت  
اء(  اء( أو لم تلتجب )لم تلأم بعملية شر ا تجميبيًا بالاستجابة )قامت بعملية شر

ً
ي تللأت بميد

 . الت 

ي 
ي خيار الانحدا  Logistic Regression يم نك بناء نموذج مشاااااااااااابه باسااااااااااات دام الانحدار اللوجلااااااااااات 

ر فى
Regression  ة   اااااااااااامن الوظائف الإ ااااااااااااافيadd-on . ي توتج

للحصااااااااااااول عل قائمة كاملة بالإجراءات الت 
 . نماذج توبؤية، راجع المو وع اللابق تلجيل البيانات باست دام النماذج التوبؤية

ي بيانا
والذي  لااااااات دم لبناء النموذج، ام يتم تطبثق هذا ،  dmdata2.savت   لااااااات دم هذا الم ال ملفى

 . راجع مو وع "ملفات الأم لة" للحصول عل مزيد من المعلومات. dmdata3.sav النموذج عل

 خطوات بناء نموذج تنبؤي جديد

 .dmdata2.savت فتح ملف البيانا. 1

ا تجميبيًا، ويحتوي 
ً
يحتوي هذا الملف عل خصااااااااااائص ديموغرافية م تلفة لفشاااااااااا ا  الذين تللأوا بميد

ي الحلأل )أو 
يد أم لا. يتم تلجيل هذه المعلومات فى ا عل معلومات حول ما إذا كانوا قد استجابوا للت 

ً
أيض

( ملاااااااتجي يدية،    1تشااااااات  اللأيمة  .  Respondedب  المتغت  إلى أن جهة الاتصاااااااال اساااااااتجابت للرساااااااائل الت 
 . إلى أن جهة الاتصال لم تلتجب 0صفر  وتشت  اللأيمة

: . م2  التسويق المباسر  < اخير تقنية ن اللأوائم اخت 

Direct Marketing > Choose Technique 

ائها"دد  . ح3 ي يرجح شر
  Select contacts most likely to purchase" تحديد جهات الاتصاال الت 

 .Continueة" متابع"وانلأر فوق 

اء ل"  ، مع تحديد علامة التبويب "الحلأو Propensity to Purchase يظهر ممنااع حوار الميل إلى ال اااااااار
Fields   كما يلي : 
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ا   Fieldsل" ، مع تحديد علامة التبويب "الحلأو Propensity to Purchaseء  ممنااع حوار الميل إلى ال ر

 Responded toي"  ، حدد "تم الاسااااتجابة للعرل الاختبار Responseة  الولاااابة لحلأل الاسااااتجاب. ب4
test offer. 

 ( 1) من اللأائمة المولاااااادلة. يتم عرل اللأيمة   Yesم"  الولاااااابة للأيمة الاسااااااتجابة الإيجابية، حدد "نع. ب5
ي الواقع تلامية قيمة مرتبطة بلأيمة ملاجلة وهي 

ي حلأل النص لأن "نعم" هي فى
. )إذا لم ي ن للأيمة  ( 1) فى

ي مجاال التحمير مكاان  تااباة  
الاساااااااااااااااتجااباة الإيجاابياة تلااااااااااااااامياة قيماة محاددة، يم ناك فلأ  إدخاال اللأيماة فى

 . النص( 

لا6 ما.  بااااااااالاماياااااااال  الاعاماPredict Propensity withع  لاتاواباؤ  حاااااااادد  الاااااااادخاااااااالAgeر  ،  فائااااااااة   ،  Income 
category، م  التعليEducationسااااااااانوات الإقامة الحالية ،  Years at current residenceالجوس ، 

Gender و ى  .Children ، والأطفالRegionة ، المنطلأMarriedج ، مت 

حاااااا7 مل.  النموذج إلى  اختيااااااار( "تصااااااااااااااااااااادير معلومااااااات  تحلأق من  )أو   XML  "Export modelف  دد 
information to XML file. 

للانتلأااال إلى المكااان الااذي تميااد حف  الملف فيااه وإدخااال اسااااااااااااااام    Browseل"  نلأر فوق "اساااااااااااااااتعرا.  8
 . للملف

ي 9
فى ا .  ال ااااااااااااااار إلى  "الميااااااال  الحوار  ممنااع  التبوياااااااب  Propensity to Purchaseء"    انلأر فوق علاماااااااة   ،

 .Settingsت" "الإعدادا

اء، مع علامة التبويب الإعدادات كما يلي 
 : يظهر ممنااع حوار الميل إلى ال ر
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اء، مع علامة التبويب الإعدادات  - بناء نموذج توبؤي   ممنااع حوار الميل إلى ال ر

اء  خيارات مرب  ع حوار الميل إلى الش 

ي 10
، حاااادد )أو تحلأق من تحاااااديااااد(  Model Validationج   مجموعااااة خياااااارات التحلأق من النموذ . فى

 Set seed to replicateر  و اذلاك تحادياد خياا Validate modelج" "التحلأق من صاااااااااااااااحاة النموذ 
results. 

ي بولاااااااااااب. 11
اضى  training sample partition ٪50ة  اسااااااااااات دم حجم تلألااااااااااايم عثنة التدريب الافت 

size ا ية  (. 2000000) ، واللأيمة الأولية الافت 

ي مجموعاة خياارات م رجاات التشااااااااااااااا ي.  12
، حادد )أو تحلأق من تحادياد(  Diagnostic Outputص  فى

 .Classification table وجدول التصويف Overall model qualityة جودة النموذج الشامل

.  لأاااعاادة عااامااة، يجااب عليااك تحادياد  0.05، أدخاال  Minimum probabilityل  ل يااار أدئى احتمااا.  13

ا عنها  ولاابة. تم ل اللأيمة  ً  لمعدل الاسااتجابة الملااتهدفة، معت 
معدل    0.05قيمة قميبة من الحد الأدئى

 . ٪5استجابة بولبة 

 . لتشغيل الإجراء وإ شاء النموذج Runل" تشغي"انلأر فوق . 14
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ي  
ى
 SPSSتقييم النموذج التنبؤي ف

قبال اسااااااااااااااات ادام النموذج التوبؤي لأغرال تلاااااااااااااااجيال البيااناات، يجاب علياك تلأثيم مادى جودة النموذج 
التوبؤي. يعتمد نوع النتائج المتاحة لتلأثيم النموذج عل التلأنية الملااات دمة لإ شااااء النموذج.  لااات دم  

ي خيار التلاااويق 
اء، المتوفرة فى ة الميل إلى ال ااار ى المباشر  ااامن الوظائف هذا الم ال النتائج المتاحة مع مت 

 .add-onالإ افية 

اء   ي شااامل وجدول تصااويف    Propensity to Purchaseيوتج عن الميل إلى ال اار م ط  جودة نموذخ 
classification table  .يم ن است دامه لتلأثيم النموذج 

يوفر م ط  جودة النموذج العاام إشااااااااااااااااارة مرئياة شيعاة لجودة النموذج.  لأااعادة عااماة، يجاب أن ت ون  
 . 0.5جودة النموذج الإجمالية أعل من 

ى م ط  جودة النموذج العام:   الشكل التالىي يب  

 
 0.55م ط  جودة النموذج العام بدرجة 

ا فحص جدول التصويف
ً
 . للت  د من أن النموذج مناسب للتلجيل، يجب عليك أيض

ى جدول التصويف  : الشكل التالىي يب  

 
 جدول التصويف
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اللأيم المتوقعاة للحلأال الهادف بااللأيم الفعلياة للحلأال    classification tableف يلأاارن جادول التصاااااااااااااااوي
ات عل مااادى   overall accuracy rateالهااادف. يم ن أن يوفر معااادل الااادقاااة الإجماااالىي   بعج المؤشر

ا بااادرجاااة أ ت  بولاااااااااااااااباااة الاساااااااااااااااتجااااباااات الإيجاااابياااة المتوقعاااة  جودة عمااال النموذج، ولكن قاااد ت ون مهتماااً
ي من المحتمل أن  

ي ون لها  الصحيحة، إذا كان الهدف هو بناء نموذج يحدد مجموعة جهات الاتصال الت 
ي استجابة معدل  ي أ ت  من  لاوي أو إيجائ   المحدد لمعدل الاستجابة الإيجائ 

 . الحد الأدئى

ي هاااذا الم اااال، يتم تلألااااااااااااااايم جااادول التصاااااااااااااااويف إلى عثناااة تااادرياااب
ر وعثناااة اختباااا  training sample  فى

testing sample  .  يتم اسااااااااااااااات ااادام عثناااة التااادرياااب لبنااااء النموذج. ام يتم تطبثق النموذج عل عثناااة
 . الاختبار لمعرفة مدى جودة عمل النموذج

. يو اااح جدول التصاااويف أن معدل التصاااويف ( ٪5) أو   ( 0.05هو ) الأدئى المحدد عدل الاساااتجابة  مكان 

ي عثنة التدريب و  ( ٪7.43)   الإيجابية هو ساااااااتجابات  الصاااااااحثح للا 
ي عثنة الاختبار. نظرًا لأن   ( ٪7.61) فى

فى
، يجاب أن ي ون هاذا النموذج قاادرًا عل تحادياد مجموعاة  ( ٪5) معادل اساااااااااااااااتجااباة عثناة الاختباار أ ت  من  

ي يحتمل أن 
 . ( ٪5) معدل استجابة أ ت  من ي ون لها جهات الاتصال الت 

 تطبيق النموذج التنبؤي

ي برنام
تيب SPSSج فيما يلي خطوات تطبثق النموذج التوبؤي فى  : بالت 

البيااااااانااااااا.  1 هااااااذا عل معلومااااااات ديموغرافيااااااة  .  dmdata3.savت  افتح ملف  البيااااااانااااااات  يحتوي ملف 
ي بميد الاختبار. انظر مو ااااااااااوع ملفات  

ي لم يتم تضاااااااااامثنها فى
ومعلومات أخرى لجمثع جهات الاتصااااااااااال الت 

 . لمزيد من المعلومات الأم لة

 .Scoring Wizardل افتح معالج التلجي. 2

 لفتح معالج التلجيل، اخت  من اللأوائم: 

 معالج التسجيلة < أدوات مساعد

Utilities > Scoring Wizard 

 : كما يلي   Select a Scoring Modelل يظهر معالج التلجيل: حدد نموذج التلجي

 
 تطبثق النموذج التوبؤي  -معالج التلجيل: حدد نموذج التلجيل 
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للنموذج وانلأر  XMLف  للانتلأال إلى الموقع حي  قمت بحف  مل  Browseل"  نلأر فوق "اساااااااتعرا. ا3
ي ممنااع الحوار "استعرا Select" فوق "تحديد

 .Browseل" فى

ي معااالج التلاااااااااااااااجياال  zip.و  أ  xml.د  يتم عرل جمثع الملفااات ذات الامتاادا
إذا تم التعرف عل الملف .  فى

 . المحدد كملف نموذج صالح، فليتم عرل وصف النموذج

 .Next الذي قمت بل شائه ام انلأر فوق التالىي  XMLف حدد نموذج مل. 4

 خطوة مطابقة حقول النموذج

 : يظهر معالج التلجيل: مطابلأة حلأول النموذج كما يلي 

 
 معالج التلجيل: مطابلأة حلأول النموذج 

، يجب أن تحتوي مجموعة البيانات عل حلأول  datasetة من أجل تلااااجيل مجموعة البيانات الوشااااط
ا عل حلأول ملألاااااااااااامة،  

ً
ي النموذج. إذا كان النموذج يحتوي أيضاااااااااااا

ى فى ات( تتوافق مع جمثع المتوبئ   )متغت 
ي النموذج

ا عل حلأول تتوافق مع جمثع الحلأول الملألمة فى
ً
 . فيجب أن تحتوي مجموعة البيانات أيض

ي 
ي مجموعة البيانات الوشااااطة لها نفس الاساااام والنوع  حلأول فى

، تتم مطابلأة أي حلأول فى ي
اضى بشااااكل افت 
 . النموذج تللأائيًا 

اسااااااااااااااات ادم اللأاائماة المولاااااااااااااااادلاة لمطاابلأاة حلأول مجموعاة البيااناات بحلأول النموذج. يجاب أن ي ون نوع  
ي كل من النموذج ومجموعة البيانات لمطابلأة الحلأول

 . البيانات ل ل حلأل هو نفله فى

لا يم ناك المتاابعاة مع المعاالج أو تلاااااااااااااااجيال مجموعاة البيااناات الوشاااااااااااااااطاة ماا لم تتطاابق جمثع المتوبئاات 
ي مجموعة البيانات الوشطة

ي النموذج مع الحلأول فى
 . )والحلأول الملألمة إن وجدت( فى

ي .  Incomeل لا تحتوي مجموعة البيانات الوشاااااااااااطة عل حلأل  لااااااااااا  الدخ
لذا فإن ال لية الموجودة فى

ي   Dataset Fieldsت  عمود حلأول مجموعااة البيااانااا
ي النموذج ت ون فااارغااة فى

ناااظر حلأاال الاادخاال فى
 
ي ت
الت 

ي مجموعة البيانات الوشطة مكافى  لحلأل النموذج هذا 
 . البداية. تحتاج إلى تحديد حلأل فى

ي عمود حلأول مجموعااة البيااانااا. م5
ي  Dataset Fieldsت  ن اللأااائمااة المولاااااااااااااااادلااة فى

ي ال ليااة الفااارغااة فى
فى

 .IncomeCategoryل ، حدد حلأل فئة الدخIncomeصف حلأل نموذج الدخل 



 

ي 
ح برنامج التحليل الإحصائ   مصطفى فؤاد عبيد د. م.                        خطوة خطوة                                       - SPSSشر

 

120 

 

ي مجموعة  ملاحظة
: بالإ اااااافة إلى اسااااام الحلأل ونوعه، يجب الت  د من تلاااااجيل قيم البيانات الفعلية فى

ي مجموعة البيانات الملاات دمة لإ شاااء 
ي يتم تلااجيلها بنفس طميلأة تلااجيل قيم البيانات فى

البيانات الت 
به دخل ملألاام إلى أرنااع فئات،   Incomeل النموذج. عل ساابيل الم ال، إذا تم إ شاااء النموذج بحلأل دخ

ي مجموعة البيانات الوشاااط
به دخل ملألااام إلى سااات فئات أو   IncomeCategoryة وكان حلأل الدخل فى

ي ساااااااايتم الحصااااااااول 
ا مع بعضااااااااها البعج والنتائج الت 

ً
أرنااع فئات م تلفة، فإن هذه الحلأول لا تتطابق حلأ
 . علثها لن ت ون مواوقة عن تطبثق النموذج التوبؤي

 خطوة تحديد وظائف التسجيل

ي معالج التلجي Next انلأر فوق "التالىي . 6
 ل. للمتابعة إلى ال طوة التالية فى

 : كما يلي   Select Scoring Functionsل يظهر معالج التلجيل: حدد وظائف التلجي

 
 معالج التلجيل: حدد وظائف التلجيل 

المتااااحاااة للنموذج المحااادد.   scoresت"  هي أنواع "الااادرجاااا  Scoring Functionsل  وظاااائف التلاااااااااااااااجيااا
ي 
ي ال نائ 

 binary logistic تعتمد وظائف التلااااااجيل المتاحة عل النموذج. بالولاااااابة للنموذج اللوجلاااااات 
model  ي هاذا الم اال، فاإن الوظاائف المتااحاة هي اللأيماة المتوقعا

،  predicted valueة  الملااااااااااااااات ادم فى
ة  ، واحتماااااال اللأيماااااة المحااااادد probability of the predicted valueة  واحتماااااال اللأيماااااة المتوقعااااا

probability of a selected valueة ، وال لأconfidence. 

ي هذا الم ال، نحن مهتمون بالاحتمال المتوق
للاساااااااااااااااتجابة الإيجابية عل   predicted probabilityع فى

 .probability of a selected valueة المراسلات؛ لذلك نميد احتمال اللأيمة المحدد

 .Probability of Selected Categoryحدد )أو تحلأق من تحديد( احتمال الفئة الم تارة . 7

ي عمود اللأيم. 8
من اللأائمة المولااااااااااااااادلة. يتم تحديد قائمة اللأيم المحتملة للهدف   ( 1) ، حدد  Valueة  فى

ي ملف البيانات الملت دم لبناء النموذج
ي النموذج، بناءً عل اللأيم الملتهدفة فى

 . فى

اء لبناء نموذج، فإن اللأيمة المرتبطة بالاسااااااتجابة الإيجابية  ملاحظة ة الميل إلى ال اااااار ى : عند اساااااات دام مت 

ي ( 1)  ساااااااات ون دائمًا 
ى الهدف إلى حلأل انائ  اء يعيد تللأائيًا ترمت  حي  يم ل   Binary ، نظرًا لأن الميل لل اااااااار

ي ملف البيانات )صااااااااااااافر(  اساااااااااااااتجابة إيجابية، ويم ل  ( 1) 
أي قيمة صاااااااااااااالحة أخرى تم الحصاااااااااااااول علثها فى

 . الملت دم لبناء النموذج
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 . قم بللغاء تحديد )أو ملح( جمثع وظائف التلجيل الأخرى. 9

ي .  10
ي أ تح للحلأاال الجااديااد الااذي سااااااااااااااايحتوي عل قيم النلأاااط فى

ى اسااااااااااااااام وصااااااااااااااافى ا، يم نااك تعث  
اختياااريااً

 .Probability_of_responding مجموعة البيانات الوشطة. عل سبيل الم ال،

 . لتطبثق النموذج عل مجموعة البيانات الوشطة Finishء" انلأر فوق "إنها . 11

 probability ofة  يتم إلحاق الحلأل الجديد الذي يحتوي عل حلأل احتمالية وجود اسااااااااااااتجابة إيجابي
a positive response بنهاية مجموعة البيانات . 

 خطوة تحديد الحالات

 ااااااامن عملية تطبثق النموذج التوبؤي، يم نك بعد ذلك اسااااااات دام هذا الحلأل لتحديد مجموعة فرعية  
ى أو أعل  ي عند ملااااااتوى مع   ي من المحتمل أن تلاااااافر عن معدل اسااااااتجابة إيجائ 

من جهات الاتصااااااال الت 
منااه. عل سااااااااااااااابياال الم ااال، يم نااك إ شااااااااااااااااااء مجموعااة بيااانااات جاادياادة تحتوي عل مجموعااة فرعيااة من 

ي لا يلأل عن الحالا  حتمل أن تلفر عن معدل استجابة إيجائ 
ي ي 
 . ٪5ت الت 

 : من اللأوائم اخت  . 12

 البيانات < تحديد الحالات

Data > Select Cases 

ي ممنااع حوار تحديد الحالات، حدد  . 13
ط"فى وانلأر   If condition is satisfied"  إذا تم اسااااتيفاء ال اااار
 .If فوق

ي 14
 : ، أدخل التعبت  التالىي Ifت  ممنااع حوار تحديد الحالا . فى

Probability_of_responding> = 0.05 

ا للحلأل الذي يحتوي عل قيم الاحتمالات، ف دخل ذلك الاسااااااام  ملاحظة
ً
: إذا اسااااااات دمت اسااااااامًا م تلف

 م
ً
ي ه. Probability_of_respondingن بدلا

اضى  .SelectedProbabilityو الاسم الافت 

 .Continue "ةمتابع"نلأر فوق . ا15

ي ممنااع حوار تحديد الحالات، حدد " لن الحالات المحددة إلى مجموعة بيانات جديد.  16
 Copyة"  فى

selected cases to a new dataset  وأدخل اساااااااااامًا لمجموعة البيانات الجديدة. يجب أن تتوافق
ات  ات(. راجع المو ااااااااوع أسااااااااماء المتغت  أسااااااااماء مجموعات البيانات مع قواعد تلاااااااامية الحلأول )المتغت 

 . لمزيد من المعلومات

 . لإ شاء مجموعة البيانات مع جهات الاتصال المحددة OKق" انلأر فوق "مواف. 17

 النتيجة

ي تم الحصاااااااااااااااول علثهاااا من تطبثق النموذج التوبؤي عل جهاااات 
تحتوي مجموعاااة البيااااناااات الجاااديااادة الت 

 . ٪5الاتصال فلأ  مع احتمال متوقع لاستجابة إيجابية لا تلأل عن 
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 (1) رقم الملحق

 ملفات الأمثلة المستخدمة في الكتابدليل 

 

 ما هي ملفات الأمثلة

ي الكتاب ملف البيانات 
. وملف البيانات هذا عبارة عن ملاااااااح وه ي demo.savتلااااااات دم معظم الأم لة الملااااااات دمة فى

لعدة  لاف من الأشااا ا ، ويحتوي عل معلومات ديموغرافية أسااااساااية ومعلومات عن الملاااتهلك، وفثها معظم ملفات 
ي  نامج التدريت  ي الت 

ي هذا الكتاب وفى
 .SPSSالأم لة الملت دمة فى

، وقد   demo.sav، فإن إصاادار  Studentإذا  نت تلاات دم إصاادار  ال ا  بك هو نموذج تم يلي لملف البيانات الأصاالي
ه تم ت ي تحصااال علثها باسااات دام ملف البيانات هذا سااات تلف عن النتائج   (1500)لثتوافق مع حد صاااغت 

حالة. النتائج الت 
ي هذا ال

 كتاب. المعرو ة فى

ي الادليال الفرعي  SPSSج يم ن الع ور عل ملفاات الأم لاة الملااااااااااااااات ادماة والم بتاة مع برناام
ي دليال التثبيات.   Samples فى

فى
ية والفر لاااااااااااااية والألمانية والإيطالية   Samples يوجد مجلد منفصااااااااااااال داخل دليل الفرعي  ى ل ل من اللغات التالية: الإنجلت 

 . واليابانية والكورية والبولندية والروسية والصينية المبلطة والإسبانية والصينية التلأليدية

لا تتوفر جمثع ملفات الأم لة الملاااااااااات دمة بكل اللغات. إذا كان ملف الأم لة غت  متوفر بلغة معثنة، فإن مجلد اللغة هذا 
ية من ملف الأم لة ى  . يحتوي عل إصدار اللغة الإنجلت 

 موقع ملفات الأمثلة

ي الادليال الفرعي  Sample Filesة يم ن الع ور عل ملفاات الأم لا 
ي دليال التثبيات. يوجاد    Samples الم بتاة مع المنتج فى

فى
يااة والفر لااااااااااااااايااة والألمااانيااة والإيطاااليااة   Samples  مجلااد منفصاااااااااااااااال داخاال الاادلياال الفرعي  ى ل اال من اللغااات التاااليااة: الإنجلت 

 . واليابانية والكورية والبولندية والروسية والصينية المبلطة والإسبانية والصينية التلأليدية

لا تتوفر جمثع ملفاات الأم لاة بكال اللغاات. إذا كاان ملف غت  متوفر بلغاة، فاإن مجلاد اللغاة هاذا يحتوي عل إصااااااااااااااادار اللغاة 
ية من نموذج الملف ى  . الإنجلت 

 لملفاتتفصيلىي لوصف 

ي كل مو اااااااوعات 
ي أم لة م تلفة فى

الكتاب ودورات تدريبية برنامج  فيما يلي وصاااااااف موجز لنماذج الملفات الملااااااات دمة فى
ي 
 .SPSS التحليل الإحصائ 

accidents.sav  : ى تدرس عوامل ال طر المتعللأة بالعمر والجوس لحوادث ي يتعلق ب ااار ة ت م  
اضى هذا ملف بيانات افت 

ي منطلأة معثنة. تتوافق كل حالة مع تصويف شامل للفئة العممية والجوس
 . الليارات فى

adl.sav  : .ح لمرضى الل تة الدماغية ي يتعلق بالجهود المبذولة لتحديد فوائد نوع العلاج الملأت 
اضى هذا ملف بيانات افت 

. الأول تلف  العلاج  ى ى الولااااااااااء المصاااااااااابات باللااااااااا تة الدماغية إلى واحدة من مجموعت   ي بتعث  
قام الأطباء بشاااااااااكل عشاااااااااوائ 

ي تلف  علاجًا عاطفيًا إ اااااااافيً 
، وال ائى ا. بعد الااة أشاااااااهر من العلاج، تم تلاااااااجيل قدرات كل مميج عل أداء الطبيعي اللأياشي

ات ترتيبية  ة للحياة الثومية كمتغت 
 . الأ شطة المشت 

advert.sav  : ي يتم إنفااااقهاااا عل
ى الأموال الت  ي يتعلق بجهود باااائع التجزئاااة لفحص العلاقاااة ب  

اضى هاااذا ملف بيااااناااات افت 
 . الإعلان والمبيعات الناتجة. ولهذه الغاية، قاموا بجمع أرقام المبيعات اللابلأة وتكاليف الإعلان المرتبطة بها 

aflatoxin.sav  : ه بشااكل ى ، وهو ساام يتفاوت تر ت  ى ي يتعلق باختبار محاصاايل الذرة لففلاتو لاا  
اضى هذا ملف بيانات افت 

ى غلات المحاصيل وداخلها. تلف  معالج الحبوب   ي  محاصيل وقياس ملتويات الألفا  8عثنة من كل    16 بت  ب  
ى فى تو ل  

ي المليا
 .PPBر أجزاء فى
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anorectic.sav :أ النهم، أجرى الباااح ون  نأاناااء العماال نحو عرل أعرال موحادة لللااااااااااااااالوس ال  55دراسااااااااااااااااة عل    1ه ي
ا يعانون من ا ااااااااااااطرابات الأ ل المعروفة. تمت مشاااااااااااااهدة كل مميج أرنااع مرات عل مدار أرنااع ساااااااااااانوات، ليصاااااااااااابح 

ً
مراهلأ

ي كال ملاحظاة، تم تلاااااااااااااااجيال المرضى ل ال من الأعرال    220المجموع  
. درجاات الأعرال مفلأودة للمميج  16ملاحظاة. فى

ي الوقت  71
ي الوقت  76يج والمم  2فى

ي الوقت  47والمميج  2فى
 . ملاحظة صالحة 217، وترس 3فى

bankloan.sav  : ي يتعلق بجهود البنااك لتلألياال معاادل الت لف عن ساااااااااااااااااداد اللأرول. يحتوي
اضى هااذا ملف بيااانااات افت 
   850الملف عل معلومات مالية وديموغرافية عن 

ً
   عميلا

ً
ا ومحتملا

ً
حالة هم العملاء الذين حصاااااالوا عل   700. أول  سااااااابلأ

ي اللاااااااااااااااابق.  خر  
حالة هم عملاء محتملون يحتاج البنك إلى تصاااااااااااااااويفهم عل أنهم م اطر ائتمانية جيدة أو   150قرول فى
 . سيئة

bankloan_binning.sav  :  ي يحتوي عل معلوماااات ماااالياااة وديموغرافياااة عن
اضى عميااال   5000هاااذا ملف بيااااناااات افت 

 . سابق

behavior.sav  :  ي الم ال ال لاسااااااااااي ي
لب من 2فى

 
ا و   15طالبًا تلأثيم مجموعات من   52، ط

ً
ا عل ملأياس   15موقف

ً
ساااااااااالوك

اوح من   10من  عل الأفراد، يتم أخذ = "غت  مناسااب تمامًا". عند حلاااب المتوساا     9= "مناسااب للغاية" إلى    0نلأاط يت 
 . اللأيم عل أنها اختلافات

behavior_ini.sav :ي الأبعاد ل
 .havior.savا يحتوي ملف البيانات هذا عل ت وين أولىي لحل انائ 

brakes.sav : .ي مصااااااااااااانع يوتج مكابح قرصاااااااااااااية لللااااااااااااايارات عالية الأداء
ي يتعلق بمراقبة الجودة فى

اضى هذا ملف بيانات افت 
 . ملم 322 لات إنتاج. اللأطر الملتهدف للمكابح  8قرصًا من كل من  16يحتوي ملف البيانات عل قياسات قطر 

breakfast.sav :  ي دراسااااااة كلاسااااااي ية
لب من   3فى

 
ي مدرسااااااة وارتون وأزواجهم   21، ط

ي إدارة الأعمال فى
طالب ماجلااااااتت  فى

ي وجبة الإفطار حلااااااب الأفضاااااالية مع    15ترتيب  
ا فى    1عنلاااااااً

ً
= "الأقل تفضاااااايلا". تم تلااااااجيل   15" إلى = "الأ تح تفضاااااايلا

ونات فلأ ي ستة سيناريوهات م تلفة، من "التفضيل العام" إلى "وجبة خفيفة مع الم ر
  ". تفضيلاتهم فى

breakfast-overall.sav  :  ،التفضيل العام" "يحتوي ملف البيانات هذا عل تفضيلات عناة الإفطار للليناريو الأول
 . فلأ 

broadband_1.sav  : ي خاادمااة النطاااق
، حلااااااااااااااااب المنطلأااة، فى ى    

ي يحتوي عل عاادد المشااااااااااااااات 
اضى هااذا ملف بيااانااات افت 

ى الشهمية لا     
ة أرنااع سنوات 85العميج الوطنية. يحتوي ملف البيانات عل أرقام المشت   . منطلأة خلال فت 

broadband_2.sav  :ااااااااااااااااا  ملف البيانات هذا مطابق لbroadband_1.sav   ولكنه يحتوي عل بيانات لمدة الااة أشاهر
 . إ افية

car_insurance_claims.sav  :  ي مكاااااان  خر
الملأااااادماااااة والمحللاااااة فى البيااااااناااااات  ار   4مجموعاااااة  تتعلق بمطاااااالباااااات الأةى

ا، باسات دام دالة الارتباط الع شاي لمن  امً عمبل  المطالبة عل أنه يحتوي عل توزيااااع  باللايارات. يم ن نمذجة متوسا   
المتغت  التاابع بمجموعة خطياة من عمر حامل الوايلأاة ونوع اللاااااااااااااااياارة وعمر اللاااااااااااااااياارة. يم ن اسااااااااااااااات ادام عدد متوسااااااااااااااا   

 .المطالبات الملأدمة  وزن لللأياس

car_sales.sav  : ا اااااااية للمبيعات، وقائمة الأساااااااعار، والمواصااااااافات المادية يحتوي ملف البيانات هذا عل تلأديرات افت 
ع لم تلف أنواع وموديلات المر باااات. تم الحصاااااااااااااااول عل قاااائماااة الأساااااااااااااااعاااار والمواصااااااااااااااافاااات الماااادياااة باااالتنااااوب من مواق

edmunds.com وmanufacturer. 

car_sales_uprepared.sav :ن هذه  ل ة معدلة مcar_sales.sav لا تتضمن أي  لن محولة من الحلأول . 

carpet.sav  :  ي م ال شاااااااااائع
ي فحص ت ات  خملاااااااااة عوامل عل 5فى

، ترغب شر ة مهتمة بتلاااااااااويق منظف ساااااااااجاد جديد فى
داد Good Housekeepingم  تصاميم العبوة، واسام العلامة التجارية، واللاعر، وخت  -تفضايل الملاتهلك   ، و امان اسات 

ي مكان فرشااة أداة التثبيت؛ الااة أساماء 
الأموال. هناس الااة ملاتويات من العوامل لتصاميم العبوة، ي تلف كل ملاتوى فى

ة Bissellو Gloryو K2Rة  تجاري ين. يرتب ع اار ى الأخت  ى )إما لا أو نعم( ل ل من العامل   ؛ الااة ملااتويات لللااعر وملااتوي  
ى   ا بهذه العوامل. يحتوي التفضااااااااااااايل المتغت  عل رتبة متوسااااااااااااا     22ملاااااااااااااتهلك  

ً
ا محدد

ً
ا تعميف

ً
ملف التصاااااااااااااويفات ل ل  ملف

. يع س هذا المتغت  ملأياسًا عامًا للتفضيل ل ل ملف تعميف تيب المن فج يتوافق مع التفضيل العالىي
 . تعميف. الت 



 

ي 
ح برنامج التحليل الإحصائ   مصطفى فؤاد عبيد د. م.                        خطوة خطوة                                       - SPSSشر

 

124 

 

carpet_prefs.sav  :ااااااااااااااااااااااااااااااا  يعتمااد ملف البيااانااات هااذا عل نفس الم ااال الموصاااااااااااااااوف لcarpet.sav لكنااه يحتوي عل ،
ى تصااااااويف   لب من الملااااااتهلك  

 
ة. ط ى الع اااااار ي تم جمعها من كل من الملااااااتهلك  

ا شاااااا صاااااايًا  22التصااااااويفات الفعلية الت 
ً
ملف

ا . تحتوي المتغت 
ً
 إلى الأقل تفضااااايلا

ً
عل معرفات الملفات الشااااا صاااااية   PREF22  إلى  PREF1ت  للمنتج من الأ تح تفضااااايلا
ي 
 .carpet_plan.sav المرتبطة، كما هو محدد فى

index.sav  : ا ااااااااااااااية ل لااة منتجات تم بيعها بواسااااااااااااااطة شر ة يحتوي ملف البيانات هذا عل أرقام مبيعات شااااااااااااااهمية افت 
ات توقع محتملة ى بيانات عن خمس متغت  ا تضم  

ً
 .  تالوج. يتم أيض

index_seasfac.sav  :ف  ملف البيانات هذا هو نفلاه ملindex.sav    باسات ناء إ اافة مجموعة من العوامل الموسامية
ات التارياااان المصاحبة  . المحلونة من إجراء التحليل الموس ي جنبًا إلى جنب مع متغت 

cellular.sav : ي يتعلق بجهود شر اة الهااتف ال لوي لتلأليال الا اااااااااااااااطراب. يتم تطبثق درجاات
اضى هاذا ملف بيااناات افت 

اوح من   ي تت 
ي تلااااااجل  100إلى   0ميل الزخم عل الحلااااااابات، والت 

أو أعل إلى تغثت  ملأدري   50. وقد تتطلع الحلااااااابات الت 
 . ال دمة

ceramics.sav  :  ة ى ي يتعلق بجهود ال ااااااااااااااار اة المصااااااااااااااانعاة لتحادياد ماا إذا كاانات اللااااااااااااااابي اة المتمت 
اضى هاذا ملف بيااناات افت 

 لإحدى اللاابائك؛ يتم تلااجيل 
ً
الجديدة تتمتع بملأاومة أ ت  للحرارة من اللاابي ة اللأياسااية. تم ل كل حالة اختبارًا منفصاالا

ي فشل فثها المحمل
 . الحرارة الت 

cereal.sav :  ي يتعلق باساااااااتطلاع شااااااامل
اضى ي وجبة الإفطار، مع   880هذا ملف بيانات افت 

ا حول تفضااااااايلاتهم فى شااااااا صاااااااً
ا إلى العمر والجوس والحالة الاجتماعية وما إذا كان لديهم نم  حياة  ش  أم لا )بناءً عل ما إذا كانوا يمارسون 

ً
الإشارة أيض

ي الأسبوع عل الأقل(. تم ل كل حالة م
ى فى  . دع عليه منفصلالميا ة مرت  

clothing_defects.sav  : ي مصاااااااااااااانع ملابس. من كل دفعة يتم
ي يتعلق بعملية مراقبة الجودة فى

اضى هذا ملف بيانات افت 
ي المصنع، ي خذ المفتشون عثنة من الملابس ويحلبون عدد الملابس غت  الملأبولة

 . إنتاجها فى

coffee.sav  :  ل ل سااااااامة من سااااااامات صاااااااور 6ملف البيانات هذا يتعلق بالصاااااااور المتصاااااااورة للااااااات ماركات قهوة م لجة .

ي تم وصاااافها بواسااااطة اللاااامة. يتم   23اللأهوة الم لجة البال  عددها 
ساااامة ، اختار الأشاااا ا  جمثع العلامات التجارية الت 

 . للحفاظ عل ال ية FF و EE و DD و CC و BB و AA الإشارة إلى العلامات التجارية اللت

contacts.sav  :  ي مبيعات أجهزة ال مبثوتر ي يتعلق بلأوائم جهات الاتصااال لمجموعة من مندوئ 
اضى هذا ملف بيانات افت 

ا تلاااجيل مبل  
ً
كاتهم. يتم أيضااا ي يعملون فثها وترتيب شر

ي ال ااار ة. يتم تصاااويف كل جهة اتصاااال حلاااب قلااام ال ااار ة الت 
فى

 . الاتصال  خر عملية بثع تم إجرا ها والوقت منذ  خر عملية بثع وحجم شر ة جهة

Creditpromo.sav  :  ي ي يتعلق بجهود متجر متعاااادد الأقلااااااااااااااااااام لتلأثيم فعاااااليااااة عرل ترويج 
اضى هااااذا ملف بيااااانااااات افت 

ا يروج   500حدي  لبطاقة الائتمان. تحلأيلأا لهذه الغاية، تم اختيار 
ً
. تلف  نصااااااااااااااافهم إعلان ي

حامل بطاقة بشاااااااااااااااكل عشاااااااااااااااوائ 
ي تمت خلال الأشهر ال لااة الملأبلة. تلف  

يات الت  ا موسميًا قياسيًا  لمعدل فائدة م فج عل المشت 
ً
 . النصف إعلان

customer_dbase.sav  : ي ملاتودع
ي يتعلق بجهود ال ار ة لاسات دام المعلومات الموجودة فى

اضى هذا ملف بيانات افت 
البيااانااات ال ااا  بهااا لتلأااديم عرول خاااصااااااااااااااااة للعملاء الااذين من المرجح أن يردوا. تم اختيااار مجموعااة فرعيااة من قاااعاادة 

ي ومنح العرول ال اصة، وتم تلجيل ردودهم
 . العملاء بشكل عشوائ 

customer_information.sav :ي يحتوي عل معلومات بميدية للعميل، م ل الاسم والعنوان
اضى  . ملف بيانات افت 

customer_subset.sav : ن حالة م 80مجموعة فرعية منcustomer_dbase.sav. 

debate.sav : ي مناظرة ساااااااياساااااااية قبل
ي يتعلق بالردود المزدوجة عل اساااااااتطلاع من الحضاااااااور فى

اضى هذا ملف بيانات افت 
 . ونعد المناقشة. كل حالة تتوافق مع مدع عليه منفصل

debate_aggregate.sav  : ي
ي يلأوم بتجمثع الردود فى

اضى تتوافق كاااال حااااالااااة مع .  Discuss.sav  هااااذا ملف بيااااانااااات افت 
 . تصويف متلأاطع لففضليات قبل المناقشة ونعدها 

demo.sav :  .يد اة، لغرل إرساااااال العرول الشاااااهمية بالت 
ي يتعلق بلأاعدة بيانات العملاء المشااااات 

اضى هذا ملف بيانات افت 
 . يتم تلجيل ما إذا كان العميل قد استجاب للعرل أم لا، جنبًا إلى جنب مع المعلومات الديموغرافية الم تلفة
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demo_cs_1.sav  :ي يتعلق بال طوة الأولى لجهود ال اااااااااااااار ة
اضى لتجمثع قاعدة بيانات لمعلومات   . هذا ملف بيانات افت 

 .الملح. تتوافق كل حالة مع مدينة م تلفة، ويتم تلجيل تحديد المنطلأة والملأاطعة والجي والمدينة

demo_cs_2.sav  :  ي يتعلق باال طوة ال اانياة لجهود ال ااااااااااااااار اة لتجمثع قااعادة بيااناات لمعلوماات
اضى هاذا ملف بيااناات افت 

ي ال طوة الأولى، ويتم تلاااااااااااااااجيااال المنطلأاااة 
لياااة م تلفاااة عن المااادن الم تاااارة فى ى الملاااااااااااااااح. تتوافق كااال حاااالاااة مع وحااادة متى

ى معلومات أخذ العثنات من والمحافظة و والملأاطعة   ا تضاااااااام  
ً
المدينة والتلألاااااااايم الفرعي وتحديد هوية الوحدة. يتم أيضاااااااا

ى من التصميم ى الأولث    . المرحلت  

demo_cs.sav  : ي تم جمعها باسااااااااااااات دام تصاااااااااااااميم عثنات
ي يحتوي عل معلومات الملاااااااااااااح الت 

اضى هذا ملف بيانات افت 
لية م تلفة، ويتم تلجيل معلومات ديموغرافية ومعلومات م تلفة ى  . معلأد. تتوافق كل حالة مع وحدة متى

sugar_costs.sav  : عن حاملي الواائق الذين 
ى ي يحتوي عل معلومات تحتف  بهاا شر ة التا م  

اضى هذا ملف بياانات افت 
 . يعانون من مرل الل ري. كل حالة تتوافق مع صاحب بوليصة م تلفة

dietstudy.sav  :  " ي
ي هذا عل نتائج دراساااااااااة حول "نظام ساااااااااتيلمان الغذائ 

اضى . تتوافق كل 7يحتوي ملف البيانات الافت 

ي ملجم أ  
ي بالجنيه وملااااتويات الدهون ال لااية فى

 100حالة مع مو ااااوع منفصاااال وتلااااجل أوزانه قبل ونعد النظام الغذائ 
 . مل

dmdata.sav : يحتو . ائياة ل ااااااااااااااار اة تلاااااااااااااااويق مبااشر ي يحتوي عل معلوماات ديموغرافياة وشر
اضى ي هاذا ملف بيااناات افت 

dmdata2.sav   ا تجميبيًا، ويحتو
ً
ي تللأت بميد

  dmdata3.savي  عل معلومات لمجموعة فرعية من جهات الاتصاااال الت 
ي لم تلتلم بميد الاختبار 

 . عل معلومات حول جهات الاتصال المتبلأية الت 

dvdplayer.sav  : ي يتعلق بتطوير مشاااااااااااااااغاا
اضى ، قااام فميق  DVDل  هااذا ملف بيااانااات افت  جااديااد. باااسااااااااااااااات اادام نموذج أولىي

. تتوافق كل حالة مع ملااااااات دم منفصااااااال تم ملاااااااحه وتلاااااااجل بعج المعلومات  ى  ت 
التلاااااااويق بجمع بيانات مجموعة الت 

 . الديموغرافية عنه وإجاباته عل أسئلة حول النموذج الأولىي 

german_credit.sav  : ي ملاااااااااااااااتودع قواعاد بيااناات
" فى ي
ملف البيااناات هاذا ما خوذ من مجموعاة بيااناات "الائتماان الألماائى

ى  8التعلم الآلىي  ي جامعة كاليفورنيا، إيرف  
 . فى

grocery_1month.sav  :بيااااااانااااااا هااااااذا هو ملف  ي 
اضى الافت  البيااااااانااااااات  مع   grocery_coupons.savت  بلأااااااالااااااة. ملف 

 
ً
ت أساااااااااااابوعيا ي تغت 

ات الت  يات الأساااااااااااابوعية "الملفوفة" بحي  تتوافق كل حالة مع عميل منفصاااااااااااال. بعج المتغت 
المشاااااااااااات 

ي أنفلأت خلال الأسابثع الأرنعة للدراسة
ي نتيجة لذلك، والمبل  الملاوف الملجل الآن هو مجموع المبال  الت 

 . ت تفى

grocery_coupons.sav  : ي يحتوي عل بيانات استلأصائية تم جمعها بواسطة سلللة متاجر
اضى هذا ملف بيانات افت 

ائية لعملائها. تتم متابعة كل عميل لمدة أرنعة أسااااااااااااابثع، وتتوافق كل حالة مع أساااااااااااابوع عميل  بلأالة مهتمة بالعادات ال اااااااااااار
ي ذلك ال

مبل  الذي تم إنفاقه عل البلأالة خلال  منفصل ويلجل معلومات حول مكان و يفية قيام العميل بالتلوق، بما فى
 . ذلك الأسبوع

guttman.sav  :  9قدم بيل  
ً
جزءًا من هذا الجدول،   10  لتو اااثح الفئات الاجتماعية المحتملة. اسااات دم جوتمان  جدولا

، ومشااااعر الانتماء إلى مجموعة، واللأرب الجلااادي  ات تصاااف أشاااياء م ل التفاعل الاجتماعي حي  تم تجاوز خملاااة متغت 
ي ذلك الحشاااود )عل سااابيل الم ال، الأشااا ا  

من الأعضااااء، وشاااكلية العلاقة مع سااابع مجموعات اجتماعية نظمية، بما فى
ي لعبة  رة اللأدم(، الجماهت  

(، الجمهور )عل   فى ة الفصااااااااال الدراشي
ي الم اااااااااح أو محاةى

)عل سااااااااابيل الم ال، الأشااااااااا ا  فى
سبيل الم ال، جمهور الصحف أو التلفزيون(، الغوغاء )م ل الجمهور ولكن مع تفاعل أ تح   افة(، المجموعات الأساسية 

فاا ااااااااااااااااة نااتجاة عن اللأرب الماادي )الحميماة (، والمجموعاات ال اانوياة )الطوعياة(، والمجتمع الحاديا  ) ونفادرالياة فضااااااااااااااا 
 . الواثق والحاجة إلى خدمات مت صصة(

health_funding.sav  :ي يحتوي عل بيااناات عن تمويال الرعااياة الصاااااااااااااااحياة )المبل  ل ال
اضى  100 هاذا ملف بيااناات افت 

كاان(، وزياارات ملأادري الرعااياة الصاااااااااااااااحياة )المعادل ل ال لااااااااااااااا من ال 10000(، ومعادلات المرل )المعادل ل ال من اللاااااااااااااااكاان
 . من اللكان(. كل حالة تم ل مدينة م تلفة 10000
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hivassay.sav  : ي لتطوير اختبااار شيااااع للكشاااااااااااااااف عن عاادوى
ي يتعلق بجهود م تت  صاااااااااااااااياادلائى

اضى هااذا ملف بيااانااات افت 
ية. نتائج الفحص امانية ظلال عميلأة من اللون الأحمر، مع ظلال أعمق تشااااااااااااااات  إلى احتمال  وس نلأص المناعة الب ااااااااااااااار فت 

وس نلأ 2000أ ت  للإصابة. وأجميت تجمنة معملية عل  ية ونصفها نظيفعثنة دم نصفها مصاب بفت   . ص المناعة الب ر

hourlywagedata.sav : ي يتعلق باالأجور بااللاااااااااااااااااعاة للممر ااااااااااااااااات من المنااصااااااااااااااااب الم تبياة
اضى هاذا ملف بيااناات افت 
ة  . والملتشفيات ونملتويات متفاوتة من ال ت 

insurance_claims.sav  :  ى تمياد إ شاااااااااااااااااء نموذج للإبلاغ عن المطاالباات ي يتعلق ب ااااااااااااااار اة تا م  
اضى هاذا ملف بيااناات افت 

 . المشبوهة والمحتمل أن ت ون احتيالية. كل حالة تم ل مطالبة منفصلة

insure.sav  : ي تشااااااااااااااات  إلى مااا إذا كااان العمياال
ى تاادرس عواماال ال طر الت  ي يتعلق ب ااااااااااااااار ااة تاا م  

اضى هااذا ملف بيااانااات افت 
ى عل الحياة لمدة   ي ملف البيانات زوجًا من   10ساااااااااايضااااااااااطر إلى تلأديم مطالبة بشاااااااااا ن علأد ت م  

ساااااااااانوات. تم ل كل حالة فى
ا مع العمر والج

ً
 . وسالعلأود، سجل أحدهما مطالبة والآخر لم  لجل، متطابلأ

judges.sav  : ي قاااادمهااااا المحكمون الماااادرنون )بااااالإ اااااااااااااااااااافااااة إلى أحااااد
ي يتعلق بااااالاااادرجااااات الت 

اضى هااااذا ملف بيااااانااااات افت 
( إلى  ى ؛ رأى اللأضاة نفس العرول 300المتحمل  

ً
 . عرل جمباز. يم ل كل صف أداءً منفصلا

kinship_dat.sav  :  غ و يم ع روزنت  ي تحلياال   11شر
مصاااااااااااااااطلح قرابااة )عمااة، أ،، ابن عم، ابنااة، أب، حفياادة، جااد،   15فى

جاادة، حفيااد، أم، ابن أ،، ابنااة أخاات، أخاات، ابن، عم(. طلبوا من أرنااع مجموعااات من طلاب الجااامعااات )امرأتااان، واانااان 
ى  لااب من مجموعت  

 
، مع من الااذ ور( فرز هااذه المصاااااااااااااااطلحااات عل أساااااااااااااااااس أوجااه التشااااااااااااااااابااه. ط ى ، ذ ر( الفرز مرت   )أنتح

ي بناءً عل معيار م تلف عن النوع الأول. وه ذا، تم الحصول عل ما مجموعه ستة "مصادر". يتوافق كل 
التصويف ال ائى

ي المصاادر مطروحًا منه عدد مرات تلألاايم 15×   15مصاادر مع مصاافوفة تلأارب  
ي تلاااوي خلاياها عدد الأشاا ا  فى

، والت 
ي هذا المصدر ال ائ

 . نات معًا فى

kinship_ini.sav :ي الأبعاد ل
 .kinship_dat.savا يحتوي ملف البيانات هذا عل ت وين أولىي لحل الائح

kinship_var.sav  : ات ملاااااااااااااااتلألاااااة من نوع الجوس، والنوع )الت وين(، ودرجااااة يحتوي ملف البياااااانااااات هااااذا عل متغت 
ي يم ن اساااات دامها لتفلاااات  أبعاد حل ل

عل وجه التحديد، يم ن اساااات دامها لتلأثيد   kinship_dat.savااااااااااااااااااا  )الفصاااال( الت 
ات  . ملاحة الحل بمجموعة خطية من هذه المتغت 

marketvalues.sav :  ي ألجون وين، إلثنوي، خلال
ي جديد فى

وع سا تى ي م ار
يتعلق ملف البيانات هذا بمبيعات المنازل فى

 . . هذه المبيعات هي مل لة سجل عام2000-1999اللنوات 

nhis2000_subset.sav  :ي للملأابلة الصاحي
ي   NHISة  الملاح الوطتى

ى فى هو ملاح  بت  قائم عل اللاكان لللاكان المدنث  
ي من الأش. يتم الحصااااااااااااااول عل 

ي عثنة تم يلية عل الصااااااااااااااعيد الوطتى
 لوجه فى

ً
الولايات المتحدة. يتم إجراء الملأابلات وجها

عل  المعلومات والملاحظات الديموغرافية حول اللااالو يات الصاااحية والحالة لأفراد كل أشة. يحتوي ملف البيانات هذا 
ي للإحصاااااااااااءات الصااااااااااحية. ملااااااااااح الملأابلة الصااااااااااحية 2000مجموعة فرعية من المعلومات من ملااااااااااح عام 

. المر ز الوطتى

 . 2000الوطنية، 

ozone.sav  :  ات   330تتضااااااااااااااامن البيااانااات ى الأوزون من المتغت   ت 
ات أرصاااااااااااااااااد جويااة للتوبؤ بت  ملاحظااة عل ساااااااااااااااتااة متغت 

ات، ممااا يعثق نهج الانحاادار 13، 12المتبلأيااة. وجاد الباااح ون اللااااااااااااااااابلأون   ى هاذه المتغت  ى  خمين، عادم خطيااة ب   ، من ب  
 . اللأياشي 

pain_medication.sav  : ي هذا عل نتائج تجمنة شيمية لفدوية المضاااااااااااااااادة للالتهابات
اضى يحتوي ملف البيانات الافت 

لعلاج  لام التهاب المفاصاااال المزمنة. من الأمور ذات الأهمية ال اصااااة الوقت الذي  لااااتغرقه الدواء حت    ااااي مفعوله 
 .و يف يلأارن بالأدوية الموجودة

patient_los.sav  : ا ااااااااااااااايااااة هااااذا عل ساااااااااااااااجلات العلاج للمرضى الااااذين تم إدخااااالهم إلى يحتوي ملف البيااااانااااات الافت 
ي احتشااااااء عضااااالة اللألب

تتوافق كل حالة مع مميج منفصااااال وتلاااااجل  .("، أو "النونة اللألبيةMI) الملاااااتشااااافى للاشاااااتباه فى
ي الملتشفى 

ات المتعللأة بلقامتهم فى  . العديد من المتغت 
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patlos_sample.sav  : ا ية هذا عل سجلات العلاج لعثنة من المرضى الذين عولجوا مع يحتوي ملف البيانات الافت 
ة أانااء علاج احتشااااااااااااااااء عضااااااااااااااالاة اللألا  تتوافق كال حاالاة مع مميج منفصااااااااااااااال ة" ، أو "النوناة اللألبيا MIب  الأدوياة الحاالاة لل تح

ي الملتشفى 
ات المتعللأة بلقامتهم فى  . وتلجل العديد من المتغت 

Poll_cs.sav  :  وع ي يتعلق بجهود منظ ي الاسااااااااااااتطلاعات لتحديد ملااااااااااااتوى الدعم العام لم اااااااااااار
اضى هذا ملف بيانات افت 

. تلااااااااااااجل كل حالة الملأاطعة والبلدة   ى ى الملااااااااااااجل   يعية. تتوافق الحالات مع الناخب   اللأانون المعرول عل الهثئة الت اااااااااااار
 . والجي الذي يعيش فيه الناخب

poll_cs_sample.sav : ي
ى فى ى الماادرج   ي هااذا عل عثنااة من الناااخب  

اضى تم .  poll_cs.sav  يحتوي ملف البيااانااات الافت 
ي ملف خط

ا للتصااااااميم المحدد فى
ً
ى وأوزان poll.csplanة أخذ العثنة وفلأ ، ويلااااااجل ملف البيانات هذا احتمالات التضاااااام  

، فهناس (PPS)م  العثنة. لاح ، مع ذلك، أنه نظرًا لأن خطة أخذ العثنات تلت دم طميلأة الاحتمالية المتناسبة مع الحج
ا ملف يحتوي عل احتمالات الاختيار المشااااااات  

ً
ات الإ اااااااافية المتوافلأة .  (poll_jointprob.sav)ة  أيضااااااا تم جمع المتغت 

حة وإ افة ملف البيانات بعد العثنة كما تم ي الفاتورة الملأت 
 . أخذها  مع الت  ثبة اللكانية للناخب و رائهم فى

property_assess.sav  : للحفااااااظ عل تلأثيماااااات قيماااااة الملأااااااطعاااااة  ي يتعلق بجهود ملأيم 
اضى هاااااذا ملف بيااااااناااااات افت 

 . ي
ي العاااام المااااضى

ي الملأااااطعاااة فى
ي تم بيعهاااا فى

الممتل اااات محااادااااة عل الموارد المحااادودة. تتوافق الحاااالات مع العلأاااارات الت 
ي يلأع فثها العلأار، والملأيم الذي زار 

ي ملف البيانات البلدة الت 
العلأار  خر مرة، والوقت منذ ذلك التلأثيم تلجل كل حالة فى

ي ذلك الوقت، وقيمة بثع العلأار 
 . ، والتلأثيم الذي تم إجرا ه فى

property_assess_cs.sav  :  م الاادولااة لإبلأاااء تلأثيمااات قيمااة الممتل ااات ي يتعلق بجهود ملأيو
اضى هااذا ملف بيااانااات افت 

ي ملف البيانات الملأاطعة، والبلدة ، 
محداة عل الموارد المحدودة. وتتوافق اللأضاااايا مع أملاس الدولة. تلاااجل كل حالة فى

ي ذلك الو 
 . قتوالجي الذي يلأع فيه العلأار، والوقت منذ  خر تلأثيم، واللأيمة فى

property_assess_cs_sample.sav  : ي
ي هاذا عل عثناة من ال صااااااااااااااااائص المادرجاة فى

اضى  يحتوي ملف البيااناات الافت 
property_assess_cs.sav  . ي ملف خطاااا

ا للتصاااااااااااااااميم المحاااادد فى
ً
،  property_assess.csplanة  تم أخااااذ العثنااااة وفلأاااا

ة الإ ااااااااافية وإ ااااااااافتها إلى  ى وأوزان العثنة. تم جمع اللأيمة الحالية المتغت  ويلااااااااجل ملف البيانات هذا احتمالات التضاااااااام  
الااااااااااااااااااااااااااااااااااااااعااااااااااااااااااااااااااااااااااااااثاااااااااااااااااااااااااااااااااااااانااااااااااااااااااااااااااااااااااااااة أخااااااااااااااااااااااااااااااااااااااذ  بااااااااااااااااااااااااااااااااااااااعااااااااااااااااااااااااااااااااااااااد  الااااااااااااااااااااااااااااااااااااااباااااااااااااااااااااااااااااااااااااايااااااااااااااااااااااااااااااااااااااانااااااااااااااااااااااااااااااااااااااات   .ماااااااااااااااااااااااااااااااااااااالااااااااااااااااااااااااااااااااااااااف 
ي 
ي يتعلق بجهود وكاااالاااة إنفااااذ اللأاااانون الح ومياااة لفهم معااادلات العودة إلى الإجرام فى

اضى الن و . هاااذا ملف بيااااناااات افت 
اصااايل جميمتهم الأولى، منطلأة اختصااااصاااها. تتوافق كل حالة مع مجرم ساااابق وتلاااجل معلوماته الديموغرافية، ونعج تف

ى من التوقيف الأول ي غضون عام  
 . ام الوقت حت  إللأاء اللأبج علثهم للمرة ال انية، إذا كان ذلك قد حدث فى

recidivism_cs_sample.sav  : ي يتعلق بجهود وكاالاة إنفااذ اللأاانون الح ومياة لفهم معادلات
اضى هاذا ملف بيااناات افت 

ي منطلأة اختصاااااااصااااااها. تتعلق كل قضااااااية بمجرم سااااااابق تم الإفراج عنه من أول اعتلأال له خلال شااااااهر 
العودة إلى الإجرام فى

، إذا كاان قاد  ، ويلاااااااااااااااجال معلومااتاه الاديموغرافياة، ونعج تفااصااااااااااااااايال جميمتهم الأولى، ونيااناات2003يونثو   ي
اعتلأاالهم ال اائى

يونثو.،   بنهااااااايااااااة  ي 2006حاااااادث 
المحااااااددة فى العثنااااااات  أخااااااذ  ل طااااااة  ا 

ً
العثنااااااة وفلأاااااا أقلاااااااااااااااااااااام  ى من  الم ااااااالف   اختيااااااار  تم   . 

recidivism_cs.csplanم  ؛ نظرًا لأنه  لااات دم طميلأة الاحتمالية المتناسااابة مع الحج(PPS) ا ملف يحتوي
ً
، يوجد أيضااا

 .(recidivism_cs_jointprob.sav)س عل احتمالات الاختيار المشت  

rfm_transactions.sav :  ،اء ي ذلااك تااارياااان ال ااااااااااااااار
اء، بمااا فى ي يحتوي عل بيااانااات معاااملات ال ااااااااااااااار

اضى ملف بيااانااات افت 
اة، والمبل  النلأدي ل ل معاملة  . والعنلا )العناة( المشت 

salesperformance.sav  :  ي المبيعاااات. يتلف
ى فى ى جاااديااادت   ى تااادريبثت   ي يتعلق بتلأثيم دورت  

اضى هاااذا ملف بيااااناااات افت 
ى إلى الاث مجموعات، تدريبات قياساااااااااااية. بالإ اااااااااااافة إلى ذلك، تتلف  المجموعة   ا، ملألااااااااااام  

ً
تدريبًا تلأنيًا؛   2ساااااااااااتون موظف
ي نهاية الدورة التدر 3المجموعة  

. تم اختبار كل موظف فى ي ، برنامج تعلي ي عملي
يبية وسااااااااااااجلت درجاتهم. تم ل كل حالة فى

ي الامتحان
ي حصلوا علثها فى

ي تم تكليفهم بها والنتيجة الت 
 وتلجل المجموعة الت 

ً
 . ملف البيانات متدرنًا منفصلا

satisf.sav  :  ي
ي يتعلق باساااااااااااااااتطلاع الر اااااااااااااااا الذي أجرته شر ة بثع بالتجزئة فى

اضى مواقع متااجر. تم   4هذا ملف بياانات افت 
ي المجموع، وتم ل كل حالة الردود من عميل واحد  582ملح 

 فى
ً
 . عميلا

screws.sav :  ي والملامت  والصواميل والملامت
اعى  . 14يحتوي ملف البيانات هذا عل معلومات حول خصائص الت 
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shampoo_ph.sav  : ات زمنية ي مصااااااااااااانع لمنتجات الشاااااااااااااعر. عل فت 
ي يتعلق بمراقبة الجودة فى

اضى هذا ملف بيانات افت 
. النطاق الملتهدف هو  ي

 . 5.5-4.5منتظمة، يتم قياس ست دفعات إخراج منفصلة وتلجيل الأس الهيدروجثتى

ships.sav  : ي مكان  خر
ي لحلأت بلااااااافن الشاااااااحن بلااااااابب   15مجموعة بيانات تم تلأديمها وتحليلها فى

ار الت  تتعلق بالأةى
ة ال دمة.  ة البناء وفت  الأمواج. يم ن نمذجة عدد الحوادث عل أنه يحدث بمعدل بواساااااون بالنظر إلى نوع اللااااافثنة وفت 

ي الجدول الم ونة من ا
 . لتصويف المتلأاطع للعوامل قيمًا للتعرل للم اطر توفر أشهر ال دمة الإجمالية ل ل خلية فى

site.sav  : ى من ي يتعلق بجهود ال ااااااار ة لاختيار مواقع جديدة لتوساااااااثع أعمالها. للأد وظفت اان  
اضى هذا ملف بيانات افت 

الملاتشاارين لتلأثيم المواقع بشاكل منفصال، والذين، بالإ اافة إلى تلأمير موساع، ل صاوا كل موقع عل أنه احتمال "جيد" 
 ". أو "عادل" أو " عيف

smokers.sav  : ي لفش المعيشااااية لعام
لتعايي الم درات وهو   1998ملف البيانات هذا ملاااات لص من الملااااح الوطتى

ي تحلياال ملف البيااانااات هااذا يجااب أن ت ون وزن البيااانااات ة.  عثنااة احتماااليااة لفش الأممي ياا 
، فااإن ال طوة الأولى فى ونااالتااالىي

 . لتع س الاتجاهات اللكانية

stocks.sav : ي هذا عل أسعار الأسهم وحجمها لمدة عام واحد
اضى  . يحتوي ملف البيانات الافت 

stroke_clean.sav  : ا ااااااااااية هذا عل حالة قاعدة البيانات الطبية بعد تنظيفها باساااااااااات دام يحتوي ملف البيانات الافت 
ي خيار إعداد البيانات

 .الإجراءات الموجودة فى

stroke_invalid.sav  : ي هاااذا عل الحاااالاااة الأولياااة للأااااعااادة بيااااناااات طبياااة ويحتوي عل
اضى يحتوي ملف البيااااناااات الافت 

 . العديد من أخطاء إدخال البيانات

stroke_survival  :  ى من برنااامج ي هااذا باا وقااات البلأاااء عل قيااد الحياااة للمرضى ال ااارج  
اضى يتعلق ملف البيااانااات الافت 

ا من التحديات. بعد اللاا تة الدماغية، يتم تلااجيل حدوث 
ً
ي تواجه عدد

إعادة الت هيل بعد اللاا تة الدماغية الإقفارية الت 
فية وتلااااااااجيل وقت الحدث. يتم اقتطاع العثنة إلى احتشاااااااااء عضاااااااالة اللألب أو اللاااااااا تة الدماغية أو اللاااااااا تة الدماغية ال ى تى

 . اليلار لأنها تشمل فلأ  المرضى الذين نجوا حت  نهاية برنامج إعادة الت هيل بعد الل تة الدماغية

stroke_valid.sav : ا ااااااااااااااايااة هااذا عل حااالااة قاااعاادة البيااانااات الطبيااة بعااد التحلأق من اللأيم يحتوي ملف البيااانااات الافت 
 . باست دام إجراء التحلأق من صحة البيانات. لا يزال يحتوي عل حالات يحتمل أن ت ون شاذة

Survey_sample.sav  : ي ذلاك البيااناات الاديموغرافياة وملأااييس
يحتوي ملف البيااناات هاذا عل بيااناات الملاااااااااااااااح، بماا فى

ي لأبحااث المواد الكيمياائياة الملاااااااااااااااح 
ات من المر ز الوطتى المواقف الم تلفاة. وهو يلأوم عل مجموعاة فرعياة من المتغت 

ات خياااليااة إ اااااااااااااااااافيااة لأغرال   ، عل الرغم من تعاادياال بعج قيم البيااانااات وإ اااااااااااااااااافااة1998الاجتماااعي العااام لعااام   متغت 
 . التو ثح

tcm_kpi.sav  : ا
ً
ات الأداء الرئيلاااااااية الأسااااااابوعية لفعمال. يحتوي أيضااااااا ي يحتوي عل قيم مؤشر

اضى هذا ملف بيانات افت 
ة الزمنية ي يم ن التحكم فثها خلال نفس الفت 

 . عل بيانات أسبوعية لعدد من الملأاييس الت 

tcm_kpi_upd.sav  :ف  ملف البيااااناااات هاااذا مطاااابق لملtcm_kpi.sav   ولكناااه يحتوي عل بيااااناااات لأرنعاااة أسااااااااااااااااااابثع
 . إ افية

telco.sav  : ي قاعدة عملائها. تتوافق كل
ي يتعلق بجهود شر ة الاتصااااااااالات لتلأليل الا ااااااااطراب فى

اضى هذا ملف بيانات افت 
 . حالة مع عميل منفصل وتلجل معلومات ديموغرافية م تلفة واست دام ال دمة

telco_extra.sav  :ت ملف البيااناات هاذا مشاااااااااااااااااباه لملف بياانااtelco.sav ات إنفااق ، ولكن تمات إزالاة "الحياازة" ومتغت 
ات إنفاق العميل المحولة من خلال اللجل اللأياشي  ي اللجل واستبدالها بمتغت 

 . العميل المحولة فى

telco_missing.sav  :ت ملف البيااناات هاذا هو مجموعاة فرعياة من ملف بياانااtelco.sav ولكن تم اساااااااااااااااتبادال بعج ،
 . قيم البيانات الديموغرافية بلأيم مفلأودة

testmarket.sav : ي هذا ب ط  سااللاالة مطاعم الوجبات ال اايعة لإ ااافة عنلااا جديد
اضى يتعلق ملف البيانات الافت 

ي العادياد 
ي مواقع فى

ويااااج للمنتج الجادياد، لاذلاك يتم تلأاديم العنلاااااااااااااااا الجادياد فى إلى قاائمتهاا. هنااس الاث حملات محتملاة للت 
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ي كل موقع، ويتم تلاااااااجيل المبيعات الأسااااااابوعية 
ي م تلف فى من الأساااااااواق الم تارة عشاااااااوائيًا. يتم اسااااااات دام عرل ترويج 

ي الأسابثع الأرنعة الأولى. كل حالة تتوافق مع موقع منفصل أسبوع
 . للعنلا الجديد فى

testmarket_1month.sav  :بيااااااااناااااااا هاااااااذا هو ملف  ي 
اضى البيااااااااناااااااات الافت  المبيعاااااااات   testmarket.savت  ملف  مع 

ي نتيجة لذلك،  
ي تتغت  أسابوعيًا ت تفى

ات الت  الأسابوعية "ملفوفة" بحي  تتوافق كل حالة مع موقع منفصال. بعج المتغت 
 . والمبيعات الملجلة الآن هي مجموع المبيعات خلال الأسابثع الأرنعة للدراسة

Tree_car.sav : اء الليارة ي يحتوي عل بيانات ديموغرافية ونيانات سعر شر
اضى  . هذا ملف بيانات افت 

tree_credit.sav :ي يحتوي عل بيانات تارياااان اللأرول الديموغرافية والملافية
اضى  .هذا ملف بيانات افت 

tree_missing_data.sav  : ي والملاااااااااااااااافياة مع
ي يحتوي عل بيااناات تاارياااان اللأرل الاديموغرافى

اضى هاذا ملف بيااناات افت 
 . عدد  بت  من اللأيم المفلأودة

tree_score_car.sav :اء الليارة ي يحتوي عل بيانات ديموغرافية ونيانات سعر شر
اضى  . هذا ملف بيانات افت 

Tree_textdata.sav  : ات قبل ا اية للمتغت 
ا إلى إظهار الحالة الافت  ين فلأ  يهدفان أسااساً ملف بيانات بلاي  به متغت 

 . ت صيص ملتوى اللأياس وتلميات اللأيمة

tv-survey.sav  : .ي تمديد تشاااااااغيل برنامج ناجح
ي يف ر فى

ي يتعلق بملاااااااح أجراه اساااااااتديو تلفزيوئى
اضى هذا ملف بيانات افت 

؛ كل   906تم سااؤال  
ً
ي ظل ظروف م تلفة. يم ل كل صااف ملااتجثبًا منفصاالا

نامج فى ى عما إذا كانوا ساايشاااهدون الت  مشااار   
ط منفصل  . عمود هو شر

ulcer_recurrence.sav  : ى من يحتوي هااذا الملف عل معلومااات جزئيااة من دراسااااااااااااااااة مصاااااااااااااااممااة لملأااارنااة فعاااليااة اان  
ي مكان  خر 

ا للبيانات ال ا اااااااعة للرقابة الفاصااااااالة وقد تم تلأديمه وتحليله فى
ً
 جيد

ً
العلاجات لمنع ت رار اللأرحة. يلأدم م ال

16. 

ulcer_recurrence_recoded.sav  : ي
لللااااااااماح لك   ulcer_recurrence.sav  يعيد هذا الملف تنظيم المعلومات فى

ي مكان 
 من مجرد احتمال حدث نهاية الدراساااة. تم تلأديمه وتحليله فى

ً
ة من الدراساااة بدلا بنمذجة احتمالية الحدث ل ل فت 

 . 17 خر 

verd1985.sav  :  ات ذات  8مو اااااوعًا عل    15. تم تلاااااجيل ردود  18يتعلق ملف البيانات هذا بملاااااح ات. المتغت  متغت 
الحثوانات الأليفة  2العمر والزوجية ، وتشاااااااامل المجموعة   1الأهمية ملألاااااااامة إلى الاث مجموعات. تتضاااااااامن المجموعة  

نات الأليفة عل أنها اساامية متعددة ويتم تشاامل الموساايف  والموساايف  الحية. يتم تحجيم الحثوا  3والأخبار، والمجموعة  
ات الأخرى عل أنها اسمية مفردة ؛ يتم قياس جمثع المتغت  ي  . تحجيم العمر عل أنه ترتثت 

virus.sav  :ن ي يتعلق بجهود مزود خدمة الإنت 
اضى وس عل شااااااااااابكاته.  (ISP)ت  هذا ملف بيانات افت  ات الفت  لتحديد ت ات 

ي المصاابة عل شابكاتها بمرور الوقت، من لحظة الا تشااف حت  
وئى يد الإلكت  للأد قاموا بتتبع الولابة )التلأميبية( لحر ة الت 

 . احتواء التهديد 

Wheeze_steubenville.sav  : ات الصااااااحية لتلوث الهواء عل الأطفال هذه مجموعة فرعية من دراسااااااة طولية للت ات 
ي سااااااان  19

 10و 9و 8و 7. تحتوي البيانات عل ملأاييس انائية مت ررة لحالة الصااااااافت  لفطفال من ساااااااتوننفيل، أوهايو ، فى
 .  من الدراسةسنوات، بالإ افة إلى تلجيل اابت لما إذا كانت الأم مدخنة أم لا خلال اللنة الأولى

workprog.sav  : ي وظائف
ى فى نامج عمل ح وري يحاول و اااع الأشااا ا  المحروم   ي يتعلق بت 

اضى هذا ملف بيانات افت 
نامج، بينما  ي الت 

نامج، تم اختيار بعضااااهم عشااااوائيًا للتلااااجيل فى ي الت 
ى فى ى المحتمل   أفضاااال. تمت متابعة عثنة من المشااااار   

ي الت  
 فى
ً
ا منفصلا

ً
 . نامجلم يتم اختيار البعج الآخر. تم ل كل حالة مشارك

worldsales.sav :ي هذا عل إيرادات المبيعات حلب اللأارة والمنتج
اضى  . يحتوي ملف البيانات الافت 
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 (2) رقم الملحق

 SPSSالنوافذ في برنامج 

 

ي برنامج  
ى
 SPSSأنواع النوافذ ف

ي 
ي برنامج التحليل الإحصائ 

، وهي كما يلي ل SPSS هناس عدد من أنواع النوافذ فى
ى  : ل منها است دام مع  

 Data Editor محرر البيانات

يعرل محرر البيااناات محتوياات ملف البيااناات. يم ناك إ شااااااااااااااااء ملفاات بيااناات جاديادة أو تعاديال ملفاات  
البياانات الموجودة باسااااااااااااااات ادام محرر البياانات. إذا كان لديك أ تح من ملف بياانات مفتوح، فهنااس نافذة 

 . محرر بيانات منفصلة ل ل ملف بيانات

 Viewer العارض

ي العاااارل أ
يم ناااك تحمير    . Viewerو  يتم عرل جمثع النتاااائج والجاااداول والم ططاااات الإحصاااااااااااااااااائياااة فى

ي تلأوم فثها بتشاغيل  
ي المرة الأولى الت 

ا. يتم فتح نافذة العارل تللأائيًا فى
ً
الإخراج وحفظه لاسات دامه لاحلأ

 . إجراء يوتج عنه إخراج

 Pivot Table Editorي محرر الجدول المحور 

ي الجداول المحورية بعدة طرق باسااااات دام محرر الجدول المحوري أو 
 يم ن تعديل الإخراج المعرول فى

Pivot Table  . ي صفوف وأعمدة وإ افة لون وإ شاء جداول
كما يم نك تحمير النص وتبديل البيانات فى
ي 
 . متعددة الأبعاد وإخفاء النتائج وإظهارها بشكل انتلأائ 

ي 
 Chart Editor محرر الرسم البيانى

ي نوافاذ الم ططاات. يم ناك تغثت  الألوان، 
يم ناك تعاديال الم ططاات والرساااااااااااااااوم البياانياة عاالياة الادقاة فى

ة الااية   وتحديد خطوط أو أحجام م تلفة، وتبديل المحاور الأفلأية والرأساااااااية، وتدوير م ططات مبعتح
 . الأبعاد، وحت  تغثت  نوع الم ط 

 Text Output Editor محرر إخراج النص

ي الجداول المحورية باسااااااااات دام محرر إخراج النص. كما 
يم ن تعديل م رجات النص غت  المعرو اااااااااة فى

 . يم نك تحمير الإخراج وتغثت  خصائص ال   )النوع والنم  واللون والحجم( 

 Syntax Editor محرر بناء الجملة

ي نافذة بناء الجملة، حي  تظهر التحديدات ال اصاااة 
يم نك لصاااق اختيارات ممنااع الحوار ال ا  بك فى

ات خاصاااااااة غت    ى ي شاااااااكل بناء جملة الأوامر. كما يم نك بعد ذلك تحمير صااااااايغة الأمر لاسااااااات دام مت 
بك فى

ي الجللات
ي ملف لاست دامها فى

 . اللاحلأة  متوفرة من خلال ممنعات الحوار. يم نك حف  هذه الأوامر فى
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 النافذة المعينة مقابل النافذة النشطة

ي 
ا، فلااااااااااااااايتم توجيااه الإخراج إلى نااافااذة العااارل    SPSS  إذا كااان لااديااك مجموعااة من النوافااذ فى مفتوحااة معااّ

ي نافذة محرر 
المحددة. إذا كان لديك أ تح من نافذة محرر بناء واحدة مفتوحة، يتم لصاااق صااايغة الأمر فى

ي  العنوان.   ي شر
ي الرمز الموجود فى

بناء الجملة المحددة. تتم الإشاااارة إلى النوافذ المعثنة بعلامة الجمع فى
ي أي وقتيم نك تغثت  ا

ى النافذة المحددة والنافذة الوشاطة،   . لنوافذ الم صاصاة فى يجب عدم ال ل  ب  
ي الملأدمة. إذا فتحت  

وهي النافذة المحددة حاليًا. إذا كان لديك نوافذ متداخلة، تظهر النافذة الوشاااااطة فى
 . نافذة، تصبح هذه النافذة تللأائيًا النافذة الوشطة والنافذة المحددة

 تغيي  النافذة المعينة

ي النافذة( 
ي أي مكان فى

ي تميد تعثينها هي النافذة الوشطة )انلأر فى
 .اجعل النافذة الت 

 :اخت  من اللأوائم

ى النافذة< ة أدوات مساعد  تعيي 

Utilities > Designate Window 

 ملاحظة

ي 
بالولابة إلى نوافذ محرر البيانات، تحدد نافذة محرر البيانات الوشاطة مجموعة البيانات الملات دمة فى
العمليات الحلاااااابية أو التحليلات اللاحلأة. لا توجد نافذة "م صاااااصاااااة" لمحرر البيانات. راجع مو اااااوع  

 . المعالجة الأساسية لمصادر بيانات متعددة لمزيد من المعلومات

ي قوائم مربعات الحوار
ى
ات ف ات وتسميات المتغي   أسماء المتغي 

ي برنااامج التحلياال 
ي قوائم ممنعااات الحوار فى

ات فى ات أو تلاااااااااااااااميااات المتغت  يم نااك عرل أساااااااااااااااماااء المتغت 
ي 
ي SPSS  الإحصاااااااااااااااااائ 

ات المصااااااااااااااااادر. للتحكم فى ي قوائم متغت 
ات فى ي ترتيااب فرز المتغت 

، ويم نااك التحكم فى
ي قاائماة "تحمير". راجع  

ي قوائم المصاااااااااااااااادر، اخت  "خياارات" فى
ات فى ا اااااااااااااااياة للمتغت 

ساااااااااااااااماات العرل الافت 
 . المو وع خيارات عامة لمزيد من المعلومات

ات داخل ممنعات الحوار ا تغثت  سمات عرل قائمة المتغت 
ً
 .يم نك أيض

 : تعتمد طميلأة تغثت  سمات العرل عل ممنااع الحوار، كما يلي 

المصاااااااااااااااااااادر،  • ات  قااااااائمااااااة متغت  الفرز والعرل أعل  ي 
يوفر عناااااااة تحكم فى إذا كااااااان ممنااع الحوار 

 . فاست دم عناة التحكم هذه لتغثت  سمات العرل

ات المصااااااااااااااادر، فاانلأر   • ي الفرز أعل قاائماة متغت 
إذا كاان ممنااع الحوار لا يحتوي عل عنااة تحكم فى

ي قائمة المصدر وحدد سمات العرل من اللأائمة المنب لأة
 . بزر الماوس الأيمن فوق أي متغت  فى

ات بدون تلاااميات   ات )يتم عرل الأساااماء لأي متغت  ات أو تلاااميات المتغت  يم نك عرل أساااماء المتغت 
تيب الأبجدي أو ملااااااتوى اللأياس  .  محددة(، ويم نك فرز قائمة المصااااااادر حلااااااب ترتيب الملفات أو الت 

ات المصاااااااااااااادر، فإن التحديد  )  ي الفرز أعل قائمة متغت 
ي تحتوي عل عناة تحكم فى

ي ممنعات الحوار الت 
فى

ي ل
اضى تيب الملف Noneا  الافت   (. يفرز اللأائمة بت 
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ات  نوع البيانات ومستوى القياس وأيقونات قائمة المتغي 

ي ممنعات الحوار معلومات حول نوع المتغت  وملتوى اللأياس
ات فى  .توفر الرموز بجوار المتغت 

 وقت تاري    خ  نص عدد 

ي   القياس النس             ب 
 )بيانات متصلة(

 

n/a 

  

ي   ال   رت   ب  ال   ق   ي       اس 
 )بيانات رتبية(

    

القياس الاس         مي 
     )بيانات اسمية(

ي 
ي برنامج التحليل الإحصائ 

 SPSS معلومات حول نوع المتغت  وملتوى اللأياس فى

ي مربعات الحوار
ى
ات ف  الحصول على معلومات حول المتغي 

ات.  ي قوائم المتغت 
ات المعرو ة فى  توفر العديد من ممنعات الحوار اللأدرة عل معرفة المزيد عن المتغت 

ات المصدر أو الهدف ي قائمة المتغت 
 .انلأر بزر الماوس الأيمن فوق أي متغت  فى

 "  "معلومات المتغت 
 .Variable Informationاخت 

 .ملتوى اللأياس للمتغت   :لمزيد من المعلومات حول ملتوى اللأياس، راجع مو وع
.  لمزيد من المعلومات حول أنواع البيانات الرقمية والللللة والتارياااان والوقت،   راجع نوع المتغت 

 مفهوم الاستعادة التلقائية للبيانات

ي الجللاااااااااااة الوشاااااااااااطة ويتم إنهاء 
ي توجد فثها بيانات غت  محفوظة فى

ي الحالات الت 
يتم عرل ممنااع حوار فى

يوفر ممنااع الحوار (. SPSSل  يتم عرل ممنااع الحوار بعد إعادة تشااااااااااغيع ) بشااااااااااكل غت  متوق SPSSج  برنام
ي 
ي أو الاساااااتعادة التللأائية للبيانات فى

داد التللأائ  لاساااااتعادتها من الجللاااااات اللاااااابلأة   SPSS خيارات الاسااااات 
ي تم إنها ها بشكل غت  متوقع ولحذف بيانات الجللة المحفوظة

 . الت 

ي حالة  لاااااااان احتيايي حت  تلأوم باسااااااااتعادة البيانات أو م
لحوظة: سااااااااتبف  بيانات الجللااااااااة المحفوظة فى

ي كل مرة تلأوم فثها بتشاااااااااغي
داد الملاااااااااتند فى حت  يتم   SPSSل  حذفها. سااااااااايلاااااااااتمر عرل ممنااع حوار اسااااااااات 

ي ممنااع حوار ال يارات 
ي فى
داد التللأائ  اسااااااتعادة جمثع الجللااااااات المحفوظة أو حذفها. راجع قلاااااام الاساااااات 
ي المتوفرة

داد التللأائ   . العامة للحصول عل معلومات حول إعدادات الاست 

 
ا
ا طويل

ً
ي وقت

داد التلقانئ  يستغرق الاسير

 
ً
ا طويلا

ً
ي للبيااناات وقتا

داد التللأاائ  ة الاسااااااااااااااات  ى ي تلاااااااااااااااتغرق فثهاا مت 
ي الحاالات الت 

ي   فى
، يتم  SPSS حت  ت تمال فى

ي 
داد التللأاائ  ي وتوفر خياارات لتعطيال الاسااااااااااااااات 

داد التللأاائ  عرل مجموعاة متنوعاة من ممنااع حوار الاسااااااااااااااات 
ا تحديد عدم إظهار ممنااع الحوار مرة أخرى للجللة الوشطة

ً
 . تمامًا، أو لملفات معثنة. يم نك أيض

ي 
ي للبيانات فى

داد التللأائ  ت تعطيل الاست  ة عت  SPSS إذا اخت  ى  : ، فيم نك إعادة توشي  المت 

ي <  عام<  خيارات<  تحرير 
داد التلقانئ  الاسير

Edit > Options... > General > Auto-Recovery 
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 نقاط الاستعادة التلقائية للبيانات

داد  ي تم إنها ها بشكل غت  متوقع )الاست 
تلأوم نلأاط الاستعادة بحف  البيانات من الجللات الوشطة الت 

ي تحفظها بشاااااااااكل ةيااااح. كل نلأطة اساااااااااتعادة هي للأطة لجللااااااااا
( أو الت  ي

تحتوي كل نلأطة  .  SPSSة التللأائ 
ي وقت إنهاء 

ي كانت  شااااااااااااااطة فى
اسااااااااااااااتعادة عل محرر البيانات، ونناء الجملة، ومعلومات ملف الإخراج الت 

ي 
الجللااااااااة بشااااااااكل غت  متوقع أو الذي قمت بحفظه بشااااااااكل ةيااااح. تظل نلأاط الاسااااااااتعادة المحفوظة فى

 . حالة  لن احتيايي حت  تلأوم باستعادتها أو حذفها 

 فتح نقاط الاستعادة

ي ممنااع حوار  
ا فى ي كال مرة    SPSSب ترحي يتم عرل نلأااط الاساااااااااااااااتعاادة التللأاائياة للبيااناات المتااحاة تللأاائياً

فى
 .SPSSج تلأوم فثها بتشغيل برنام

ا الوصول إلى نلأاط الاستعادة من خلال قائمة 
ً
 :SPSS ملفيم ن أيض

 : انلأر فوق. 1

 فتح نقطة الاستعادة<   ملف

File > Open Restore Point 

ي جمثع نلأاط الاستعادة المتاح
داد التللأائ   ة. يعرل ممنااع حوار الاست 

 .OK ق"مواف"ق حدد نلأطة استعادة لفتحها ام انلأر فو . 2

 حفظ نقاط الاستعادة

 . تللأائيًا عند إنهاء جللة  شطة بشكل غت  متوقع SPSSة يتم إ شاء نلأطة استعادة جلل

 : يم نك حف  نلأطة استعادة يدويًا عت  

 دةحفظ نقطة الاستعا<   ملف

File > Save Restore Point... 

 حذف نقاط الاستعادة

 : أو من. SPSSت يم ن حذف نلأاط استعادة الجللة الحالية من صفحة ترحيب إحصائيا

 < فتح نقطة الاستعادة ملف

File > Open Restore Point... 

 . ام حدد نلأطة استعادة وانلأر فوق رمز الحذف

 

 تم بحمد الله،

 والله أعلم، 

 د. م. مصطفى عبيد

ى  / غزة  2026، فلسطي 
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